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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Copyright Notice

© Copyright 2005–2011 Hewlett-Packard Development Company, L.P.

Contains software from Packet Design, Inc.

© Copyright 2008 Packet Design, Inc.

Trademark Notices

Linux is a U.S. Registered trademark of Linus Torvalds.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Unix® is a registered trademark of The Open Group.
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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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1 Introduction
This chapter introduces the Route Explorer/Traffic Explorer route analytics 
tools.

Chapter contents:

• About Route Explorer/Traffic Explorer on page 13

• How Route Explorer/Traffic Explorer Operate on page 14

• Key Components on page 15

• Using Route Explorer/Traffic Explorer on page 19

About Route Explorer/Traffic Explorer

The Route Analytics Management Software (RAMS) is an IP Route Analytics 
tool that listens to routing protocols and builds a real-time routing topology 
map. The map enables you to visualize and understand the dynamic operation 
of your network. Traffic Explorer also collects and aggregates traffic data, 
enabling you to view traffic flows on top of the routing topology.

Route Explorer/Traffic Explorer offer the following powerful contributions to 
network planning and analysis:

• Unified, real-time routing topology view—View complex topologies 
hierarchically or by protocol, autonomous system (AS), Interior Gateway 
Protocol (IGP) area, or Border Gateway Protocol (BGP)/Multiprotocol Label 
Switching (MPLS) virtual private network (VPN). The History Navigator 
window lets you play back a history of your routing topology changes.
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• Monitoring and alerts—Monitor vital service parameters such as 
network churn and prefix flaps, watch for changes in specific end-to-end 
service paths and prefixes, and look for degrading redundancy. Traffic 
Explorer can also raise alerts on all watched parameters to head off costly 
outages.

• Interactive analysis—Perform before and after comparisons and 
detailed event analysis using a comprehensive routing base and complete 
event history to rapidly establish the cause of the problem. 

• Planning support—Display network activity patterns to help optimize 
performance and minimize unnecessary transit fees or bandwidth costs. 
You can simulate a link failure or change link metric costs, to see how your 
routing topology responds to specific failures or upgrades. You can also 
import and export these simulated changes to manage multiple routing 
scenarios using external editors.

• Reports—View trends and identify emerging issues before they become 
problems. You can generate graphical user interface (GUI)-based reports 
for any recorded time period to obtain key information about network 
health.

How Route Explorer/Traffic Explorer Operate

Route Explorer/Traffic Explorer appliances physically connect to the network 
directly to one of the routers on the network or through a switch or hub. The 
appliances then establish communication with several routers in the network 
through the routing protocol over this single physical connection. It is only 
necessary for the appliance to listen to link-state routing protocols, including 
Open Shortest Path First (OSPF) or Intermediate system to intermediate 
system (IS-IS) in one location, because each router knows of all adjacencies in 
the network. Link-state routers send periodic update messages that 
communicate network information to each other, and to the appliance. 

OSPFv3 adds the following additional information:

• Routers—The appliance gathers information on the R and V6 bit from 
Options field. For further information, see RFC 5340, section 2.7 (Packet 
Format Changes).

• IPv6 prefixes—The appliance collects the LA and NU bits from the Prefix 
Options, as described in RFC 5340, section A.4.1.1. 
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Unlike links between OSPF and IS-IS routers, BGP peerings may not follow 
physical paths. BGP routers and their peerings are discovered indirectly by 
receiving routes whose next hop attribute contains the address of a BGP router. 
Beyond the physical connection between a BGP router and a peer, the existence 
of a BGP peering is inferred if it is advertising prefixes. 

When you first connect the appliance to the network, it usually acquires the 
topology in a matter of minutes; however, the process can take up to one hour 
for an Enhanced Interior Gateway Routing Protocol (EIGRP) network. As 
noted in the RAMS Appliance Setup Guide, you should connect the unit to the 
core routers. When connected to a core router, the RAMS appliance becomes 
more resilient with respect to loss of edge connectivity and remains useful for 
recovery purposes even during a widespread outage.

The appliance then maintains a real-time topological view of the entire 
network. You can view and manage the network from your desktop computer 
through the graphical user interface. 

Key Components

Route Explorer/Traffic Explorer deployments may include the following 
components:

HP RAMS Route Recorder—An appliance that records routing data and 
stores it in a real-time database. The recorder can concurrently monitor most 
major routing protocols (OSPF, IS-IS, BGP, and EIGRP) across multiple 
domains and ASs from a single appliance.

HP RAMS Flow Recorder — An appliance that collects traffic flow 
information exported from the routers and NetFlow recorders, and stores this 
information in a database. (Traffic Explorer only)

The Flow Collector is supported only on appliance models with two disk 
volumes (DL380 G5 FC). 

HP RAMS Flow Analyzer—An appliance that correlates traffic and routing 
data and then uses the combined data to produce reports. (Traffic Explorer 
only)
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HP RAMS Modeling Engine — An appliance that creates a synthesized view 
of data collected across the network. The Modeling Engine presents this data 
in a graphical user interface accessible from your desktop, providing a single, 
cohesive view of network activity. 

The size and distribution of the network and the number of concurrent users to 
be supported will determine the needed number and type of appliances. In 
distributed networks, a single Modeling Engine can support multiple, 
geographically distributed Route Recorders. In Traffic Explorer deployments, 
separate appliances should be installed for the Modeling Engine, Flow 
Analyzer, Flow Collectors, and Route Recorders.

With Traffic Explorer, you can monitor and record network events in different 
parts of the network with multiple Route Recorder units. The distributed Route 
Recorders collect routing data locally, from the area where they are installed, 
through generic route encapsulation (GRE) tunnels, or both. A centralized 
Modeling Engine retrieves the recorded data from each recorder. Users can 
then monitor network-wide routing from the Modeling Engine. Users can also 
archive network-wide data from a central location, and obtain reports from 
every Route Recorder in the configuration when they access the Modeling 
Engine.

When there are multiple Route Recorders in a distributed Traffic Explorer 
deployment, you can configure each appliance to record data per protocol or per 
multiple protocols, per area or per area within a protocol, or in any combination 
thereof. Recorder configuration is described in Chapter 3,  “Configuration and 
Management” 

The next figures show how data flows through the network. Route Explorer is 
shown in Figure 1-4 and Traffic Explorer is shown in Figure 1-5.
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Figure 1 Route Explorer Data Flow
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Figure 2 Traffic Explorer Data Flow

In a distributed environment where multiple appliances are installed on the 
network, you must designate the Modeling Engine as the master appliance 
during the configuration process (with the Master Capability license key). The 
Route Recorders in the deployment act as clients. (For Traffic Explorer, the 
Route Recorder, Flow Collectors, and Flow Analyzer are all client units.) From 
the master, you view and configure clients for recording. You also manage 
licenses for the entire configuration from the master. 

In Traffic Explorer, Flow Collectors are located near the router where they 
collect traffic flow data. The recorders aggregate this data before providing it 
to the Flow Analyzer. The Flow Collector receives routing data from the Route 
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Recorder and traffic data from the NetFlow exporters to aggregate this data. 
The Flow Analyzer receives data from one or multiple Flow Collectors, and 
combines the data to create a network-wide report. The Modeling Engine 
queries the routing and traffic databases of each appliance to create a 
synthesized view of both route and flow across the network, then updates the 
topology map with this data whenever the routing topology changes, thereby 
providing an accurate, real-time view of how the network is directing traffic.

Using Route Explorer/Traffic Explorer

You can connect to the Route Explorer/Traffic Explorer appliance using either 
of the following methods: 

• A web browser for accessing the Administration web pages. Use the web 
interface to perform tasks such as database management, report creation, 
software updates, and recorder configuration. For information on 
supported browsers, refer to Connecting to the Web Interface Home Page 
on page 44.

• A Virtual Network Computing (VNC) or X Window System client for 

displaying the Route Explorer/Traffic Explorer application. Network 
engineers and operators use the VNC or X client interface to view the 
routing topology map and analyze network activity.

Both types of viewers accommodate remote access, so you can view and manage 
one or more units from any desktop computer connected to the network, 
providing that it has a web browser and a VNC or X Window System client 
installed. Refer to the “Viewers” chapter in the HP Route Analytics 
Management Software User’s Guide for instructions on setting up client access.

The Web Interface 

After you log into the appliance through a web browser, the Home page opens. 
At the top of the Home page are the following navigational links, which provide 
access to each area of the web interface:

• Administration—Connects you to the Administration pages, where you 
perform administrative tasks such as user management and software 
updates.
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• Recorder Configuration—Connects you to the Recorder Configuration 
page. In a distributed system, you configure recorders and analyzers on the 
Recorder Configuration page of the master unit. On client units, the 
Recorder Configuration page is view-only and shows just that client’s 
branch of the configuration tree.

• Reports Portal—Connects you to the reports pages of the recorder, where 
you can run reports detailing recorder activity for IGP and BGP protocols. 
In a deployment with multiple Route Recorders, you can use the Reports 
Portal of the centralized Modeling Engine to obtain network-wide reports 
from a single location.

• Support—Connects you to a page providing links to documentation in 
PDF format, as well as links to the Self Service Support site and software 
downloads.

You will also find a link to Logout of the web interface. To log back in, you must 
re-enter your user name and password.
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The Application Interface

After you launch the application in a VNC or X Window System viewer, you 
open a routing topology map, which is a real-time graphical representation of 
the network. There are three display modes for viewing and manipulating the 
topology map:

• Monitoring mode—In this mode, the topology is currently being recorded 
and updates to the routing database are shown on the topology map as they 
occur. 

• Planning mode—In this mode, planning features are enabled for the 
topology map. 

• Analysis mode—In this mode, only previously recorded information in 
the routing database is shown on the topology map.

See the “The Routing Topology Map” chapter in the HP Route Analytics 
Management Software User’s Guide for instructions on opening the maps. 
Monitoring mode is available only with databases that are configured for 
recording data.

In Planning mode and Analysis modes, you can focus on a snapshot of network 
activity that is meaningful to your network planning and analysis. For 
example, you can view network data for the last hour, the entire month, or 
create a customized time range reflecting the state of the network from 11 a.m. 
to 2 p.m. 

Topologies normally open in Monitoring mode, with the following exception: In 
Traffic Explorer, if you are opening up a topology including a traffic database, 
the topology automatically opens in Analysis Mode with the selected time set 
to the latest available traffic data. Due to the inherent delay of NetFlow 
sampling, aggregation and buffering, traffic data is typically delayed by 20 
minutes from real time. If you are only interested in routing data, you can open 
the topology in Monitoring Mode by deselecting the traffic databases in the 
Open Topology dialog box.

To change modes, click the mode icon in the lower left corner of the window and 
select the desired mode.

In addition to the main topology map window, the following tools are available:

• History Navigator—Allows you to replay and analyze historical data. 
This tool is useful in investigating the cause of past events and helps 
network engineers plan for better performance in the future.
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• Planning Reports—Allows you to view a table listing all edits you’ve 
made to the topology map in Planning mode. This tool also provides 
analysis of how the edits theoretically affect network traffic.

• Capacity Reports—Allows you to view an estimate of what future traffic 
demands could be like based on past data that has been collected. This 
enables you to plan potential expansion of the network in order to meet 
future demands. (Traffic Explorer only)
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• Traffic Reports—Allows you to view reports based on traffic collected by 
Flow Collectors, then correlated and analyzed by the Flow Analyzer. 
(Traffic Explorer only)

• Path Reports—Allows you to generate reports to analyze network 
connectivity and optimize routing performance.

• IGP and BGP Reports—Allows you to view IGP- and BGP-protocol 
routing data collected from the Route Recorders. In a distributed 
deployment with multiple Route Recorders, connect to the centralized 
Modeling Engine to view consolidated reports containing IGP- and 
BGP-protocol data collected across the network.

Before proceeding with this document, you should make sure that the RAMS 

appliance is installed and networked as described in the RAMS Appliance 

Setup Guide.
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2 Initial Configuration
This chapter describes the initial hardware configuration and boot sequence. 
Follow the instructions in the Quick Start Guide for your appliance before 
following the instructions in this chapter.

The following topics are included in this chapter:

• Configuring Serial Port Settings on page 25

• Powering On the Appliance on page 27

Configuring Serial Port Settings

This section describes the serial port settings required for initial setup and the 
boot sequence. Before powering on for the first time, connect a terminal to the 
serial port on the back panel to capture the boot-up information and configure 
the administration interface. (Use a PC as a terminal that runs a program such 
as Minicom for Linux or HyperTerminal for Windows.) Use the supplied 
null-modem serial cable, because not all null-modem cables have the correct 
pinout.

By default, the appliance requires a static IP address. If you use Dynamic Host 
Configuration Protocol (DHCP) (not recommended) to acquire an IP address, 
serious problems can occur when the IP address changes. For example, you will 
be unable to view database information on the web-based user interface.

To configure the appliance, perform the following steps:

1 Power on the terminal.

2 Connect the terminal to the console port, using the serial port settings 9600 
bps, 8N1, and no flow control.
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You cannot change the serial port settings, so you must configure the 
terminal (or terminal program) accordingly.
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3 Connect the power cord to the appliance and to a power outlet.

The use of both power supplies is recommended for the Series 
3510 appliance.

4 Power on the appliance by pressing the power button on the front panel. 
After you press the power button, the power LED light is illuminated.

5 Set the IP address using the serial console interface.

6 Connect Port 1 to the LAN using the CAT5 10/100/1000 Base-TX cable 
supplied with the appliance.

Powering On the Appliance

When you power on, a series of messages appears on the serial console. The 
message output is similar to the following:

Hardware: 
UnitID: 003048724C52
Version: 4.5.12-B/1.2.5
Hostname: localhost
IP Address: 0.0.0.0

1)  Show Configuration
2)  Configure Ethernet
3)  Configure Network

Table 1 Serial Port Settings

Feature Setting

Baud rate 9600 bps

Bits 8

Parity None

Stop bits 1

Hardware flow control No
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4)  Configure DNS
5)  Configure Passwords Menu
6)  Configure Technical Support
7)  Diagnostics Menu
8)  Reboot
9)  Shutdown
0)  Quit

localhost>

Use the menu choices shown above to configure the administration port and 
establish network connectivity. The Show Configuration option allows you to 
verify the software version and administration interface configuration. Use the 
web-based Administration pages, as described in Chapter 3,  “Configuration 
and Management” 

Most user prompts display the default values and accept the default if you 
press ENTER. 
Some menu items present more options depending on the choice you make at 
the first prompt. Each menu selection is described in more detail in the 
remainder of this chapter.

Show Configuration

This option displays the software version and network parameters of the 
administration interface. Auto Negotiate, Speed, and Duplex are the current 
interface states. After you reconfigure the interface, it may take a few seconds 
for this command to reflect the change. The UnitID field is required to upgrade 
the license. Table 2  shows sample output.
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Table 2 Show Configuration

Menu selection localhost> 1

Output Version: 5.0.06-B/2.0.0
Hardware: 
UnitID: 003048724C52
Ethernet Settings for Slot 0/Port 1
  Auto Negotiate  : Yes
  Speed           : unknown Mbps
  Duplex          : half
Network Settings for Slot 0/Port 1
  DHCP            : Disabled
  IP Address      : 10.123.234.56
Netmask : 255.255.255.0
  Default Router  : 10.123.232.1
  Hostname        : localhost
DNS
  Primary DNS     : 10.0.1.20
Technical Support
  Access          : Enabled
  Callback        : Enabled
Administrative Interface: Slot 0/Port 1

--Hit <ENTER> to continue--
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Configure Ethernet

This menu selection sets the Ethernet parameters for the administration 
interface. Table 3  shows sample output.

Configure Network

This menu selection enables or disables DHCP, and sets the IP address, 
Netmask, Default router, and Hostname. Table 4  shows sample output.

You must use a static IP address rather than DHCP.

Table 3 Ethernet Setup

Menu selection localhost> 2

Output – 
Auto-negotiation

Ethernet settings for Slot 0/Port 1:
 (press <ENTER> to accept current setting)

 Auto Negotiate (y) [y/n]?  y
 Are you sure you want to make this change [y/N]? y
Please wait while changes are being applied ..
...

Output – No 
auto-negotiation

Ethernet settings for Slot 0/Port 1:
 (press <ENTER> to accept current setting)

 Auto Negotiate (y) [y/n]?  n
 Speed (unknown) [10/100/1000]? 1000
 Duplex (half) [h:half/f:full]? f
 Are you sure you want to make this change [y/N]? y
Please wait while changes are being applied ..
...
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Configure DNS

This menu selection sets the Domain Name Service (DNS) parameters when 
the DHCP server is disabled. Table 5  shows sample output.

Table 4 Network Configuration

Menu selection localhost> 3

Output  Network settings for Slot 0/Port 1:
 (press <ENTER> to accept current setting)

Use DHCP (n)  [y/n]? n

 IP Address (0.0.0.0) : 10.123.234.56
 Netmask (255.255.255.0) : 255.255.255.0
 Default router (0.0.0.0) : 10.123.232.1
 Hostname (localhost) : lab.example.net
 Reset all other interfaces, aliases, and statically-configured routes [y/
N]? n
 Are you sure you want to make this change [y/N]? y
Please wait while changes are being applied ..
...
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Configure Passwords Menu

This option displays a submenu to configure passwords for different purposes.

The Configure Console Password option sets a password to protect access to the 
serial port console.  If a console password is set, a password prompt is printed 
upon connecting to the serial console.  By default, no password is set and so no 
prompt is printed to ask for a password.  If a user disconnects from the serial 

Table 5 DNS Setup

Menu selection lab.example.net> 4

Output – 
DHCP enabled

WARNING: DNS manual settings not supported while using DHCP.
You must disable DHCP before changing DNS.

(The configuration utility will return you to the main menu.)

Output – 
DHCP disabled

DNS: (press <ENTER> to accept current setting)
 Primary DNS (0.0.0.0) : 10.0.1.20
 Secondary DNS (0.0.0.0) : 10.128.1.20
 Are you sure you want to make this change [y/N]? y
Please wait while changes are being applied ..
...

Table 6 Configure Passwords Menu

Menu Selection localhost> 5

Output 1)  Configure Console Password
2)  Configure Master-Client Shared Secret
3)  Return to Main Menu
32 Chapter 2



console without quitting back to the password prompt, the console will remain 
logged in so the next user to connect will have access without needing to give 
the password again.

If the appliance is part of a distributed configuration, the Modeling Engine 
designated as the master will associate itself with client units through an 
HTTP POST.  The Modeling Engine authenticates that initial POST using the 
Master-Client Shared Secret.  A default password is already set on all 
appliances as delivered, so it is not necessary to change this password. If you 
want to choose a different password, the same password must be set using this 
command on the master and on each of the clients.  The password may be up to 
250 characters long.

Table 7 Configure Console Password

Menu Selection localhost> 1

Output Enter new console password (no password): 
Re-enter new console password: 

If no password is entered and re-entered (the password is cleared), the 
following message is displayed:
Console password cleared.

If a new password is entered and re-entered, the following message is 
displayed:
Console password updated.

If the entered and re-entered passwords do not match, the following 
message is displayed:
Passwords do not match, no change made.
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Table 8 Configure Master-Client Shared Secret

Menu Selection localhost> 2

Output Enter new master-client shared secret (reset to default): 
Re-enter new master-client shared secret: 

If a the entered and re-entered secrets match, the following message is 
displayed:
Master-client shared secret updated.

If the entered and re-entered secrets do not match, the following 
message is displayed:
Secrets do not match, no change made.
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Configure Technical Support Access

This option allows technical support to log through secure shell (SSH), if the 
appliance is on a publicly accessible IP address. If the appliance is connected to 
a network where direct remote access is not possible due to firewall 
restrictions, you can enable the “Technical support callback” feature. This 
feature is disabled by default and your explicit action is required to enable it. 
When you enable this feature, an SSH connection is initiated from the 
appliance to a dedicated and tightly secured server at HP. Firewall rules 
usually allow such outbound SSH connections. The appliance configures this 
connection in such a way that new login sessions can be tunneled from the 
server at HP through the SSH connection back to the appliance. As in the case 
of direct remote access, these login sessions use SSH and require a specially 
encrypted key. 

Enabling technical support callback enables technical support access. 
Disabling technical support access disables technical support callback.

Table 9  shows sample output.
Initial Configuration 35



Remote Support Level Connectivity 

RAMS appliance offers limited access for the purpose of configuration and 
administration. Special support access is required to gather internal log files, 
access or update the internal database, and so on. To overcome this problem, 
HP   offers remote console connectivity.

Access Methods

• Support access method

— A secure SSH tunnel is setup to a single point of presence at HP to 
allow support access by engineer. This will enable you to route RAMS 
Appliance to the internet. 

— A technical support engineer will access the appliance using a public 
key. For this, a private key is deployed at the time of installing RAMS 
appliance and the public key is provided to the technical support.

• Support callback method

Table 9 Technical Support Setup

Menu selection lab.example.net> 6

Output – Technical 
Support disabled

Technical Support: (press <ENTER> to accept current setting)
 Enable Technical Support Access (e) [d:disable/e:enable]? d

 Are you sure you want to make this change [y/N]? y
Disabling technical support access...
Reloading sshd:[OK]
Disabling technical support callback...

Output – Technical 
Support enabled

Technical Support: (press <ENTER> to accept current setting)
 Enable Technical Support Access (d) [d:disable/e:enable]? e
 Enable Technical Support Callback (d) [d:disable/e:enable]? d
 Are you sure you want to make this change [y/N]? y
Enabling technical support access...
Reloading sshd:[OK]
Disabling technical support callback...
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— This method is applicable for the following scenarios:

— Appliance is not accessible through internet
— Appliance is behind firewall
— Appliance is within an intranet

— Prerequisites:

— The outgoing SSH port is not blocked
— You have performed a successful ping to the PDI server box. The 

address for PDI server box is: ramstarget.packetdesign.com 
[65.192.41.23] 

— You have enabled support callback 

At times, PDI Server callback ports may be exhausted and 
will not be available for new callback. This is a rare 
occurrence; try to enable support callback again after 
sometime in such cases.

— PDI technical support will access the appliance through SSH tunnel 
created to PDI server by a using private key 

• VPN Access method

— Client Cisco VPN or client Juniper VPN is used to access the appliance 
using SSH and private/public key pair 

— For RAMS, a Cisco VPN client is recommended 

 To follow this method, you must provide IP address, user 
name, and password of your network to the support. 

— Follow these steps to set up a Cisco VPN client:

a Install the Cisco VPN client

b Create a ‘Connection Entry’ 

c Enter the host IP address

d Choose one of the authentication method available 

e Enable Transparent Tunnelling under Transport tab and choose either 
TCP or UDP

f Save and connect
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• Virtual Access Method 

a. Connect a computer with a serial cable to the ILO port of the 
RAMS Appliance

b. Create a virtual session using HP Virtual Room or Webex

c. Share the desktop with the support engineer

d. Support engineer will then connect to the computer remotely 
and access the RAMS Appliance

e. To do this, support engineer will use the ‘emergency password’ 
to login as a super user
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Diagnostics Menu

This option displays the diagnostics menu.

Table 11  describes the diagnostic commands. 

Table 10 Diagnostics Menu

Menu selection lab.example.net> 7

Output 1)  Perform ping
2)  Perform traceroute
3)  Perform telnet
4)  Perform tcpdump
5)  Show Routing Table
6)  Show Interface Statistics
7)  Show Process Statistics
8) RAID Maintenance Menu
9)  Return to Main Menu

lab.example.net>
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Table 11 Diagnostic Commands

Command User Input Output

1: Perform ping Interface name
Host name or IP 
address 

Results of ping to the specified appliance. 

2: Perform 
traceroute

Interface name
Host name or IP 
address 

Trace of the route between the selected interface 
port and the specified appliance.

3: Perform telnet Host name or IP 
address

Telnet connection attempt to the specified 
appliance. 
To forcibly disconnect an established telnet session, 
enter:
  CTRL-] close 
then press Enter.

Note: The appliance does not accept incoming 
Telnet requests.

4: Perform 
tcpdump

Interface
Filter expression 
(optional)
Filename for 
output (optional)
Number of 
packets to capture

Dump of network traffic on selected interface.
The system recognizes all filter expressions 
compatible with tcpdump 3.9.4. Does not allow 
command line options (such as -w) in the filter 
expression.
Accepts an optional filename parameter and writes 
to that filename in the /var/ftp directory. When 
output is to a file, the number of packets captured is 
limited to 1,000,000 to prevent filling the disk.

5: Show Routing 
Table

None Contents of the kernel IP routing table.
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6: Show 
Interface 
Statistics

None Displays the output of ifconfig.

7: Show Process 
Statistics

None Displays the output of top. Several of the system 
processes (including kjournald) are filtered out to 
make the list more manageable. The output can be 
run once, N times, or until you enter Ctrl-C.

8: RAID 
Maintenance 
Menu

Drive number (for 
options 3 and 5)

Displays options for RAID diagnostics. Options:
1)  Get RAID status 

Show the current RAID status.
2)  Silence RAID Controller Alarm 

On some controllers, there is an audible alarm 
that sounds when there is an error condition on 
one of the drives. This command turns off a 
sounding alarm.

3)  Detach Physical Drive
Detach a specified single drive from the array. Do 
this before physically removing a drive from the 
system.

4)  Rescan RAID Drives
Rescan the controller’s attached ports. This is 
necessary on some RAID controllers to get them 
to recognize a new drive after it is inserted. 

5)  Rebuild RAID Volume
Rebuild a specified physical drive. Note that on 
some controllers, rebuilding starts automatically.

9)  Return to Diagnostics Menu

Table 11 Diagnostic Commands (cont’d)

Command User Input Output
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Reboot

This menu selection reboots the appliance. The reboot command is also 
available on the web-based Administration Interface. Table 12  shows sample 
output.

Shutdown

Shutdown stops all internal tasks and powers down the appliance. Always use 
the shutdown command before switching off power. The shutdown command 
is also available on the web-based Administration page. Table 13  shows 
sample output.

Table 12 Reboot Command

Menu selection lab.example.net> 8

Output Are you sure you want to reboot [y/N]? y
Rebooting ...

Table 13 Shutdown Command

Menu selection lab.example.net> 9

Output Are you sure you want to shutdown [y/N]? y
Shutting down ...
42 Chapter 2



3 Configuration and Management
After you install the hardware that is required to connect one or more appliances to the 
network, you can configure each appliance using the administrative web interface. This 
chapter describes how to access the web interface and perform configuration tasks.

Chapter contents:

• Configuration Overview on page 43

• Connecting to the Web Interface Home Page on page 44

• Logging In on page 45

• Setting the Time and Date on page 48

• Applying License Keys on page 50

• Designating the Master and Clients on page 54

• Configuring the Network Interfaces on page 62

• Configuring SNMP Agent security on page 69

• Configuring SSL Certificate on page 70

• Viewing System Settings on page 74

• Configuring the Appliance for Recording on page 74

• Additional Configuration Tasks on page 122

• Enabling Technical Support Access on page 129

Configuration Overview

In a distributed deployment with multiple Route Recorders, a Modeling Engine must serve as 
the master appliance. You designate this appliance as the master during the configuration 
process. The other units in the deployment become clients of the master.
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Master and client designations do not apply to single-appliance configurations.

The following properties apply to the master and clients:

• Master—A Modeling Engine that allows centralized configuration of all client appliances 
in a multi-appliance deployment. You can monitor and manage the clients using the web 
interface on the master.

• Clients—One or more appliances that are configured and monitored by the master in a 
distributed configuration. A client can be a Route Recorder, Flow Collector, or Flow 
Analyzer.

Follow the procedures in this chapter to configure the Route Recorder to listen to particular 
protocols, the Flow Collectors to collect and aggregate traffic data, and the Flow Analyzer to 
create network-wide reports. 

Make sure that you complete the tasks in the order in which they appear in this 
chapter. 

Connecting to the Web Interface Home Page

A built-in web server provides primary administrative access. The following browsers are 
supported:

• Internet Explorer 8.0

• Firefox 3.5.2

• Safari 4

To connect to the web interface Home page, perform the following steps:

1 Open a standard web browser and enter the initially configured address or hostname of the 
appliance.

In a distributed configuration, enter the address or hostname of the designated master.

The Home page is password-protected and user input is encrypted using SSL. A 
confirmation security dialog box opens the first time you access the website. The secure 
web pages have self-signed certificates from the appliance.
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(Internet Explorer 7.0) When you enter the IP address or hostname in Step 1, 
a window may open with the warning “There is a problem with this website’s 
security certificate.” It is safe to ignore this warning. Select “Continue to this 
website (not recommended)” to connect to the Home page.

2 Click Yes to accept the certificate and allow the secure web pages to open.

The Login page opens as shown in Figure 3.

Figure 3 Log-In Page

Logging In

Before you begin configuration tasks, you must log into the Administration pages and change 
the default administration password.

To log into the system, your browser must accept cookies. 
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To log into the Administration pages, perform the following steps:

1 Open a standard web browser and enter the initially configured address or hostname of the 
appliance to open the Login page.

Figure 4 Log-In Page

The Home page is password-protected and user input is encrypted using SSL. A 
confirmation security dialog box opens the first time you access the website. The secure 
web pages have self-signed certificates from the appliance.

(Internet Explorer 7.0) When you enter the IP address or hostname in Step 1, 
a window may open with the warning “There is a problem with this website’s 
security certificate.” It is safe to ignore this warning. Select “Continue to this 
website (not recommended)” to connect to the Home page.

2 Enter the default administrator user name (admin) and the default password (admin).

3 Click Login. 

After a period of inactivity, you must repeat this step to have continued access to the 
Administration pages. 
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After a successful login, the Home page opens as shown in Figure 5. 

Figure 5 Home Page

The Home page provides links to support and documentation downloads for the 
X Window system or VNC, either of which is required to run the software. The 
X Window system is recommended for users with high-speed Internet 
connections, while VNC is more appropriate for users with dial-up or Digital 
Subscriber Line (DSL) connections.

The third-party X Window system software provided with the appliance comes 
with a 30-day evaluation license. After this initial 30-day period, you must 
purchase a license from StarNet Communications Corporation to continue 
using the software.
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For security reasons, we recommend that you change the administrator password when you 
first log in, and on a regular schedule after that.

To change the administration password, perform the following steps:

1 From the Home page, choose Administration > Users.

2 On the User Administration page, select the administrator’s user name from the Current 
Users list, and then enter the new password.

3 Click Update.

For more information about user administration, see Chapter 4,  “Administration” 

Setting the Time and Date

You must set the time and date for every appliance in your configuration before continuing with 
the procedures described in this chapter. To access the Time and Date page, choose System 
>Time and Date from the Left Navigation Bar pane.

In a multi-appliance configuration, access the Time and Date page of each 
client appliance individually to configure time and date settings.

We strongly recommended that you synchronize the time and date for each appliance with a 
Network Time Protocol (NTP) server to avoid having to make manual time adjustments, 
potentially backwards in time. (For multi-appliance configurations, NTP is required.) Because 
the recorded routing topology database requires that time progresses monotonically, the NTP 
dæmon will not adjust the time if the discrepancy is large enough to require a step adjustment 
rather than slowly slewing the clock. To avoid any problems, set the time manually to the 
correct time (within a few minutes), and then select Get time from server. After the time is 
set using the NTP server option, you can verify the results on the View Configuration page.

If you must set the clock backwards manually, you must first rename all 
currently recording databases and start a new database.

To set the time and date for each appliance, perform the following steps:

1 Choose Administration > Time and Date.
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2 Select the time zone from the Time Zone drop-down list (Figure 6).

3 Choose whether to set the time and date from an NTP server or set it manually.

• Get time from server—Enter the primary and secondary NTP server (if necessary) 
in the Primary NTP Server and Secondary NTP Server text boxes, respectively.

• Set time manually—Click the Set time now check box and adjust the time fields as 
necessary.

4 Click Update.

Modifications to the Time and Date page are not permitted if recording is in 
progress. 
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Figure 6 Time and Date Page

Applying License Keys

A license determines the available functions and the number of supported users and routers. 
For Route Recorder it also determines the supported protocols.

Each license key is tied to an identification number, or Unit ID, which corresponds to an 
appliance with the same Unit ID. In a distributed configuration, license keys for all units in 
the configuration are applied to the master, which in turn assigns the appropriate license keys 
to its clients based on the Unit ID numbers. Traffic Explorer rejects licenses without a Unit ID.
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To view the license information, start on the Administration page. Locate the Maintenance 
link in the left frame, then click License to launch the License Update page. This page displays 
the current license information for the system, and lets you activate your temporary license or 
install new license keys This page displays three buttons:

• RAMS — Provides GUI functionality and is enabled for viewing traffic information

• Traffic — Provides traffic functionality

• Modeling Engine — Provides functions for testing configurations with replication enabled

RAMS comes with a temporary license that unlocks all protocols for up to three users and 1000 
routers. The temporary license expires after 60 days. To activate a temporary license, click the 
corresponding button on the License Update page, shown in Figure 7: RAMS, Traffic, or 
Modeling Engine. For example, to activate the RAMS license, click RAMS, and the temporary 
license is applied.

If the temporary license expires before you have installed a permanent license, data recording 
is disabled, protocol configuration is disabled, and a warning message is displayed on the 
RAMS user interface. For uninterrupted use of the RAMS, you must obtain and install your 
permanent license key before the temporary license expires.

If you are setting up a system of multiple units, you will need to activate the 
temporary license on each appliance separately by logging into the 
Administration page, navigating to the License Update page, and installing the 
appropriate temporary license key. From the master appliance, you can then 
proceed to add clients, configure recording, etc.
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To install a new license key, perform the following steps:

1 Enter the license key text-string in the space provided, exactly as it was given to you, 
including punctuation. If you received your license key electronically, you can use the 
cut-and-paste feature on your computer. Otherwise, you can manually type it in. Take care 
to avoid typing mistakes.

2 Click Update. This installs the license key. The functionality authorized by the license 
key is immediately available.Each licensing component is described in Appendix D, 
“License Feature Details.”
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Figure 7 License Update Page

The License Update page displays the applied license key components and the corresponding 
expiration dates. The master later distributes license features to client units as described in 
Designating the Master and Clients on page 54.
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In some cases, you may need to reapply licenses from the master to its clients. For example, if 
a client is unreachable when a new license key is applied to the master, that client will not 
receive the new key when it is initially distributed among the appliances in the configuration. 
When the client reestablishes contact with its master, click the Re-Apply All button to 
redeploy the new license key. 

If incorrect licenses have been applied on an appliance, you may correct that by clicking 
Remove all licenses on this unit. This erases all licenses that have been applied and allows 
you to reapply the correct licenses.

Designating the Master and Clients

Distributed configuration and management allows an administrator to configure and monitor 
multiple Route Explorer/Traffic Explorer components from a central location. If you are 
working with a single-appliance configuration, skip this section and proceed to Configuring the 
Network Interfaces on page 62.

The following component definitions apply to the units in a distributed configuration:

• Route Recorders—Collect routing information to store in the database.

• Modeling Engine — Create a synthesized view of all network data collected by the 
recorders. In a deployment with multiple Route Recorders, a Modeling Engine must serve 
as the master appliance. It replicates the data collected by each Route Recorder, providing 
a locally accessible database of network-wide information. The centralized Modeling 
Engine also feeds prefix information to the Flow Collectors and supplies data to the Flow 
Analyzer to create reports. For Traffic Explorer, Modeling Engine displays this data in a 
VNC or X viewer. See the “Viewers” chapter in the HP Route Analytics Management System 
User’s Guide for more information.

• Flow Recorder—Collects traffic flow information from NetFlow recorders and stores it in 
the database. The Modeling Engine queries the database to create a synthesized view of 
traffic flow through the network.

• Flow Analyzer—Receives traffic data from the Flow Collectors. The Flow Analyzer uses 
this information to generate aggregate traffic flow reports and alerts.
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Assigning the Master Role to an Appliance

The master in a distributed configuration allows you to view and manage multiple Route 
Explorer/Traffic Explorer appliances through its administration interface. You must designate 
the Modeling Engine as the master.

The appliance designated as master will associate itself with client units 
through an HTTP POST. To authenticate that initial POST, you must use the 
Master-Client Shared Secret. A default shared secret is already set. If you want 
to choose a different one, use the Configure Master-Client Shared Secret 
command on the master appliance and on each client appliance to set the new 
secret. 
The Master-Client Shared Secret must be the same on all units.
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To designate the master appliance, perform the following steps on the system that will be the 
master: 

1 Choose Administration > Units.

2 On the Units page, the IP address of the administrative interface on the master appliance 
is listed in the text box. Click Make Master.

The master appliance is designated and the Client Configuration section appears on the 
Units page.

Figure 8 Units Page

The address of the master appliance appears in the Client List box.

You must now assign each of the clients that the master appliance will manage.

Adding Clients to the Configuration

Before you assign client units to the master, be sure the systems in the configuration are 
running and reachable. When you add a client, the master appliance automatically applies the 
appropriate license keys. When a client is bound to the master, that client cannot be bound to 
another master until the master-client relationship is dissolved (see Relinquishing the Master 
Status on page 60). License details are returned when a client is added successfully. For 
instance, a message indicating that two license keys were applied is displayed on the master’s 
Units page after you have added a client.
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The clocks of the units must be synchronized before you add clients to the 
configuration.
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To add clients to the configuration, perform the following steps:

1 On the Units page of the master, enter the IP address of a client in the Add New Client text 
box.

2 Click Add.

A success message is displayed. The IP address of the client is now listed in the Client List 
box. If the client does not appear in the Client List box, make sure the system is properly 
connected to the network and reachable by the master.

As you add each client, the Client Status table on the Units page is refreshed to display an 
updated list of clients. Each client IP address has an associated type. For example, if a system 
is licensed to act as a Modeling Engine, the Type column lists this description. The Status 
column indicates whether the client is running (Up) or not (Down).

Use the Refresh Client Status button at the bottom of the Units page to update the displayed 
version, type, and status of the clients listed on the page.

Figure 9 Client Status Section of Units Page
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Adding a Second Modeling Engine to the Configuration

One Modeling Engine is sufficient for most networks. However, if you anticipate that more than 
five users will need to access the Modeling Engine simultaneously, or if you have recorders at 
a vast geographical distance from the Modeling Engine, you will need to add an additional 
Modeling Engine to your network. 

Before adding the second Modeling Engine, verify that the master unit has all 
the necessary licenses.
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To add a second Modeling Engine to your network, perform the following steps:

1 Choose Administration > License.

2 Paste the license for the second Modeling Engine into the License Update box, and click 
Update.

3 Return to the Units page, and enter the IP address for the second Modeling Engine in the 
IP Address text box.

4 Click Add.

If the license was successfully applied for the second Modeling Engine, 
Data Source Configuration is listed in the left navigation bar.

You now need to specify how to obtain the routing data for the Modeling Engine. There are 
several ways to obtain data:

• From the Route Recorder

• From the primary Modeling Engine (if it is replicating)

• From the second Modeling Engine

See Choosing a Data Source on page 172 for more information.

Relinquishing the Master Status

If necessary, you can remove the master status from an appliance and assign this function to 
another Modeling Engine in the configuration. Keep in mind that relinquishing the master role 
requires you to delete all client configurations. 

To remove the master status, perform the following steps in the order listed:

1 Delete each of the client configurations on the master from the Recorder Configuration 
page. To delete client configurations on the master appliance, perform the following steps:

a Choose Recorder Configuration.

b Click Stop All Recording.

c Click the client to remove from the tree structure.

d Click Delete, and then click Yes to confirm.
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e Repeat Steps c and d to remove additional clients from the configuration.

If a client is inaccessible for any reason, you will receive a warning message 
when you attempt to delete its configuration. If necessary, you can forcibly 
remove the configuration of the inaccessible client. If you choose to forcibly 
remove the client configuration of an inaccessible appliance, the client will be 
unusable until it is reset to factory defaults.

2 On the Units page of the master appliance, remove each of the clients from the Client List 
box. To remove clients from the client list, perform the following steps:

a Choose Administration > Units.

b Select the client IP address from the Client List box.

c Click Delete.

A success message appears. The IP address of the client is now removed from the 
Client List box and from the Client Status table on the Units page.

Deleting a system from the Client List box means the client appliance no longer has a 
relationship with the master and is free to become the client of another master.

3 On the Units page, click Relinquish Master Role.

The appliance no longer functions as the master of the distributed configuration. You can 
now designate a second appliance the configuration master and, if desired, add the first 
appliance as a client of the new master. For more information, see Designating the Master 
and Clients on page 54.
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Configuring the Network Interfaces

Use the Network and Interface Configuration page (Figure 10) to set the appliance’s 
networking configuration and add interfaces and static routes.

Figure 10 Network and Interface Configuration Page
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Before  you can change the Administrative Interface IP address on a system 
(the one with Allow Admin selected), you must delete all recorder 
configurations, delete all associations between master and client, and 
relinquish the master role. Failure to do so may require a reset to factory 
defaults on all units to recover.

In a multi-appliance configuration, access the Network and Interface 
Configuration page of each client appliance individually to configure network 
and interface settings.

Before you configure the network manually or using DHCP, enter the hostname of the 
appliance in the Hostname text box.

It is strongly recommended that you use static IP addresses rather than DHCP 
when you configure a stand-alone system. In a multi-appliance deployment, 
static IP addresses are required.

To configure the network manually (recommended), perform the following steps: 

1 Choose Administration > Network and Interface. 

2 Configure the following information:

• Hostname, which may be a fully qualified domain name or just the simple name.  It 
should be the same name that users specify when accessing the appliance with a web 
browser in order to avoid authentication warnings. Enter the host name before you 
configure the network manually or using DHCP.

• Domain suffix, which is the default value that the appliance uses when looking up host 
names that have been supplied without a domain name.

• Primary DNS IP address

• Secondary DNS IP address (optional)

• Properties for each interface (name, IP address, and netmask). Select Allow Admin on 
one interface. Refer to Selecting the Administration Interface on page 65.

3 Click Update.
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To configure the network using DHCP (single units only), perform the following steps:

1 Choose Administration > Network and Interface. 

2 Select Use DHCP.

3 Enter a name to identify the interface.

4 Select Auto Negotiate to use automatic speed and duplex settings.

5 Click Update. 

DHCP automatically configures the IP address, netmask, default router, and primary and 
secondary DNS servers.
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Selecting the Administration Interface

Administrative access to the appliance is available only through one of the configured 
interfaces. For configurations without an option card, this interface is one of the two RJ-45 
jacks labeled Port 1 and Port 2 (Port 1 by default). If you have a multiple port option card, any 
of the interfaces can act as the Administration Interface. On the Network and Configuration 
page, click Allow Admin for the interface that acts as the Administration Interface.

For OSPFv3, you must specify an instance ID when configuring an interface.

Use the IP address that is associated with the interface to administer the appliance. The IP 
address is also used in the following ways:

• As a File Transfer Protocol (FTP) address for file transfer to the appliance.

• As an address where XML queries are sent.

• As an address required by technical support when any request for assistance is made.

• As an address for the X Window System or VNC client software connections.

Configuring VLAN Interfaces

The appliance can support  virtual LAN (VLAN) interfaces that are configured on top of the 
physical Ethernet interfaces. By configuring VLAN interfaces on the Network and Interface 
Configuration page, you can ensure compatibility with network installations in which the 
switches present multiple VLANs on a port. 

A configured VLAN interface can serve the same purposes as a physical interface, including 
serving as the selected administrative interface. You can configure multiple VLANs, for 
example, to connect to each of the areas in a multiple-area OSPF network.

To configure a VLAN interface, perform the following steps:

1 Choose Administration > Network and Interface. 

2 In the VLAN Interfaces section, select the desired interface from the Interface drop-down 
list.

3 Enter the VLAN ID.

4 Click Update.
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The new interface is added to the table near the top of the page, and a new entry line is 
added in the VLAN Interfaces area. Add additional VLAN interfaces as needed by 
repeating the previous steps.

5 For each VLAN, enter the following information in the interface table.

• Name (optional)

• IP address

• Netmask

6 Click Update.

To modify an interface, make changes, and click Update. To remove an interface, manually 
erase the details, and click Update.

Configuring Alias Interfaces

Use an alias interface to add an additional IP address to an interface inside the netmask that 
is configured for that interface. To configure an alias, there must an IPv4 address assigned to 
a VLAN interface.

To configure an alias interface, perform the following steps:

1 Choose Administration > Network and Interface. 

2 In the Alias Interfaces section, select the desired interface from the Interface drop-down 
list.

3 Enter a name for the alias in the Alias Name text box.

4 Enter the IP address in the IP Address text box.

5 Click Update.

The new interface is added to the table near the top of the page, and a new entry line is 
added in the Alias Interfaces area. Add additional alias interfaces as needed by repeating 
the previous steps.

6 For each alias interface, enter the following information in the interface table.

• Name (optional)

• IP address

• Netmask

7 Click Update.
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To modify an interface, make changes, and click Update. To remove an interface, manually 
erase the details, and click Update.

Configuring a Static Route

Use a static route to route packets directly to a specific router in a particular network area. If 
the address of the Administration Interface is configured, as recommended, then you must also 
configure a default static route.

For EIGRP topologies, the default route configured on an interface must be suitable for a Telnet 
or SSH transmission to all routers in the autonomous systems monitored on that interface. If 
multiple physical interfaces or tunnels are configured, you can configure a separate default 
route on each interface by specifying a target router on the subnet of the interface.

If no default route is set on a particular interface, the EIGRP Route Recorder uses policy 
routing to direct Telnet or SSH packets through one of the EIGRP peer routers. All the EIGRP 
peer routers on an interface are suitable for this purpose. In this case, you must install a 
default route on that interface to avoid the possible selection of an unsuitable peer. If more than 
one interface is connected to the same autonomous system (for improved visibility), the Route 
Recorder prefers a broadcast interface over a tunnel interface. Configuring the Route Recorder 
for the Collector on page 95 describes how to configure the Collector for non-EIGRP topologies.

The appliance does not monitor the Internet Control Message Protocol (ICMP) 
redirect messages that are used by some enterprises to route around failures. 
The appliance does not accept ICMP redirects to update its routing table.

To add a static route, perform the following steps:

1 Choose Administration > Network and Interface. 

2 In the Static Routes section, enter the destination, default router, and netmask.

3 Click Update.

The new interface is added to the table near the top of the page, and a new entry line is 
added in the Static Routes area. Add additional static routes as needed by repeating the 
previous steps.

You can override the default gateway that is inserted by DHCP by adding two 
static routes: 0.0.0.0/128.0.0.0 and 128.0.0.0/128.0.0.0.
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To modify a static route, make changes, and click Update. To remove a static route, manually 
erase the details, and click Update.

It can take up to 30 seconds before a static route becomes visible while the new 
information is written to the system asynchronously. If you click Update again 
in this time period, the new static route information is erased. If the page 
returns earlier and does not display the new routes, click Reload on the 
browser to refresh the page.

Configuring Multiple Port Options

You can monitor a different OSPF or IS-IS area or EIGRP autonomous system with each of the 
ports on the appliance, including those on a multiple port option card. Multiple area monitoring 
is also available using tunnels. See Configuring GRE Tunnels on page 125 for more 
information.

To set up multiple port monitoring, keep the following factors in mind:

• The default router must be on the same network as the Administration Interface.

• One of the interfaces must be the Administration Interface. The default is slot 0 port 1.

• You can use DHCP to set the IP address on the Administration Interface.

• You must assign an IP address to each of the ports or interfaces.

To configure multiple ports from the Network & Interfaces Configuration page, perform the 
following steps:

1 Choose Administration > Network and Interface. 

2 Click Allow Admin to switch the administrative interface to the desired port.

3 To use DHCP on the Administrative Interface, select Use DHCP.

It is strongly recommended that you use a static IP address rather than 
DHCP. In a distributed configuration, a static IP address is required.

4 For each of the other interfaces on the card, enter the following information in the 
appropriate text boxes:

• Name (optional)

• IP address
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• Netmask

5 Click Update. It may take some time for all of the interfaces to become active.

After the network is configured, check that the network settings are correct by reviewing the 
View Configuration page.

Configuring SNMP Agent security

You can define the security settings that apply to the Simple Network Management Protocol 
(SNMP) agent running on the appliance by way of the SNMP Agent Configuration page. See 
Configuring the Route Recorder for the Collector on page 95 for information on how SNMP is 
used with the Collector.

If you plan to use SNMPv3, see Configuring SNMP v3 Profiles on page 104 for instructions on 
defining SNMP v3 profiles before you configure SNMP agent security.

To configure SNMP agent security, perform the following steps:

1 Choose Administration > SNMP Agent Configuration.

The SNMP Agent Configuration page opens (Figure 11).

Figure 11 SNMP Agent Configuration

2 If you plan to use SNMP v2, enter the SNMP v2 community name.

3 If you plan to use SNMP v2, select an SNMP v3 profile. See Configuring SNMP v3 Profiles 
on page 104 for instructions on defining SNMP v3 profiles.

4 Click Save.
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Configuring SSL Certificate 

The appliance web server uses a built-in self-signed certificate for SSL security on https 
connections.  This may result in security warnings from web browsers that access the server.  
Use the SSL Certificate page to create a Certificate Signing Request (CSR). The CSR allows 
you to obtain and install a certificate that is signed by a public or corporate Certificate 
Authority (CA).

To create and submit a CSR: 

1 Choose Administration > SSL Certificate.

The SSL Certificate page opens (Figure 12).

Figure 12 SSL Certificate Page

2 Click Create CSR to display the request form.
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Figure 13 CSR Form

3 Complete all of the requested information, and click Generate Key and CSR. 1024 bits 
is the default.

The key and CSR are generated, and a page displaying the request opens. 
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Figure 14 CSR Key and Download Options

4 Perform any of the following operations from this page:

• Click File Download under Certificate Signing Request  to download the CSR to be 
sent to the CA.

• Click File Download under Server Private Key to download a copy of the server’s 
private key for backup. The key is kept on the appliance, but it is strongly 
recommended that you back it up on another system. The key is not encrypted, so make 
sure that you have backed it up to a private and secure location.

• Click Cancel CSR if you do not want to use the generated CSR, but instead want to 
continue to use the built-in self-signed certificate.

• When the CA returns the signed certificate, copy and paste the certificate into the 
space provided or click Browse to upload the file containing the certificate. Click Use 
Certificate. Click Clear if you need to remove the pasted certificate.

After you click Use Certificate, the process is now complete. When users connect from a 
browser that has the CA certificate installed, no security warning is issued.

If you later return to the SSL Certificate page, the page presents the following options:

• Obtain a new certificate using the same CSR. You can use this option to add an updated 
certificate if the previous certificate is due to expire.

• Remove the installed Certificate and resume using the built-in, self-signed certificate. This 
option removes the CSR completely. If you decide to request a new certificate at a later 
time, you must complete a new CSR.

Viewing System Settings

System settings are listed on the View Configuration page for each appliance. To access the 
View Configuration page, choose Administration > View Configuration.

Configuring the Appliance for Recording

If you are working with a single-appliance configuration, proceed to Configuring the Route 
Recorder on page 78, where you’ll configure the Route Recorder to listen to particular protocols.
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In a multi-appliance deployment, components are configured and managed from the master 
appliance. All configuration tasks described in this section are performed on the Recorder 
Configuration page of the master appliance. You cannot configure or manage appliance 
components from the Recorder Configuration pages of client units. The Recorder Configuration 
page at the client level displays only that client’s branch of the configuration hierarchy tree, 
where settings are view-only.

You must perform the following component management tasks in this order:

1 Creating a Configuration Hierarchy on page 75

2 Configuring the Route Recorder on page 78

3 Adding Protocol Instances on page 80

4 Configuring the Flow Collector on page 109 (Traffic Explorer only)

If the Flow Analyzer is already running when you begin recording on the Route 
Recorder or Flow Collectors, you must restart the Flow Analyzer as described 
on Starting and Stopping the Flow Collectors on page 113.

Click Recorder Configuration on the top navigation bar to access the Recorder 
Configuration page.

Creating a Configuration Hierarchy

This section describes how to create a configuration hierarchy. Use a configuration hierarchy 
to organize components into a tree structure, with each branch representing a different part of 
the configuration. For example, Figure 15 shows branches for Traffic Explorer for different 
protocols and the recorders that listen to those protocols. You can also organize the tree 
according to the area being monitored within each protocol.
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Figure 15 Configuration Hierarchy
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The branches in the tree are grouped under a top-level administrative domain, represented by 
a folder icon on the web interface. You should first establish one top-level administrative 
domain so that you can easily rename the complete hierarchy of recorded databases for backup 
purposes. You can add multiple administrative domains beneath the top-level administrative 
domain as needed to organize the structure of the network, for example, to reflect geographical 
regions, or management divisions running separate protocol instances, or to designate traffic 
and reports instances. This tree structure is useful when opening a topology, because you can 
load the entire tree or focus only on particular branches. For more information, see the “The 
Routing Topology Map” chapter in the HP Route Analytics Management System User’s Guide.

The organization of the tree is reflected by the Modeling Engine when you open a topology in 
the VNC or X viewer.

To begin creating a configuration hierarchy, perform the following steps:

1 On the master appliance, choose Recorder Configuration to open the Recorder 
Configuration page.

2 Click Networks.

A pop-up menu opens.

3 Move the cursor to Add, and select Administrative Domain (see Figure 16).

Figure 16 Administrative Domain

The Recorder Configuration page opens.
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Figure 17 Adding an Administrative Domain

4 Enter a name for the administrative domain. The name must consist solely of 
alphanumeric characters, with an alphabetic character first.

This is the top-level domain under which you will create the rest of your hierarchy.

5 (Distributed configurations only) In the IP Address field, choose None from the drop-down 
list if you are establishing a top-level domain. Otherwise, choose the IP address of the 
appliance to add to the hierarchy.

6 If the administrative domain represents a BGP confederation, perform the following steps:

a Select Domain is a BGP AS Confederation. A BGP confederation is a domain that 
contains multiple member autonomous systems, but appears to outside autonomous 
systems to have a single AS identifier. For more information, see Configuring a BGP 
Confederation on page 83.

b Enter the confederation ID number in the BGP AS Confederation Id text box.

7 Click Add Domain.

8 Click the + symbol to the left of Networks to open the folder that shows the domain name 
you just entered.

9 See the next section, Configuring the Route Recorder on page 78, to configure one or more 
Route Recorders to listen to different protocols across the network.

Configuring the Route Recorder

This section introduces the main functions of the Route Recorder and describes how to 
configure a Route Recorder to start recording. You must configure the Route Recorder before 
configuring other appliance components.

Set the time and date before configuring the recorder, per the instructions 
described in Setting the Time and Date on page 48. The date and time must be 
set before data recording begins because the system relies on accurate time 
stamps to generate reports. We strongly recommend that you use NTP to set 
the time and date.

In a deployment with multiple Route Recorders, you can configure different network segments 
to be recorded by different Route Recorders and configure each to listen to one protocol or 
multiple protocols per area or AS. Only one Route Recorder can record per area or AS.
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To add a Route Recorder to the configuration hierarchy, perform the following steps:

1 Choose Recorder Configuration on the master appliance.

2 Click the top-level domain name you added in Creating a Configuration Hierarchy on 
page 75 (for example, CorpNet).

3 Move the cursor to Add.

The option to add another level of domain name hierarchy appears, as shown in Figure 16. 

4 Click Administrative Domain.

The Name of new Administrative Domain box appears as shown in Figure 17.

5 Enter a name for the administrative domain. The name must consist solely of 
alphanumeric characters, with an alphabetic character first (for example, IGPRecorders).

6 (Distributed configurations only) From the IP Address drop-down list, choose the IP 
address of a Route Recorder, or choose None. When you choose None, you create a branch 
in the configuration tree that you can use to organize the tree by protocol or by area. For 
example, assume that you add a IGPRecorders branch to the tree. In subsequent steps, you 
can add OSPF and IS-IS branches under IGPRecorders. Then, under OSPF and IS-IS, you 
can add one or more Route Recorders.

7 If the administrative domain represents a BGP confederation, perform the following steps:

a Select Domain is a BGP AS Confederation.

A BGP confederation is a domain that contains multiple member autonomous 
systems, but appears to outside autonomous systems to have a single AS identifier. 
For more information, see Configuring a BGP Confederation on page 83.

b Enter the confederation ID number in the BGP AS Confederation ID text box.

8 Select the check box for MPLS WAN if you want to set up this domain as an MPLS WAN 
site. See the “MPLS WAN” chapter in the HP Route Analytics Management System User’s 
Guide for guidelines on setting up a domain as an MPLS WAN site.

9 Click Add Domain.

The domain name you just entered (for example, IGPRecorders) appears in the hierarchy.

The Route Recorder listens to routing protocol packets and records that data in a database. To 
set up the databases, refer to Adding Protocol Instances on page 80.
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Recorder Configuration Restrictions for MPLS WAN

The following guidelines apply to recording by protocol for MPLS WAN. For more information, 
see the “MPLS WAN” chapter in the HP Route Analytics Management System User’s Guide.

• Record IGP protocols as usual (via tunnels if needed).

• Record internal BGP (IBGP) peering with customer edge (CE) routers.

• For static recording:

— There is usually one static instance per network.

— Collect static routes from CE routers if they have static routes to/from provider edge 
(PE) routers.

— Create a static instance (even if there is no route collection), for MPLS WAN with 
traffic.

• Traffic (if applicable):

— Put all traffic-related instances outside of sites

— Record traffic at a site through all CE interfaces (simple) or through CE interfaces on 
CE-PE links, plus interfaces with outbound traffic to capture the effect of outbound 
traffic.

— You can record traffic differently on different sites, but do not mix the different 
recording options within the same site.

Adding Protocol Instances

The appliance uses a hierarchical tree to represent the collection of IGP and BGP routing 
protocols to be recorded and the relationships among them.

Each instance of an IGP or BGP routing protocol is represented by a page icon as a leaf in the 
tree. A protocol instance includes the set of routers that communicate directly with each other 
using that routing protocol. For example, the routers within a set of interconnected OSPF areas 
form one protocol instance.

Note that multiple instances of the same protocol cannot be configured within a single 
administrative domain. If a network contains two instances of the same protocol, then you 
must create two administrative domains to contain them. Also, a BGP instance cannot be 
configured in an administrative domain whose ancestor directly contains a BGP instance.
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Before starting to record routing data using the Route Recorder, you must assign a name to the 
database where the data will be stored. You must also specify the routing protocol (IS-IS, OSPF, 
EIGRP, or BGP) and the network interface used to listen to the routing protocol packets.

For each interface, the appliance supports an interface password and an area 
or domain password. If that interface is recording Level 1, enter the area 
password when configuring that interface in the recorder configuration. If the 
interface is recording Level 2, the domain password should be used. If the 
interface is recording both Level 1 and Level 2, then the area and domain 
passwords configured on the router must be the same.

When configuring the appliance for the first time, at least one database must be specified for 
storing routing data.

To add a protocol instance and start recording routing data, perform the following steps:

1 Choose Recorder Configuration on the master appliance.

2 Click the label that you added in Configuring the Route Recorder (for example, 
IGPRecorders) and choose Add.

3 Choose the desired type of protocol instance (BGP, OSPF, OSPFv3, IS-IS, or EIGRP).

One of the following options is displayed to the right of the configuration tree:

• If the label you added in Configuring the Route Recorder is bound to an IP address, the 
configuration section for the selected protocol appears. Proceed to Configure an IGP 
Instance on page 84 or Configure a BGP Instance on page 90 for detailed instructions 
about how to configure the protocol instance.

• If the label you added in Configuring the Route Recorder is unbound, a drop-down list 
of Route Recorders appears with the Select a unit button. Proceed to Step 4.

4 Choose one of the following options, and then click Select a unit:

• If you will be adding only one Route Recorder under this protocol, choose the Route 
Recorder’s IP address from the drop-down list. The configuration section for the 
selected protocol appears. Proceed to Configure an IGP Instance on page 84 or 
Configure a BGP Instance on page 90 for detailed instructions about how to configure 
the protocol instance.

• If you will be adding more than one Route Recorder under this protocol, choose 
Multiple from the drop-down list. Proceed to Step 5.
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5 Click the protocol label you just added and select Add Route Recorder from the pop-up 
menu. Then choose the IP address of the Route Recorder from the pop-up menu.

The configuration section for the selected protocol appears on the right side of the Recorder 
Configuration page. For detailed instructions about how to configure the protocol instance, 
see Configure an IGP Instance on page 84 or see Configure a BGP Instance on page 90.

You do not need to stop recording to configure protocol instances.

6 You can configure additional protocol instances by repeating the preceding steps.

You can add multiple different protocol instances under one administrative 
domain, but only one instance of a particular protocol is allowed.

The structure of the administrative domain hierarchy also affects how the appliance associates 
the protocol instances to connect them in the routing topology map and to calculate routes. The 
next sections explain the requirements to consider when you configure the hierarchy:

• Correct interconnection of BGP and IGP protocol instances depends on their proximity in 
the hierarchy.

• If the network is a BGP confederation, this must be indicated in the administrative domain 
configuration.

• You can configure multiple EIGRP autonomous systems in one administrative domain or 
in separate ones.

After you determine the administrative domain hierarchy that is appropriate for your network, 
see the specific instructions in Configure an IGP Instance on page 84.

The appliance supports up to 100 areas. This limitation applies to the total of OSPF areas, 
IS-IS areas (levels), EIGRP autonomous systems, and BGP autonomous systems.

Interconnection of BGP and IGP Protocol Instances

A single physical router can run multiple routing protocols and be a member of multiple 
protocol instances. The appliance will attempt to consolidate all the instances of that router as 
a single node on the routing topology map so that the protocol instances will be connected. 
Because the various protocols identify routers in different ways, the appliance employs a 
heuristic algorithm to match routers.

A BGP node that peers with the appliance is identified by the peering address, while a BGP 
node created as a next-hop from a BGP peer is identified by the address in the BGP NextHop 
attribute of some of the routes learned from that BGP peer. The appliance searches for the 
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nearest IGP protocol instance in the hierarchy containing a router with matching router ID or 
interface address, or, failing those, a router that advertises a prefix containing the BGP 
address. If the hierarchy is configured with an administrative domain for each AS containing 
the BGP and IGP protocol instances of that AS, the intended IGP protocol instance will be 
nearest. However, if the hierarchy is configured inappropriately, the closest IGP with a match 
might not be correct.

For example, consider a network with two BGP and two IGP instances. Here, the two BGP 
instances represent two BGP autonomous systems that are connected with an external BGP 
peering across a link. In each AS, The appliance would peer with the BGP router on the end of 
the link in that AS, and from that peer it would learn routes of the other AS. Along with these 
routes, it would also learn an interface address of the BGP router on the other end of the link 
using the BGP NextHop attribute of the routes. 

To join the two autonomous systems by a link on the map, the appliance must consolidate this 
interface address with an IGP router in the other AS. To do this, it first finds the BGP instance 
of the next-hop router using the AS number from the BGP AS path attribute, and then it 
searches from that point in the hierarchy for the closest IGP instance containing a matching 
router as described above. If each of the BGP and IGP instances were in its own administrative 
domain under the Separate domain rather than being paired in the East and West domains, 
then both IGPs would be equally distant and either might have matched (because both are 
likely to advertise a prefix covering that interface address). As a result, the wrong IGP might 
be found first, causing the next-hop router to be consolidated with the router at the wrong end 
of the link.

Configuring a BGP Confederation

A BGP confederation is a domain that contains multiple member autonomous systems but 
appears to outside autonomous systems to have a single AS identifier. If your network is 
configured as a BGP confederation, you must create an administrative domain to represent the 
confederation and configure it with the confederation AS identifier. Under that administrative 
domain, you then configure an administrative domain for each member AS.

There are two types of BGP confederations. The member BGP autonomous systems in the 
confederation may all be contained within one IGP domain, or each member BGP AS may be 
running a separate IGP instance. The administrative domains Common and Separate are 
the ones that represent the confederation in each case. Underneath these are the West and 
East administrative domains, each of which contains a BGP instance for the member AS. For 
the common IGP case, a single IGP instance is configured under the confederation domain. For 
the separate IGP case, an IGP instance is configured along with the BGP instance in each 
member AS domain. You can adapt the approaches in these examples for monitoring your BGP 
confederation. See Configure a BGP Instance on page 90 for guidelines on configuring BGP.
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Configuring Multiple EIGRP Autonomous Systems

A network with multiple EIGRP autonomous systems can be configured in either of the 
following ways:

• Configure a single protocol instance with multiple network interfaces that are connected 
to the different EIGRP autonomous systems, provided that no two autonomous systems 
have the same number.

Advantages: Fewer configuration steps are required, and the autonomous system 
configuration need only be entered once.

• Create separate administrative domains for each AS, each with its own protocol instance. 
However, you can only configure a particular network interface under a single protocol 
instance, so you must configure all of the autonomous systems that may be heard on a 
single interface under the same domain and protocol instance.

Advantages: Each AS can be given a name rather than being identified only by number.

Configure an IGP Instance

After you create an OSPF, IS-IS, or EIGRP protocol instance, the 
configuration section for the selected protocol instance appears on the 
right side of the Recorder Configuration page, as shown in Figure 18. 
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Figure 18 Configuring an IGP Protocol Instance

The buttons and and check boxes that appear on the page depend on the specific instance you 
specified.

Recording does not need to be stopped to configure protocol instances.

To configure the IGP instances, perform the following steps:

1 Follow the steps on page 81 to open the Recorder Configuration page and specify the 
protocol to configure.

2 To create trace files containing raw packets, select Capture raw protocol packets. The 
protocol packets (IS-IS LSPs, OSPF LSAs or EIGRP updates) are saved in the format in 
which they are observed over the network.  The packets are stored in pcap-format files in 
the FTP directory in subdirectories isisTraces, ospfTraces, and eigrpTraces. The recording 
is broken into separate file of 15 minutes duration with names formed from the database 
name plus the date and time.

3 To enable recording of a pseudo-event to mark each packet arrival, select Record protocol 
packet events. The pseudo-events are recorded into the topology database interspersed 
with the real events, such as adjacency state changes. You can then view the rate of the 
packet arrivals in a History Navigator graph.  You can also view the individual 
pseudo-events along with real events in the Events table if enabled in Administration > 
Options > Miscellaneous.  By recording the protocol packet events, you can determine 
whether the routing protocol is behaving properly, for example, whether the update refresh 
rate is correct.

4 (OSPF only) Select the Enable sending the LSAs necessary to support Graceful 
Restart helper mode check box if you want the peer routers to be able to perform graceful 
restart.  Graceful restart enables the recorder to send its own Router LSA when 
appropriate, and during a graceful restart of the peer, to reflect the peer’s Router LSA and 
Network LSA.  No other LSAs are sent.  When this check box is not selected, the recorder 
does not send any LSAs.

5 To record IPv6 prefixes, select IPv6 (IS-IS protocol only).  

6 Beneath the Interfaces section of this page, the configured network interfaces are 
displayed in the Not Active column, and the interfaces that are currently available for 
recording display in the Active column. Select the interface that is connected to a network 
area or autonomous system you wish to configure. You can toggle the selections between 
the columns using the < and > buttons.
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7 If a GRE tunnel is required to connect to a remote router, click New Tunnel, and then 
follow the instructions in Configuring GRE Tunnels on page 125 to create the tunnel 
interface.

For EIGRP, there can be multiple interfaces connected to a single autonomous system in 
order to get complete coverage. You may need to configure a default route for each interface 
as described in Configuring a Static Route on page 67. 

The procedures for configuring an IGP instance vary between the protocols 
after Step 8. If you are configuring for IS-IS protocol, continue to Step 9. If 
you are configuring for OSPF, continue to Step 10, and if you are configuring 
for EIGRP, continue to Step 12.

8 Enable authentication by selecting the desired interface from the Active column, and click 
Configure. The Configure Interface page opens, as shown in Figure 19. 

Figure 19 Configure Interface Page for IGP (IS-IS Protocol)

9 (IS-IS only) Select the form of authentication you wish to use for the interface or the 
area/domain for the interface:

• MD5 (Message Digest Algorithm 5) Key-ID: requires a password (up to sixteen 
characters) and a Key-Id (a number between 1 and 255, inclusive)

• Simple: requires only a password (up to eight characters)

After entering the information, click Update.
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You can now begin recording routing topology information for this IS-IS protocol instance, 
or you can complete the configuration of all other protocol instances in the topology, if any, 
before you begin recording.

10 (OSPF only) Select the form of authentication you wish to use for OSPF authentication:

• MD5 Key-ID: requires a password (up to sixteen characters) and a Key-Id (a number 
between 1 and 255, inclusive)

• Simple: requires only a password (up to eight characters)

To monitor two OSPF areas that are linked to a single Cisco router, you must 
configure a loopback interface on the router to monitor both areas with Traffic 
Explorer. See Configuring a Loopback Interface for Cisco Routers on 
page 129.

11 After entering the information, click Update.

You can now begin recording routing topology information for this OSPF protocol instance, 
or you can complete the configuration of all other protocol instances in the topology, if any, 
before you begin recording.

Steps 6 through 17 are for configuring EIGRP protocol instances only.

12 (For EIGRP only) For an EIGRP instance, one or more autonomous systems must also be 
configured. Click New AS to display the autonomous system configuration section, as 
shown in Figure 20. 

For a network with more than one EIGRP AS, there are two configuration choices as 
explained in Configuring Multiple EIGRP Autonomous Systems on page 84.
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Figure 20 Configuring an EIGRP Autonomous System
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13 In the Configure Autonomous System table, specify the following:

• Enter either an explicit AS number or zero to allow the appliance to record all 
autonomous systems that are heard on the selected interfaces. To restrict the recording 
to a subset of the autonomous systems that may be heard, configure each desired AS 
number explicitly, one at a time.

• Topology Exploration parameters:

— Periodic Explore Interval—Determines the frequency of periodic exploration, 
and may be configured or left at its default value of 8 hours. Entering zero disables 
periodic exploration.

— Periodic Explore Start Time—Determines when periodic exploration begins, 
and is expressed in 24-hour clock mode in the time zone set on Traffic Explorer.

— Full Explore Interval—Determines the frequency of full topology exploration, 
and may be configured or left at its default value of 48 hours. Entering zero disables 
exploration.

— Full Explore Start Time—Determines when full exploration begins, and is 
expressed in 24-hour clock mode in the time zone set on Traffic Explorer.

• You can change the setting for Max Outstanding Queries, but the default value is 
recommended. This setting controls the maximum number of routers to which 
simultaneous Telnet or SSH connections will be issued to query topology information 
using the command line interface.

•  Telnet Line Password, Terminal Access Controller Access-Control System 
(TACACS)/SSH Username, and TACACS/SSH Password— These authentication 
parameters are used to access the command line interface of the routers to collect 
information about the network topology using show commands. If all routers use the 
same line password or TACACS username and password combination, enter the router 
line login password or a TACACS username and password combination (or both if some 
routers will use one and some routers will use the other). 

You can supply an optional second set of these parameters to accommodate networks 
where some routers are managed internally and some by outsourcing (without having 
to enter all the addresses for one group or the other into the Configure Interface 
Passwords table), or to accommodate a transition from an old password to a new 
password that does not happen immediately. The TACACS fields can also be used for 
username and password authentication when the routers are configured to use Remote 
Authentication Dial In User Service (RADIUS) or a locally configured set of accounts.

Refer to Step 16 if each router in the AS has a unique simple password or 
TACACS user name and password combination.
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• In the Login Methods area, select the method that the appliance will use to log into 
routers to collect EIGRP topology information by selecting telnet, SSH, or both if some 
routers use Telnet and some use SSH. If both are selected, SSH will be tried first.

14 In the Configure Blocked Interfaces table, specify any router interfaces that you do not 
want included in the topology map.

You can use this feature to specify routers that Traffic Explorer should not attempt to log 
into, or to limit the scope of the Traffic Explorer topology exploration.

15 Enter an interface address, and then click Update AS.

16 Use the Configure Interface Passwords table to override the generic passwords that are 
specified in Step 13 for any router that has a password different from those specified in the 
Configure AS table. Enter an interface address and its password or TACACS user name 
and password combination, and then click Update AS.

You must configure the password for all interfaces on the router.

17 When you have configured all of the autonomous systems, blocked interfaces, and interface 
passwords, click Save to complete the recorder configuration process.

You can now begin recording routing topology information for this EIGRP protocol instance, or 
you can complete the configuration of all other protocol instances in the topology, if any, before 
you begin recording.

Configure a BGP Instance

After you create a BGP protocol instance as described in Adding Protocol Instances on page 80, 
the BGP configuration section appears on the Recorder Configuration page as shown in Figure 
21. This section presents guidelines for choosing the peerings to establish between the 
appliance and the BGP routers.
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Figure 21 Configuring a BGP Instance

For every configured BGP AS, the AS number and list of IP addresses of peers in the AS are 
required during configuration. Configure each as an IBGP peer with the appliance. It is 
important that no policies are applied to the routes sent to the appliance. The appliance does 
not send any routes to its peers. Nevertheless, you should install filters on the peer routers to 
prevent the acceptance of any routes from the appliance.

If multiple autonomous systems are monitored, you must assign an alias must for each 
additional AS. Aliases are logical interfaces that are created by the operating system (OS) and 
assigned their own IP addresses. They behave in the same way as any other physical interface. 
Aliases identify the multiple personalities that are required for participation in multiple 
autonomous systems. These additional addresses can be the tunnel end-point addresses or they 
can be configured IP alias addresses. See Configuring Alias Interfaces on page 66. Any tunnels 
should be into the corresponding autonomous systems.

If you use IP alias addresses, all the addresses should be from the AS to which the 
main/physical routing interface connects. The router at the other end of this interface 
connection should ensure that each of these addresses is routable. The easiest way to ensure 
this is to assign all of the alias addresses from the same address block as the interface (from 
the subnet of the interface). In this case, no additional configuration is required in the AS 
routers. However, when the additional IP addresses are not from the same subnet block, the 
static routes to the AS routers must be configured and injected into the IGP/BGP so that the 
system is reachable from each BGP peer.

Use the following approaches (in order of preference) to configure a BGP instance in relation 
to the IBGP full mesh:
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1 Ensure that the system participates as part of the IBGP full mesh with a neighbor 
relationship (peer relationship) with all of the IBGP routers. This allows the appliance to 
have access to all of the IBGP updates sent by all of the routers in the mesh. The appliance 
constructs the topology from the same perspective as the other IBGP routers.

2 If your network has route reflectors, you can set up a peer (neighbor) relationship between 
the appliance and all of the Route Reflectors in the network. Note that you are configuring 
the Route Reflectors to treat the appliance as a peer, not as a client. In this scenario, the 
appliance receives all of the updates from Route Reflector clusters. This provides 
information about all routes being advertised, but the information is more limited than if 
the appliance were part of the full IBGP mesh. In particular, if some of the Route Reflector 
clusters have multiple exit points for the same route, the appliance might be able to see 
only a few (if there are multiple route reflectors present in the cluster), or only one of the 
exit points.

3 The least preferred method is to configure the appliance as a Route Reflector client. This 
option provides only one view of the network, that of the Route Reflector. This limits the 
ability of the appliance to do some types of analysis, but route tracing should work 
correctly.

To increase the available amount of routing information, you can configure the appliance 
to be a client of several key Route Reflectors. For best coverage, you should select Route 
Reflectors in geographically distant major PoPs.

When you set up peer relationships with Route Reflectors as a client, the total 
number of received routes is the product of the number of Route Reflectors 
multiplied by the number of prefixes. Because the total number of advertised 
routes can be very high, it is recommended that the appliance support no 
more than 10 Route Reflectors when it is configured as a client.

You can choose the third option even if you do not currently have any Route Reflectors in your 
network. You can configure any router to be a Route Reflector to peer with the appliance. This 
does not affect the other BGP neighbors of the router, because Route Reflector is a per-neighbor 
setting. Consider the third option if the first two options would entail too much configuration 
effort. If you choose the third option and later decide to change to the first or second option, you 
can simply reconfigure the Route Reflectors to treat the appliance as a peer instead of a client.

Configuring the appliance as an external BGP peer is not recommended because there are 
several drawbacks associated with EBGP peer relationships:
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• EBGP routing information does not include certain BGP attributes such as the NextHop, 
Local-Pref, and MED attributes. These attributes are essential to determine the best BGP 
routes inside an AS. Without them, the appliance is unable to determine the correct exit 
routers or find correct paths for BGP prefixes.

• From each of the EBGP peers the appliance will learn one route for each prefix known in 
the autonomous system, rather than only those routes for which the peer is responsible. 
This applies unless a policy filter is used to limit this information. If the appliance peers 
with many BGP routers in the AS, the total number of routes may exceed its capacity.

• Although the appliance will be maintaining many more routes than with IBGP peering, the 
fidelity of the routing information is less due to missing attributes. Without the attributes, 
the routes passed to the appliance by different routers is almost identical.

After you have configured a BGP instance for IBGP peering with the routers in your own AS, 
you may want to determine which routes are advertised to other autonomous systems. For this 
purpose, you can configure the appliance with a separate BGP instance to EBGP peer with one 
or a few of the border routers in your AS.

In a BGP confederation, configure the appliance to peer with each member AS using one of the 
three approaches described earlier in this section for a non-confederated BGP AS. For each 
member AS, configure the appliance as an IBGP peer to participate in the full mesh of IBGP 
routers in the member AS, or as a Route Reflector peer or client. You must assign a different 
alias to the appliance for each member AS.

If your appliance has a license for BGP and VPN protocols and you want to monitor VPN 
routing, you can collect complete routing information by configuring peering to all of the PE 
routers or to all of the Route Reflectors that serve the VPN routes in the AS. When configuring 
each peering, enable BGP extensions for MPLS VPNs, as indicated in the next procedure. See 
the “VPN Routing” chapter in the HP Route Analytics Management System User’s Guide for 
more information about configuring customer/Route Target (RT) associations for routing 
reports.

When configuring BGP peers in the recorder configuration, you can configure 
a prefix (such as 192.168.0.0/24), rather than multiple individual peer 
addresses that fall within that prefix. Multiple prefixes are allowed. However, 
it is only possible to use MD5 authentication with prefixes having mask length 
24 or greater. MD5 authentication will be ignored for any configured prefixes 
with shorter mask length.

To configure a BGP instance, perform the following steps:
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1 Follow the steps on page 81 to open the Recorder Configuration page and specify the 
protocol to configure.

2 Enter the BGP IP address in the BGP Id box.

3 Enter the autonomous system number in the AS box. If the BGP protocol instance is within 
a confederation, enter the AS number of the member in the Member AS box. This is not 
the confederation ID, which is shown separately.

4 From the Interface drop-down list, select the physical interface slot and port or select the 
logical interface alias.

5 To save a trace of the BGP protocol packet stream in a format similar to the MRTG format, 
select Capture raw protocol packets. The trace is stored in files in the FTP directory in 
subdirectory bgpTraces.  It is broken into separate file of 15 minutes duration with names 
formed from the database name plus the date and time. 

6 To enable recording of a pseudo-event to mark each packet arrival, select Record protocol 
packet events. The pseudo-events are recorded into the topology database interspersed 
with the real events, such as adjacency state changes. You can then view the rate of the 
packet arrivals in a History Navigator graph.  You can also view the individual 
pseudo-events along with real events in the Events table if enabled in Administration > 
Options > Miscellaneous.  By recording the protocol packet events, you can determine 
whether the routing protocol is behaving properly, for example, whether the update refresh 
rate is correct.

7 In the Peers column, click Add to add peers.

The peer configuration table opens at the left side of the screen as shown in Figure 22.

Figure 22 BGP Peer Configuration

8 In the Peer Information column, enter the IP addresses or prefixes of the peers, and the 
MD5 password, if applicable.  
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9 In the Options column, specify whether the peers are internal or external.

If you enter multiple peers at once, all of the peer addresses must share the same internal 
or external setting.

10 If this BGP topology is a BGP MPLS VPN, select BGP ext for MPLS VPNs. Otherwise, 
leave this check box empty.

11 If this BGP topology is a BGP IPV6, select BGP ext for IPV6. Otherwise, leave this check 
box empty.

12 When you have entered all information for the peers, click Update Peer to return to the 
BGP instance configuration.

13 Click Save.

You can now begin recording routing topology information for this protocol instance, or you can 
complete the configuration of all other protocol instances in the topology, if any, before you 
begin recording.

To Edit a BGP Peer, perform the following steps:

1 In the Peer column shown in Figure 21, click on the peer you wish to edit.

2 Click Edit.

The BGP Peer Configuration table displays.

3 Modify the fields you wish to edit, and click Save.

You can delete multiple BGP peers by selecting the peers you want to delete, 
and then clicking the Delete button.

Configuring the Route Recorder for the Collector

This section describes how to configure the Route Recorder for the Collector, which collects 
router interface information, static and connected routes, VRF-related information, and 
RSVP-TE. 

The available Collector capabilities depend upon the installed licenses.
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The Collector process gathers additional  information from the routers found through recording 
of BGP, IS-IS, and OSPF protocols. The information is gathered using SNMP to query the 
necessary MIBs or by connecting to each router with Telnet or SSH to issue CLI commands and 
parse the output.  The choice of method is determined by the Collector configuration and  how 
the information can be accessed on routers from each supported vendor.  When both SNMP and 
CLI methods are available, CLI is preferred because it provides more complete information, 
while imposing a lighter load on the router.

For EIGRP networks, a separate route recorder process collects the same information using 
Telnet or SSH as part of discovering the EIGRP topology.  SNMP is not used. Therefore, the 
Collector      bypasses routers running EIGRP unless an explicit address of the router is 
included in the Specific Router Access Configuration.

The Collector records two kinds of routes: connected and static. A router maintains a connected 
route for each of its network interfaces based on the prefix specified for the interface.  The 
Collector derives these connected routes from the interface information it retrieves using 
SNMP or SSH/Telnet.

Static routes are manually configured on the router by specifying a destination prefix and the 
next hop to which a packet should be sent towards that destination.  When the collection 
method is SSH/Telnet, static routes are always collected because doing so imposes very little 
additional load on the router and the network. Only the static routes are queried and not the 
whole routing table.  When the collection method is SNMP, static routes are only collected if 
that option is selected.  Collecting static route information using SNMP can consume 
substantial resources on  the routers because it requires retrieving the full routing table, which 
is quite large for a complete set of Internet BGP routes.

You can configure SNMP collection of static routes from the subset of routers for which static 
routes are present and the routing table is not too large.  Groups of routers are selected by 
specifying a prefix that covers one or more interface addresses on the routers.  Multiple prefixes 
can be specified to apply different sets of collection parameters to different groups of routers.  
For any router address, the longest matching prefix determines the applicable parameters.  To 
avoid undue resource load for routers with large routing tables, you can first configure 
collection of information without static routes on the full set of routers of interest (perhaps 
using the default 0.0.0.0/0 table entry that includes all routers known from the IGP and BGP 
protocols). Then separately configure one or more table entries with more-specific prefixes that 
have static route collection enabled to cover the subset of routers for which static routes are 
present and the routing table is not too large.
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RSVP-TE and the Collector

Route Explorer automatically tracks where MPLS tunnels that were created using RSVP-TE, 
including backup tunnels, are created in the network and how they change over time due to 
design changes or failures. To support this feature, you must configure the Collector to obtain 
the tunnel information from the routers using a combination of SNMP, SSH/Telnet, and syslog 
protocols. Routers are actively queried using SNMP or SSH/Telnet, while SNMP traps and 
syslog messages are passively received. 

Collection of the tunnel information begins with a full exploration of all the routers included in 
the Collector configuration.  Tunnel information is collected together with basic information 
about the routers and their interfaces.

To facilitate collection of updates to the tunnel information when changes occur, while 
minimizing load on the network, the Collector accepts change notifications from several 
sources so that it can issue targeted queries to the specific routers where changes occur:

• Any change in the up/down state, metric, or configured bandwidth for links in the IGP 
protocols that Route Explorer is recording.

• SNMP traps or syslog messages sent from the routers to the Collector.

• Anticipation of periodic tunnel reoptimization based on the timer values collected from the 
routers.

Route Explorer analyzes this information and then collects the additional information it needs 
from specific routers to update the tunnel tables and maps accordingly.

For situations where change notifications are not available and to provide backup in the event 
that a change notification is lost, the Collector also supports periodic lightweight exploration. 
In lightweight exploration, the routers at the head end of the tunnels are queried for tunnel 
changes. If a tunnel has changed since the last exploration, it is reported, and an additional 
query is sent to the router to obtain details. Route Explorer queries only the routers at the head 
ends of tunnels and requests details only if there has been a change. 

Traffic Explorer can query additional routers along the tunnel to obtain MPLS label 
information if the routers are configured as NetFlow exporters. Because the additional load 
associated with lightweight exploration is negligible, lightweight exploration can be done 
frequently (every 5 to 15 minutes). To obtain accurate information for traffic recording, we 
generally recommend a maximum interval of 15 minutes (the default); however, if the routers 
are configured to send SNMP traps or syslog messages to the Collector, then a longer interval 
(such as one hour) is acceptable.
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We recommend performing full exploration once per day to make sure that the complete tunnel 
information is current. Full exploration collects a superset of the information that is collected 
in lightweight exploration. If lightweight exploration and full exploration are scheduled at the 
same time, then only the full exploration is performed.  After the full exploration of each router 
is completed, the lightweight exploration interval resumes for that router.

In addition to the events related to TE transitions, you can record other information obtained 
from syslog, for example, to correlate TE events with other syslog events. To obtain this 
information, you add regular expressions to the Collector to identify the syslog messages to add 
to the syslog database on the appliance. An example is the syslog messages for adjacency 
transitions.

Configuring the Collector

You can configure the Collector on any appliance that performs route recording. The scope of 
the Collector is determined by the location in the hierarchy that you choose when configuring 
the recorder and applies to the selected subtree (Figure 23). You can configure multiple 
Collector instances, provided that their scope is not overlapping. This may be desired for 
geographically distributed recorders. If you attempt to configure overlapping instances, an 
error message is displayed.

Figure 23 Choosing Scope for Collector

The appliance collects VRF-related information for VPN traffic reports and for VPN routing 
reports. To use these features, SNMP v2 or v3 is required on all platforms, and Juniper and 
Cisco routers also require Telnet/SSH. For a list of Juniper and Cisco router commands, refer 
to Information Collected from Routers on page 209. 

Before you configure the Collector, you must enable the XML RPC query server on the Route 
Recorder or Modeling Engine. On a distributed system, it is normally best to use the Modeling 
Engine, because it has the complete network topology and can provide the complete list of 
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routers. If there is only one Route Recorder unit in the system, then selecting the Route 
Recorder itself is the right choice because that recorder will have the full network topology and 
that is the same appliance where the Collector will be running. If there are multiple Route 
Recorder units, however, you should select the Modeling Engine. For more information on the 
query server, see the Route Explorer and Traffic Explorer Developer’s Guide.

To enable the query server, perform the following steps:

1 Choose Administration > Queries.

2 Select the XML-RPC Query Server and Enable remote access check boxes.

3 Enter and confirm the password for query access.

4 Click Update.

To configure the Collector, perform the following steps:

1 Verify that the routers to be included in the Collector are configured for SNMP v2 or v3 and 
Telnet or SSH (for Juniper and Cisco routers).

2 Choose Recorder Configuration.

3 Click the desired level in the recorder hierarchy in the left navigation bar and choose Add 
> Collector.

4 If you have a distributed system, choose the Route Recorder appliance from the drop-down 
list, and click Select to open the Recorder Configuration window. (Figure 24). If you have 
a single appliance, it is not necessary to select the appliance to open the Recorder 
Configuration window. 

5 Make changes as needed to the following Global Router Access Configuration settings:

• Router list query server—Indicates the Route Recorder or Modeling Engine 
where the query server is configured. The field is read-only if this is a single unit (not 
part of a distributed system). Otherwise, select the IP address of the query server that 
you enabled in the previous procedure.

• Router list query server password—Enter the same password that you configured 
for the query server in the previous procedure.

• Router list refresh time—Specifies the interval for polling the Query Server for the 
current list of known routers.  A shorter interval allows detection of new routers more 
quickly so information will be collected from them; a longer interval reduces 
interference with user access to the Query Server.

• Full exploration schedule—Specifies the schedule used to query all routers that 
match the Collector configuration to collect all changes in the recorded information.
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• Inaccessible router timeout—Specifies the period after which routers are marked 
as down if they could not be reached during exploration.

• Light-weight RSVP TE exploration interval—(RSVP-TE only) Specifies whether 
lightweight exploration is enabled or disabled. Lightweight exploration collects only 
the changes in MPLS tunnels since the last exploration. 

• Minimum interval between queries to router (minutes)—(RSVP-TE only) 
Specifies the minimum interval between queries for information about MPLS tunnels. 
15 minutes is recommended; setting the value to 0 disables the queries outside of 
exploration and disables IGP-triggered exploration.

• IGP triggered exploration—(RSVP-TE only) Specifies the exploration that happens 
due to IGP protocols, This setting enables use of IGP events for event drive exploration. 
For more information, see the “RSVP-TE” reports chapter in the HP Route Analytics 
Management System User’s Guide.

• Number of routers to query in parallel—Specifies the number of routers to query 
in parallel for all exploration. Default is 50.

• Exploration at next Start Recording—If selected, a full exploration is performed 
when recording is started. If the check box is not selected, full exploration runs only at 
the scheduled times.

6 If you are using SSH and/or Telnet, you can configure the following global SSH/Telnet 
parameters to be referenced by entries in the Specific Router Access Configuration section:

• Login User 1/Login User 2—Enter up to two user names and passwords for SSH and 
Telnet access.
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Figure 24 Recorder Configuration Window for the Collector
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7 If you are using SNMP, you can configure the following global parameters to be referenced 
by entries in the Specific Router Access Configuration section:

• SNMP v2 Community—Enter the SNMP community for the router, if SNMP v2 is 
used.

• SNMP v3 Profile—Choose the SNMP v3 profile, if SNMP v3 is used. See Configuring 
SNMP v3 Profiles on page 104 for instructions on creating SNMP v3 profiles.

• Interval between queries to a router (milliseconds) within the polling 
cycle—Enter the number of milliseconds between successive SNMP requests to 
individual routers within a particular polling cycle (default 0 means that there is no 
delay between requests). Because there may be a large number of SNMP tables and the 
table size may be large, multiple SNMP get/bulkget requests are often needed to collect 
the requested information from a router. The interval specified in this field prevents 
excessive load on the router due to the SNMP get/bulkget requests.

• Collect Static Routes—Select the check box to collect static route information from 
the specified routers. Because static route collection can consume substantial router 
resources, we recommend that you collect static routes only from routers with small 
routing tables.

8 If you are using syslog, you can configure the following global RSVP-TE related parameters 
to be referenced by entries in the Specific Router Access Configuration section. These 
settings are available if the appliance has an MPLS VPN or RSVP-TE license: 

• Syslog port—(RSVP-TE only) Specify the port on which the appliance will receive 
syslog messages from routers (default 514).

• Trap port—(RSVP-TE only) Specify the port on which the appliance will receive traps 
from routers (default 162).

• Accept additional syslog messages as regular expressions—(RSVP-TE only) 
specify the regular expressions to be recognized. Add each regular expression on a new 
line in the text box. For example, enter .* to record all syslog messages. If nothing is 
entered, then only RSVP-TE messages are recorded.

9 You must create one or more entries in the Specific Router Access Configuration section to 
specify prefixes that cover the addresses of all the routers from which information should 
be collected.  The default 0.0.0.0/0 prefix entry will include all routers known from the IGP 
and BGP protocols that are recorded.  For each of these entries, you can use the global 
settings or optionally configure settings that differ from the global settings.  You can specify 
the following settings. To remove an entry, select the Delete check box and click Save.

• Routers (Prefix)—Specify a prefix that contains the router ID or interface addresses 
of a set of routers to be queried. Only routers that are known through IGP or BGP 
recording will be queried, except that a /32 prefix will always be queried.
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• SNMP/SSH/Telnet—Select check boxes if you want to configure SNMP, SSH, or 
Telnet settings for the specific routers. When you select one of these check boxes, the 
settings for that item are activated. The router is blacklisted if none of these is 
specified.

• Accept Syslog—Select the check box to accept syslog messages from the router.

• Accept SNMP traps—Select the check box to accept SNMP traps from the router.

• SNMP v2 Community—Enter the SNMP community for the router, if SNMP v2 is 
used.

• SNMP v3 Profile—Choose the SNMP v3 profile, if SNMP v3 is used. See Configuring 
SNMP v3 Profiles on page 104 for instructions on creating SNMP v3 profiles. 

• SNMP Collect Static Routes—Select the check box to collect static route information 
from the specified routers. Because static route collection can consume substantial 
router resources, we recommend that you collect static routes only from routers with 
small routing tables.

• SSH/Telnet User Name—Enter the user name for SSH and Telnet access.

• SSH/Telnet Password—Enter the password for SSH and Telnet access.

10 Click Save.

The Collector is now configured and ready to start collection when you start recording.

To view the Collector configuration, perform the following steps:

1 Open the client application as described in the “Viewers” chapter in the in the HP Route 
Analytics Management System User’s Guide.

2 Choose Tools > Find Router.

3 Enter the router address of interest and click OK. The router is highlighted on the map and 
flashes briefly in yellow.

4 Right-click the router to open the Inspector for the router.

5 Open the Collector tab. You may need to click the right-facing arrow near the top of the 
panel to find the Collector tab.

The information includes prefixes, events, and interfaces. Only the up interfaces are listed.
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Configuring SNMP v3 Profiles

Use the SNMP v3 Profiles page to define SNMP v3 profiles for the Collector. When you define 
a profile, it becomes available for selection on the Recorder Configuration page. See 
Configuring the Route Recorder for the Collector on page 95.

To configure an SNMPv3 profile, perform the following steps:

1 Choose Administration > SNMP v3 Profiles.

2 Choose one of the following options:

• To create a new profile, click New.

• To edit an existing profile, select the profile and click Edit.

The SNMP v3 Profiles page opens (Figure 25).

Figure 25 SNMP v3 Profile Configuration

3 Enter or confirm the profile name. The name is used when you select a profile for the 
Collector.

4 Enter the name of the SNMP user.

5 Choose one of the following security options for the SNMP messages, and configure 
additional information as indicated:

• No authentication or privacy (noAuthNoPriv)—Permits all SNMP v3 messages 
with no authentication or privacy protection.
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• Authentication with no privacy (authNoPriv)—Requires authentication for 
SNMP v3 messages. If you select this option, choose the default MD5 or Secure Hash 
Algorithm (SHA) authentication protocol and enter an authentication passphrase.

• Authentication with privacy (authPriv)—Requires authentication for SNMP v3 
messages and adds message encryption. If you select this option, configure the 
authentication options described in the previous bullet. Choose the default Data 
Encryption Standard (DES) or Advanced Encryption Standard (AES) privacy protocol 
and enter a privacy passphrase. This option is recommended for full protection.

6 Click Save.

Starting and Stopping the Route Recorder

To start recording routing topology data for any of the protocols you added in Configuring the 
Route Recorder on page 78, perform the following steps on the Recorder Configuration page of 
the master appliance:

(Traffic Explorer only) If a Flow Analyzer is running in the configuration, you 
must stop the Flow Analyzer before you can start recording. See Deleting a 
Flow Analyzer on page 121.

1 Choose Recorder Configuration.

2 In the configuration hierarchy tree, click the protocol instance where you’ll start recording 
routing data, and select View.

If the protocol instance is not already recording, the Start Recording button is displayed 
on the Recorder Configuration page.

3 Click Start Recording.

When recording has begun, the Stop Recording button appears.

4 Restart the Flow Analyzer, if it is stopped. (Traffic Explorer only)

The Route Recorder will write routing data for the selected protocol to the database until you 
click Stop Recording.

Use the Start All Recording and Stop All Recording buttons to start and stop recording for 
the entire configuration tree.
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Viewing and Modifying Route Recorder Settings

After the Route Recorder is started, as described in Starting and Stopping the Route Recorder 
on page 105, Traffic Explorer is ready to receive routing announcements from the peer routers. 
You can check the status of the recorder using the Status table on the Recorder Configuration 
page.

To access the Status table, perform the following steps:

1 Choose Recorder Configuration.

2 In the configuration hierarchy tree, click the protocol instance, and select View.

Depending on the protocol instance, the following information is displayed:

• For non-BGP protocols, the table shows the status of the protocol adjacency, the time 
the last “hello” packet was received as part of the routing protocol, the time the last 
event was written to the database by the Route Recorder. The table also identifies the 
interface, AS, and neighbor AS.

• For BGP protocols, the table shows the peer status for the AS, including IP address of 
the peer, the BGP Id, the state of the peering, and how long that state has existed 
(“Since”).

From the Status table for each protocol instance, you can also change recorder settings, as 
described in the following sections.

Changing the Area ID Format of an OSPF Protocol Instance

For an OSPF instance, viewing the configuration also displays the Area ID Format selection. 
An OSPF Area ID can be displayed either as a single decimal number or in dotted decimal 
format. The format selection controls both the administration pages and the Traffic Explorer 
client, but you must restart the client for a change in the format to take effect. If you use VNC, 
you must also stop the VNC server and restart it to see the change.

To change the Area ID format, perform the following steps:

1 Choose Recorder Configuration.

2 In the configuration hierarchy tree, click the protocol instance, and select View.

3 From the Area ID Format drop-down list, choose Decimal or Dotted Decimal.

4 Click Submit.

5 Choose Administration > VNC Configuration.
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6 On the VNC Configuration page, click Stop. This stops the VNC server and closes any 
active VNC sessions.

7 Click Start to restart the VNC server.

8 Restart any VNC client sessions.

Deleting an Existing Domain or Protocol Instance

To delete an existing administrative domain or any instance, perform the following steps:

1 Choose Recorder Configuration.

2 In the configuration hierarchy tree, click the protocol instance, and select View.

3 Click Stop Recording.

4 Click an existing instance from the tree structure on the left side of the screen.

A pop-up menu appears.

5 On the pop-up menu, click Delete.

6 Click Yes on the confirmation screen that opens.

This deletes the instance, but the database remains in Traffic Explorer as a historical 
record.

Removing an Interface from a Protocol Instance

To remove an interface from a protocol instance, perform the following steps:

1 Choose Recorder Configuration. 

2 In the configuration hierarchy tree, click the protocol instance, and select View.

3 Click Stop Recording.

4 Choose an existing interface name. If the chosen interface is in the Active column, move 
it to the Not Active column.

5 If the interface is a tunnel that you want to delete, highlight the interface name and click 
Configure.

The Configure Interface section opens on the Recorder Configuration page.

6 Click Delete. A confirmation message page opens.

7 Click Yes. The tunnel is deleted and the Recorder Configuration status page returns.
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Changing an OSPF Authentication Password

To change an OSPF authentication password, perform the following steps:

1 Choose Recorder Configuration.

2 In the configuration hierarchy tree, click the protocol instance, and select View.

3 Click Stop Recording.

4 Choose an existing interface name. If the chosen interface is in the Active column, move 
it to the Not Active column.

5 Select the interface name, and then click Configure.

6 Highlight the password and enter another password. 

7 Click Update. This changes the password.

Deleting an OSPF Authentication Password

To delete an OSPF authentication password, perform the following steps:

1 Choose Recorder Configuration.

2 In the configuration hierarchy tree, click the protocol instance, and select View.

3 Click Stop Recording.

4 Choose the existing interface name with the affected password. If the interface is Active, it 
is first necessary to move it to the Not Active column.

5 Select the interface name and then click Configure.

6 Deselect Enable.

7 Delete the password.

8 Click Update. This deletes the OSPF authentication password.
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Configuring the Flow Collector

This section applies to Traffic Explorer only. The Flow Collector is supported 
only on appliance models with two disk volumes (3510 FR and 4000 FR).

A Flow Collector receives and stores NetFlow traffic data from various routers on the network 
to the database, and creates reports. The Flow Analyzer aggregates the reports and is 
responsible for issuing alerts. See Configuring MPLS-Aware NetFlow v9 on Cisco Routers on 
page 123 for information on configuring NetFlow for Cisco routers.

In releases prior to 8.0, it was possible to double-count traffic flows that passed through more 
than one exporting router; therefore, it was important for users to select the set of exporting 
routers such that traffic flows would not pass through more than one exporting router. Now a 
deduplication process stops the projection of a traffic flow when it reaches a second exporter so 
it won't be counted more than once. This allows greater flexibility when setting up the 
appliance.

• Enterprises can increase coverage by measuring traffic flows at all data centers and 
peering points where significant traffic originates.

• VPN service providers can enable traffic collection from combination P/PE routers in 
addition to the downstream P routers. In doing so, the service provider must restrict the 
set of exporting interfaces on the P/PE router to those that are connected to upstream PE 
routers (the interfaces used in the router’s P role). This restriction applies because at the 
ingress to a PE router, the traffic is not yet encapsulated in the VPN, and information is 
not yet available to specify the VPN. Therefore, such traffic cannot be shown as VPN traffic 
within the provider’s network.

In MPLS VPN deployments, you must establish Label Distribution Protocol (LDP) peering 
sessions to exporting routers to learn of the MPLS labels assigned to ingress traffic for the 
routers, except in the cases where this information is already carried in the NetFlow records. 
See Configuring MPLS VPN-Aware LDP for Cisco Routers on page 122.

LDP peering is established in two phases. First, a hello adjacency (UDP) is established, and 
then a session is established to work over TCP. 

You must configure the Route Recorder as described in Configuring the Route 
Recorder on page 78 before you begin configuration of the Flow Collectors.
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To configure a Flow Collector, perform the following steps:

1 Choose Recorder Configuration on the master appliance.

2 Click the top-level domain name you added in Creating a Configuration Hierarchy on 
page 75 (for example, CorpNet) and select Add.

A list of options appears on the pop-up menu.

3 Click Traffic near the bottom of the list.

A status message indicates that a traffic label was added to the configuration hierarchy. 
The traffic label is used to organize one or more Flow Collectors, which you will add in 
Steps 4-18.

4 Click the Traffic label in the configuration hierarchy and move the cursor to Add Flow 
Collector.

A choice of IP addresses appears. Each IP address corresponds to a Traffic Explorer client 
licensed to function as a Flow Collector.

5 Click an IP address.

The Recorder Configuration page appears as shown in Figure 26. The domain is 
pre-populated with the name of the administrative domain.
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Figure 26 Configuring a Flow Collector

6 In the Flow Collector Id text box, enter a label for the Flow Collector.

The appliance uses this label to identify the Flow Collector in the configuration hierarchy 
tree, and as the name of the Flow Collector database file. This text box is editable until a 
valid ID is entered. After the ID is validated, the text box is no longer editable, and you 
cannot change the Flow Collector ID.
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7 In the UDP Port text box, verify the UDP port number. The number in this text box must 
match the port number to which the routers will send NetFlow data. The text box is 
pre-populated with the port from which flow exports are received.

8 In the Sampling Rate text box, enter the NetFlow sampling rate configured on most or all 
of the routers. If no sampling is done on the routers, enter 1. This value serves as the 
default when configuring exporters, but may be overridden for individual exporters in Step 
11.

9 In the Exporter Prefix box, enter the IP address of the router from which the Flow Collector 
will accept NetFlow data exports. The number of routers specified in this section is not 
limited.

10 In the Router IP Address text box, enter the IP address of the corresponding router if the 
exporter is not known to the Route Recorder.

11 In the Sampling Rate text box, enter the sampling rate that is configured on the router, if 
the sampling rate is different from the sampling rate shown in Step 8.

12 Select the Accept Netflow check box to enable collection of Netflow data

13 Select the LDP Enabled check box if you want to establish LDP peering with the exporter 
that you are configuring. Specify an MD5 password if desired. These settings are available 
only if the appliance has an MPLS-VPN license.

When the appliance collects Netflow data from some midpoint routers of a 
tunnel, an LDP session is required from the same Flow Collector to the 
tailend router for that tunnel.

14 Select the physical interface from the drop-down menu.

15 Click Delete box remove the configuration information for the row.

16 Repeat steps 9 through 15 to specify additional routers.

If more than five routers need to be configured you must enter the first five 
rows of addresses first, and click the Save button. After clicking Save, five 
more rows will appear in 
the table

17 Use the Show Password check box at the bottom of the page to show or hide all of the 
passwords on this page.

18 Review the information in the Flow Collector Configuration portion of the window, and 
click Start Recording. This button also saves the configuration.
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The Flow Collector appears in the domain hierarchy.

In the Flow Collector Status portion of the Flow Collector Configuration window, you can view 
recording status for the Flow Collectors. The columns in this section of this window are as 
follows:

• Status—Displays whether recording is under way.

• Last Status Update—Displays the most recently requested update for the recorder. Click 
Show Last Event Times to view the last report times for the routing and traffic 
databases from the point of view of the FR, or click Hide Last Event Times to hide that 
information.

• Last NetFlow Record—Displays detailed statistics for the NetFlow records received.

The bottom of the Flow Collector Configuration page displays the status of LDP peering with 
each neighboring exporters that the recorder is configured to communicate with. Detailed 
status is also available to show the number of NetFlow packets received by the Flow Collector, 
the number of NetFlow packets lost, if any, and the number of traffic flows known to the Flow 
Collector.

Starting and Stopping the Flow Collectors

This section applies to Traffic Explorer only.

After configuring the Flow Collectors as described in the previous section, you can start or stop 
recording NetFlow data using the Recorder Configuration page of the master appliance.

To start recording traffic flow data, perform the following steps:

1 If a Flow Analyzer is running in the configuration, you must stop the Flow Analyzer before 
you can start recording. To do so, choose Recorder Configuration, select the Flow 
Analyzer, and click View. Click Stop on the Recorder Configuration page.

2 In the configuration hierarchy tree, click the Flow Collector instance where you will start 
recording traffic data.

A pop-up menu appears.

3 Click View.

If the Flow Collector is not already recording, the Start Recording button is displayed on 
the Recorder Configuration page.
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4 Click Start Recording.

When recording has begun, the Stop Recording button appears.

5 Restart the Flow Analyzer, if you stopped it in Step 1.

The Flow Collector will write traffic data to the database until you click Stop Recording. 
Changes to Flow Collector configuration are not allowed after recording has started.

Viewing Flow Collector Settings

This section applies to Traffic Explorer only.

You can view settings for a configured Flow Collector using the Recorder Configuration page 
on the master appliance.

To view Flow Collector settings, perform the following steps:

1 On the Recorder Configuration page, click the Flow Collector to view in the tree structure 
on the left side of the page.

A pop-up menu appears.

2 Click View.

A Status table appears at the bottom of the Recorder Configuration page. If this table is not 
empty, then a database is being created for Traffic Explorer. If the table is empty, verify 
that the connection to the router or the tunnel is properly configured.

The Flow Collector Status table displays each Flow Collector ID and gives its status 
(Recording, Not Recording, or Down). The table also shows the time the status was last 
updated, and when the last NetFlow record was received.

You can view more detailed status messages about the traffic database by clicking Show 
Detailed Status (Table 14 ). The Detailed Status table displays information such as the 
number of NetFlow packets received by the Flow Collector, the number of NetFlow packets 
lost, if any, and the number of traffic flows known to the Flow Collector. 
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Table 14 Detailed Status Table 

Time elapsed since last 
start in seconds

Amount of time in seconds since the last Flo
start.

NetFlow packets Number of NetFlow packets (all export forma
from all exporting routers. This count is cum
since the most recent time the recorder was 
restarted).

Note: This count should be equal to the sum
v1/v5/v8 packets and NetFlow v9 packets.

NetFlow v1/v5/v8 
packets

Number of NetFlow v1/v5/v8 packets receive
exporting routers. This count is cumulative s
most recent time the recorder was started (o

NetFlow v9 packets Number of NetFlow v9 packets received from
exporting routers. This count is cumulative s
most recent time the recorder was started (o

Netflow packets from 
invalid exporters

Number of packets that arrived at the record
dropped because they came from an invalid e
this number is non-zero, it could indicate 
misconfiguration of the Flow Collector (or th
a malicious outsider attempting to flood the 
Collector.

NetFlow packets with 
invalid timestamps

Number of NetFlow packets received with in
timestamps 

Flow Collectors reject NetFlow packets with 
more than sixty seconds in the past or more 
seconds in the future.

NetFlow records Number of NetFlow records received (all pro
all exporting routers. This count is cumulati
most recent time the recorder was started (o

NetFlow IPv4 records Number of NetFlow records received describ
IPv4 flows from all exporting routers. This c
cumulative since the most recent time the re
started (or restarted).
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NetFlow VPN records Number of NetFlow records received describ
flows from all exporting routers. This count i
cumulative since the most recent time the re
started (or restarted).

NetFlow records lost Number of NetFlow records estimated to be 
the recorder started (or was restarted). This 
by examining the sequence numbers in the N
packets. When recording a new traffic datab
of loss at the start of recording is normal (a n
than .01% of the total NetFlow records). Low
deployments may see zero lost packets.

NetFlow records with 
invalid timestamps

Number of NetFlow records received with in
timestamps.

Flow Collectors reject NetFlow records with 
more than one hour in the past or more than
seconds in the future.

Current/Mean/Maximum 
five-minute count of 
NetFlow Records

Current/Mean/Maximum number of NetFlow
received from all exporting routers in the pa
minutes since the last Flow Collector start.

NetFlow records sampled Number of records sampled since the recorde
For low traffic level deployments, this numb
the same as the number of NetFlow records 

Number of records processed through algorit
the recorder started.
For low traffic level deployments, this numb
the same as the number of NetFlow records.
For high traffic environments, sampling is d
level of NetFlow records and this number cou
records that were selected by the sampling a
(Currently, a cap of 500,000 records per five 

Table 14 Detailed Status Table  (cont’d)
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absence of errors in NetFlow records, this nu
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NetFlow records dropped 
outside aggregation 
window

Number of Netflow records dropped due to la
(greater than 20 minutes) by the exporting r

NetFlow records dropped 
due to source/destination 
not in prefix table

Number of Netflow records dropped due to s
destination address of the reported flow not 
routing prefixes heard
by the Route Recorders.

NetFlow records dropped 
due to IPv4 
source/destination not in 
prefix table

Number of NetFlow records describing nativ
dropped due to source destination address of
reported flow not in the set of routing prefixe
the Route Recorders.

NetFlow records dropped 
due to VPN 
source/destination not in 
prefix table

Number of NetFlow records describing VPN
dropped due to source destination address of
reported flow not in the set of routing prefixe
the Route Recorders.

NetFlow records dropped 
with multicast 
information

Number of Netflow records with multicast in
that are
received by the Recorder. Multicast Netflow 
currently
not processed by the Flow Collector.

Table 14 Detailed Status Table  (cont’d)
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To delete a Flow Collector from the configuration hierarchy, perform the following steps:

1 Stop the Flow Collector, as described in Starting and Stopping the Flow Collectors on 
page 113.

2 On the Recorder Configuration page of the master appliance, click the Flow Collector to 
delete in the tree.

3 In the pop-up menu that opens, click Delete. Click Yes to confirm.

This deletes the instance, but the database remains in the appliance as a historical record.

Known flows Instantaneous measure of the number of flow
represents a source or destination prefix/exp
combination) that the Flow Collector is track
influences the amount of memory used by th

Prefixes Instantaneous measure of the number of pre
to the Flow Collector. It uses these prefixes f
aggregation purposes. The appliance uses th
when aggregating data. This number should
count of prefixes known to all of the IGP and

Exporters Instantaneous measure of the number of exp
router (An exporter refers to an interface on
For example, in a deployment with two route
exporting from ten interfaces, this value wou

Table 14 Detailed Status Table  (cont’d)
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Configuring Flow Analyzer Recording Status

This section applies to Traffic Explorer only.

A Flow Analyzer processes traffic data received from the Flow Collectors to generate aggregate 
traffic reports and alerts.

To configure the recording status of the Flow Analyzer, perform the following steps:

1 On the Recorder Configuration page of the master appliance, click the top-level domain 
name you added in Creating a Configuration Hierarchy on page 75 (for example, CorpNet).

2 Move the cursor to Add.

A list of options appears on the pop-up menu.

3 Click Traffic Reports.

A status message appears in the browser window indicating that a traffic label was added 
to the configuration hierarchy. The traffic label is used to organize one or more Flow 
Analyzers, which you will add in the following steps.

4 Click the Traffic Reports label in the configuration hierarchy and move the cursor to Add 
Flow Analyzer.

The Flow Analyzer’s IP address appears.

5 Click an IP address.

The Flow Analyzer Status window opens.

The following buttons are found at the top of this window:

• Stop—Stops all report daemons for the Flow Analyzer.

• Refresh Status—Refreshes the information found on-screen.

• Restart Replication—Restarts the Flow Collector to collect traffic data, write reports to 
correlate routing and traffic information to the Flow Analyzer.
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Starting and Stopping the Flow Analyzer

This section applies to Traffic Explorer only.

To start and stop the Flow Analyzer, perform the following steps:

1 On the Recorder Configuration page of the master appliance, click the Flow Analyzer 
instance.

A pop-up menu appears.

2 Click View.

If the Flow Analyzer has not already been started, the Start button is displayed on the 
Recorder Configuration page.

3 Click Start.

When the Flow Analyzer is running, the Stop button appears.

4 Click Stop to stop the Flow Analyzer.

Viewing Status of the Flow Analyzer

This section applies to Traffic Explorer only.

You can view the recording status of the Flow Analyzer on the Recorder Configuration page. 
You can also stop recording and restart replication.

Configuring the Flow Analyzer occurs automatically when you configure the 
Flow Collector.

In the Flow Analyzer Status portion of the window, a row is displayed for each of the following 
time intervals:

• 5-Min Report

• Hourly Report

• Daily Report
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• Weekly Report

• Monthly Report

The following columns of information are displayed for each interval:

• Report Type—Displays the following schedule of reports:

• Last Report Time—Displays the date and time the report was last written.

• Status—Displays whether the Flow Analyzer is Up or Down.

In the Database portion of the window, the names of the Flow Collector database displays in 
the left portion of the table. The Status column displays whether the database is running on 
or offline.

The bottom of the Flow Analyzer Status window displays the Replication Status table. The 
following columns are displayed:

• IP Address—Displays the IP address of the Flow Collector.

• Databases—Displays the Flow Collector database name.

• Status—Displays whether the recorder is running or not. If it isn’t, click Restart 
Replication to restart replication.

Deleting a Flow Analyzer

This section applies to Traffic Explorer only.

To delete a Flow Analyzer from the configuration, perform the following steps:

1 Stop the Flow Analyzer as described in Starting and Stopping the Flow Analyzer on 
page 120

2 On the Recorder Configuration page of the master appliance, click the Flow Analyzer to 
delete in the tree.

3 In the pop-up menu that opens, click Delete. Click Yes to confirm.

This deletes the instance, but the database remains in Traffic Explorer as a historical 
record.
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Additional Configuration Tasks

Configuring MPLS VPN-Aware LDP for Cisco Routers

LDP is a protocol in which two Label Switch Routers (LSRs) exchange label mapping 
information. LDP is used to build and maintain LSR databases that are then used to forward 
traffic through MPLS environments. LDP relies on the underlying routing information 
provided by an IGP in order to forward label packets. LDP is used only for signalling best-effort 
LSPs.

The configuration procedures that follow are intended for P routers. You also 
must have MPLS VPN configured on your network before working through the 
sections that follow.

Targeted LDP Configuration for Cisco Routers

To learn what labels your router is using, you must set up a targeted LDP session. This session 
forces the router to send you all the labels that it is using throughout the MPLS VPN.

Refer to the Cisco router documentation for detailed router configuration 
instructions.

To configure targeted LDP on a Cisco router, perform the following steps:

1 Open a session with the router.

2 Enter the following command in global configuration mode:

mpls ldp neighbor <flow-recorder-ip-address> targeted

The mpls ldp neighbor <flow-recorder-ip-address> targeted command sets up a 
targeted LDP neighbor peering with the Flow Collector, which then receives the NetFlow 
v9 flow records. 

To set the Router ID, perform the following steps:

1 Open a session with the router.
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2 Enter the following command in global configuration mode:

mpls ldp router-id interface [ ]force

The mpls ldp router-id interface [ ]force command specifies a preferred interface 
for determining the LDP router’s ID.

This command may be necessary to ensure that there is a matching router-id 
for the router in the IGP and/or BGP routing space that is being recorded by 
the Route Recorders.

Configuring MPLS-Aware NetFlow v9 on Cisco Routers

NetFlow v9 provides network administrators access to information about IP flows within their 
data networks. This data can be used for network management and planning, enterprise 
accounting, and data warehousing. By analyzing flow data, a picture of traffic flow and volume 
can be built. 

MPLS-aware NetFlow v9 is available only in certain IOS versions. Verify that 
the version of IOS you are running supports MPLS-aware Netflow. Refer to the 
Cisco router documentation for detailed router configuration instructions.
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Configuring MPLS-Aware NetFlow v9 for Cisco Routers 

To configure MPLS-aware Netflow v9 on Cisco routers, enter the following commands (in 
EXEC mode):

1 Open a session with the router.

2 Enter the following commands in EXEC mode:

ip flow-export version 9

The ip flow-export version 9 command enables v9 data export for the main cache.

ip flow-cache mpls label-positions 1 2 

The ip flow-cache mpls label-positions 1 2 command enables MPLS-aware NetFlow.

To enable NetFlow v9 on each Cisco interface, perform the following steps:

1 Open a session with the router.

2 Enter the following command in EXEC mode:

interface / interface-type interface number 

The interface / interface-type interface number command configures an interface 
(or subinterface) type, and enters Interface Configuration mode.

3 Enter the following command in Interface or Subinterface configuration mode:

ip flow ingress

The ip flow ingress command configures NetFlow on an interface or subinterface.

ip flow ingress was introduced in IOS release 12.3. If you are 
using an earlier IOS version, use the command ip route cache flow 
instead.

To view the status of NetFlow exports, perform the following steps:

1 Open a session with the router.

2 Enter the following commands in EXEC mode:
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show ip flow export

The show ip flow export command displays information about the software-switched flows 
for the data export, including the main cache and all other enabled caches.

show ip cache flow

The show ip cache flow command display a summary of the NetFlow cache flow entries.

show ip cache verbose

The show ip cache verbose command displays additional information for the NetFlow cache 
entries.

Configuring GRE Tunnels

This section introduces GRE tunnels and describes how they are configured. GRE is used to 
listen to routing traffic on a network other than the local network. This section also describes 
how to configure a loopback interface for Cisco routers. Use a loopback interface to monitor two 
areas that are linked to a single router.

To listen to routing traffic on a network other than the local network, remotely connect that 
network to a secondary network interface on the appliance, or use a GRE tunnel to form the 
adjacency.

The GRE tunnel follows standard routing across the network to the destination. Only the 
source router and appliance need to be configured to bring up the tunnel.

In general, a small address block is assigned to the tunnel (usually a /30 address block with 
four addresses in it). Of these four addresses, the first and last address are the network and 
broadcast addresses, respectively. The second address is assigned to the router end of the 
tunnel, and the third to the appliance end of the tunnel. For example, assume that the address 
block 10.0.1.0/30 is assigned to the GRE tunnel. The four addresses are allocated as follows:

• 10.0.1.0/30 is the network address.

• 10.0.1.1/30 is the router end of the tunnel.

• 10.0.1.2/30 is the appliance end of the tunnel.

• 10.0.1.3/30 is the broadcast address.

The tunnel extends from the router to the appliance, and you must configure the tunnel on the 
router and on the appliance.
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When you configure the router, keep the following points in mind:

• From the router perspective, the tunnel source is the IP address of either a loopback or 
physical address on that router.

• The tunnel destination is the IP address of the physical interface on the appliance.

• The IP address of the tunnel has to be assigned to the monitored protocol on the router. For 
example, there must be a network statement in OSPF for the network IP address of the 
tunnel.

When you configure the appliance, keep the following points in mind:

• The tunnel source is the IP address for the physical interface on the appliance.

• The tunnel destination is the IP address of the physical interface of the remote router.

The default Maximum Transmission Unit (MTU) size is 1476 for OSPF and 
EIGRP and 1514 for IS-IS.

To create a GRE tunnel on Cisco destination router, the information in Table 15  must be 
configured for the router. (This description applies to Cisco routers and may vary for others. 
Refer to the router documentation for detailed router configuration instructions.)

For a GRE tunnel that will carry an EIGRP peering, the default 7 kb/s bandwidth setting of the 
tunnel must be increased to a value that reflects the bandwidth available on the physical path. 
This change is required because EIGRP protocol packets are paced to consume no more than 
half of the available bandwidth, and 3.5 kb/s may not be sufficient to deliver Update packets 
for the full EIGRP routing table in less time than the 180-second stuck-in-active (SIA) timeout. 
As a consequence, the peering can flap indefinitely if any routes are active at the time the 
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peering is initiated. A bandwidth setting of 1000 kb/s, as shown in Table 15 , is generally 
sufficient, but this may be increased if the bandwidth of the physical path is higher. Setting the 
bandwidth for protocols other than EIGRP is fine, too, although not required.

To configure a GRE tunnel, perform the following steps:

1 On the Recorder Configuration page, select a protocol instance name on the tree.

2 From the pop-up menu, click View to see the protocol configuration.

3 Click New Tunnel on the Recorder Configuration page.

The Configure Interface section opens, as shown in Figure 27.

Figure 27 Configuring a GRE Tunnel Interface

Table 15 Required Tunnel Information on Remote Router

Item Example of Command

Tunnel Interface int tunnel <n>

Tunnel IP ip address 10.0.1.1 netmask 255.255.255.252

Tunnel Source tunnel source loopback 0

Tunnel Destination tunnel dest <Traffic Explorer IP address>

Bandwidth bandwidth 1000

Network Statement The routing protocol configuration must include a network 
statement with the assigned IP address of the tunnel and the 
inverse of the network mask. For example:
router ospf <n> network 10.0.1.0 0.0.0.3 area <area to 
be monitored>
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4 In the Interface text box, enter a descriptive name for the tunnel.

5 If you are configuring a tunnel for an OSPF instance, and OSPF authentication is 
configured for the area to be monitored, then you must configure authentication by 
selecting the Enable check box.

• For simple authentication, enter a password in the Password text box that matches the 
password in the remote area.

• For MD5 authentication, enter a password and MD5 Key-ID that match the password 
and key used in the remote area.

If an MD5 key is entered, it is assumed that there is MD5 authentication for this OSPF 
area. If no MD5 key is entered, then simple authentication is presumed.

6 In the Remote IP Address text box, enter the IP Address of the physical interface or 
loopback on the remote router.

This IP address should be the same as the Tunnel Source address you configured on the 
router.

7 In the Local IP address text box, enter the IP Address assigned to the tunnel on Traffic 
Explorer.

Using the example addresses listed above, this would be 10.0.1.2

8 In the Netmask text box, enter the network mask of the Tunnel IP address that you 
configured on the router.

The format for the Netmask field can be one of the following:

• CIDR notation (/x) 

• Netmask notation (x.x.x.x) 

Here is an example based on the addresses used in Figure 27:

• Remote IP Address: 192.123.4.5 (IP address of the physical interface or loopback on 
the router that is the tunnel destination.)

• Local IP Address: 10.0.1.2 (IP address assigned to the tunnel on Traffic Explorer.)

• Netmask: /30 (mask length for the Tunnel IP address of the tunnel.)

9 Click Update. 

The protocol instance configuration box returns on the Recorder Configuration page with 
the new tunnel name appearing in the Not Active interface list.

10 To begin recording data for the tunnel, move the tunnel name into the Active column.

11 Click Update.
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Configuring a Loopback Interface for Cisco Routers

To monitor two areas that are linked to a single router, you must configure a loopback interface 
on the Cisco router. If you do not do this, only one adjacency will be formed with the remote 
router. Both areas will come up initially with full adjacency, but the first one to come up will 
fail soon after. Use the command line interface to the router to configure the loopback interface.

To configure a loopback, perform the following steps:

1 Open a session with the router.

2 Enter the following commands:

int loopback <n>
ip address <ip address> <netmask>
int tunnel <n>
ip address <tunnel ip address> <netmask>
tunnel source <loopback ip address>
tunnel destination <Traffic Explorer ip address>
router ospf <process number>
network <loopback ip address> <inverse netmask> area <a>
network <tunnel ip address> <inverse netmask> area <a>

Enabling Technical Support Access

To enable or disable technical support options, choose Administration > Support Access. 
The Technical Support Configuration page displays as shown in Figure 29.

In a multi-appliance configuration, access the Technical Support Configuration 
page of each system individually to enable tech support access.
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Figure 28 Technical Support Configuration Page

The Technical Support Configuration page has two buttons that control access by technical 
support personnel. The first, Technical support access, is enabled by default. It allows HP 
technical support personnel to connect using an SSH connection and a specially encrypted key. 
Access is restricted to HP technical support personnel and is initiated only after obtaining your 
permission as part of your requested assistance. To disable technical support access, click 
Disable Access.

Disabling technical support access makes it impossible for HP to reset the 
password or perform diagnostic services. In this case, you must return the 
appliance to receive support.

If the appliance is connected to a network where direct remote access is not possible due to 
firewall restrictions, enabled the Technical support callback feature by clicking Enable 
Callback. This initiates an SSH connection from the appliance to a dedicated and tightly 
secured server at HP. Firewall rules usually allow such outbound SSH connections. The 
connection is configured in such a way that new login sessions can be tunnelled from the server 
at HP through the SSH connection back to the appliance. As in the case of direct remote access, 
these login sessions use SSH and require a specially encrypted key.

When you enable technical support access, technical support callback is also 
enabled. When you disable technical support access, technical support callback 
is disabled as well.
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Figure 29 Technical Support Configuration Page
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4 Administration
Administration includes ongoing maintenance tasks such as managing users, updating 
software, and maintaining databases. You perform these tasks per client, rather than using the 
Administration pages of the master appliance. To access the Administration pages, click 
Administration at the top of the appliance Home page. 

Before performing the administrative tasks described in this chapter, see Chapter 3,  
“Configuration and Management”  for information about how to access the Administration 
pages, log in, and configure components. 

Chapter contents:

• Creating and Authenticating User Accounts on page 134

• Creating Traffic Groups on page 141

• Creating CoS Definitions on page 146

• Configuring the VNC Server on page 149

• Managing Databases on page 153

• Backing Up and Restoring Data on page 157

• Replacing Client and Master Appliances on page 167

• Choosing a Data Source on page 172

• Archiving Data on page 175

• Updating Software on page 181

• Using the Reports Scheduler on page 186 

• Scheduling Top N Reports on page 192

• Configuring the FTP Server on page 195

• Configuring Flow Fanout on page 196

• Viewing and Exporting Log Pages on page 198

• Uploading Layout Backgrounds on page 199
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• Using Diagnostic Functions on page 201

• Shutting Down on page 203

The links and buttons on the Administration pages might differ from those 
shown in the examples in this guide, depending on the functions for which your 
system is licensed. If your system is not licensed for a particular function, the 
links or buttons related to that function do not appear on the Administration 
pages.

Creating and Authenticating User Accounts

You can configure authentication to be performed locally or through a remote TACACS+ or 
RADIUS server. In multi-unit deployments, you have the option of using the master unit as the 
authentication server for the client units (using TACACS+).

Local authentication is always used as a fallback in the event that authentication through a 
remote server (Master or external server) fails. For this reason, it is important to always have 
at least one administrator account configured on each appliance. It is also important to change 
the passwords on the factory installed accounts to more secure values because these local 
accounts will be used for authentication if access to the remote server fails.

User Privileges

Every user is assigned one of the following privileges:

• Administrators have full access privileges and can perform the following functions:

— Configure other user accounts.

— Load, modify, or delete any layout, as described in “The Routing Topology Map” chapter 
of the HP Route Analytics Management System User’s Guide. 

— Modify or delete groups of network elements (routers, links, prefixes) that are owned 
by others, as described in “The Routing Topology Map” chapter in the HP Route 
Analytics Management System User’s Guide.

— Configure alerts, as described in the “Alerts” chapter of the HP Route Analytics 
Management System User’s Guide. 
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• Operators can access the Application and the Report pages, but do not have any 
administration privileges. Operators can load any layout, but if they save a layout that they 
do not own, a new copy of the layout is created with the same name, but with the new 
owner. Operators can also save a layout under a new layout name.

• Guests are view-only users. They have the same access as operators, but cannot save or 
delete routing topology map layouts.

When administrators, operators, and guests use SSH for access, the X Window System or 
VNC client displays the graphical interface.

• CLI Access users use SSH to connect to the TTY user interface rather than the graphical 
user interface. Once connected, the CLI access user can run diagnostic commands, reboot 
the appliance, or shut it down. For more information about using diagnostic and other 
command-line functions, see the RAMS Appliance Setup Guide.

TACACS+ and RADIUS Parameters

You can use existing TACACS+ or RADIUS server that is configured for user accounts; 
however, changes to the account parameters are required to authorize the users for access to 
the appliance at an appropriate privilege level. 

TACACS+

To configure a TACACS+ server for use with the appliance, you must define a set of authorized 
users, which are expressed as service/protocol pairs. There are four classes of users: 

• Administrator (rex-admin)

• Operator (rex-op)

• Guest (rex-guest)

• CLI (rex-cli). 

Each user should be authorized for service “ppp,” with the protocol as one of the above strings 
(for example, rex-admin). For example, a guest user would have service=ppp 
protocol=rex-guest. The “ppp” is a convention used by the appliance to identify users.

A user should not be in more than one of the four user classes. If the account needs FTP or 
secure File Transfer Protocol (SFTP) access, it should be assigned separately (for example, 
service=ppp protocol=rex-ftp).
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The following example shows a tac_plus.conf configuration file. The example creates an 
administrative user “admin” with password “mypassword.” It also creates an Operator “op,” 
with FTP access; and a CLI account called “cliuser.” The latter two accounts store their 
passwords encrypted.

key = SomethingSecret
user = admin {
        pap = cleartext mypassword
        service = ppp protocol = rex-admin {}
}
user = op {
        pap = des sOzm4t1mClWDg
        service = ppp protocol = rex-op {}
        service = ppp protocol = rex-ftp {}
}
user = cliuser {
        pap = des 6bjKZUV4xsNRQ
        service = ppp protocol = rex-cli {}
}

RADIUS

For RADIUS, configure each of the four user classes as a NAS Identifier and then list the user 
names associated with each identifier. In FreeRADIUS, the configuration is done by populating 
a “huntgroups” file, as in the following example:

rex-op          Nas-Identifier == rex-op
                User-Name == op

rex-admin       Nas-Identifier == rex-admin
                User-Name == admin

rex-ftp         Nas-Identifier == rex-ftp
                User-Name == admin,
                User-Name == op,
                User-Name == cliuser

rex-guest       Nas-Identifier == rex-guest

rex-cli         Nas-Identifier == rex-cli
                User-Name == cliuser
136 Chapter 4



It is important to specify all of the groups, even if they are empty. Otherwise the system will 
grant those group privileges to any user. User names in FreeRADIUS are defined in a “users” 
file, as in the following example:

admin           Cleartext-Password := "mypassword"
op              Cleartext-Password := "operator"
cliuser         Cleartext-Password := "cliuser"

User Administration Page

Open the User Administration page to select an authentication server, create and update user 
accounts for local authentication and log-in attributes for the users you support.

To open the page, choose Administration > Users. The top portion of the User Administration 
page displays the following authentication information:

• TACACS Server—TACACS+ is a security system that can provide centralized validation 
of users.

• RADIUS Server—RADIUS is a method that was originally designed for authenticating 
modem and ISDN connections and for tracking connection time, but subsequently 
extended for general authentication service.

• Local Authentication—This is the default choice for user authentication. The system 
contains a TACACS+ server that references the database of users configured through the 
User Administration page. Always configure local authentication on the master appliance 
in a multi-appliance deployment.

• Authenticate via Master—The client will use the master as its TACACS+ authentication 
server.

Selecting an Authentication Method

To select the authentication method for all users to access the system, perform the following 
steps:

1 Choose Administration > Users to open the User Administration page (in Figure 30).
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Figure 30 Authentication Method Section of User Administration Page

2 Select TACACS+ Server, RADIUS Server, or Local Authentication as the 
authentication method, and enter the shared secret in the Shared Secret text box for the 
option you selected. 

If you have a master/client configuration and the master appliance is set for local 
authentication, then when you bring up a client, Authenticate via Master is selected and 
the shared secret is added automatically. If you reconfiguring a client to work with a 
master, you will need to enter the shared secret for the master.

3 Select the Show Shared Secret check box if you want the shared secret to be displayed.

4 Click Update to save the information.

After changing the authentication method, immediately test access using the 
new method using another browser window. If that test fails, you can switch 
back the authentication method using the original browser window that is still 
logged in.
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Creating New User Accounts

User accounts that are configured on the User Administration page are always authenticated 
using local authentication. Always maintain at least one administrator user account, even if 
TACACS+ or RADIUS is selected as the general authentication method. Doing so assures that 
you can access the system even if the TACACS+ or RADIUS server is unavailable. It is also 
important to change the passwords on the factory installed “admin” and “op” accounts, or to 
delete them, since the default passwords may be easily guessed.

To create a new user account, perform the following steps:

1 Choose Administration > Users.

2 Enter the user name in the New User field (Figure 31).

Figure 31 Create Users Section of User Administration Window

3 Select the privilege level of the user from the Privilege drop-down list:

4 Enter and confirm the user password.

5 Click Enable FTP to allow the new account to access the FTP server on the appliance. See 
Configuring the FTP Server on page 195 for more information.

6 Click Create to save the information. Select Cancel to dismiss the window.

To update an existing user account, perform the following steps:

1 Choose Administration > Users.

2 Select a user from the Current Users box.
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Figure 32 Update Accounts Section of User Administration Window

3 Make the desired changes for the user, and click Update to commit these changes.

Update Login Attributes

You can protect a users login by selecting a login expiration time and a timeout in case of 
inactivity. 

To update user login attributes, perform the following steps:

1 Choose Administration > Users.

2 Enter the number of seconds desired before a users login is discarded in the Login Expire 
Time (in seconds) text box as shown in Figure 33. The minimum value is 60 seconds; if you 
enter Never, there is no expiration. 

Figure 33 Update Login Attributes Section of User Authentication Window

3 Enter the amount of time (seconds) that the user must wait to log in again after the login 
expire time. The minimum value is 60 seconds; if you enter Forever, the user can never log 
in again after expiration.
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4 Click Update Login Timeouts to save the information.

Creating Traffic Groups

This section applies to Traffic Explorer only.

Traffic Explorer increases visibility into the traffic flowing through the network core by 
classifying traffic into user-defined groups. Group rules can include a combination of 
source/destination prefixes, TCP/UDP ports, an IP protocol, and traffic classes. The traffic 
group then matches a subset of network traffic between specific locations per applications 
and/or classes of service.

If a traffic class is specified, it matches a subset of traffic associated with a particular Class of 
Service (CoS) defined by Type of Service (ToS) or Differentiated Services Code Point (DSCP) 
bits in the IP header. A traffic deployment can have either ToS or DSCP at one time, but not 
both.

After the appropriate groups are defined, network administrators can track traffic:

• Determine traffic to or from specific application servers (based on prefixes). For specific 
services such as “Voice Premium” or “Voice Gold” (based on ToS and DSCP: AF or EF 
classes).

• Determine the application or CoS.

• Send alerts when percentage utilization or rate exceeds or falls below a specified threshold 
per traffic group.

To access traffic groups, perform the following steps:

1 Choose Administration > Traffic Groups.
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The View Group window opens, as shown in Figure 34.

Figure 34 View Group window

2 To perform a task on this page, choose from the following list of buttons:

• New—Create a new traffic group (see the next procedure).

• Edit—Modify a previously created traffic group.

• Change Order*—Set the priority of the traffic group the Flow Collector will track 
traffic for.

• Enable/Disable—Enable or disable a group.

• Delete—Remove a group.

• Copy—Create a new group using information for the selected group.

Traffic Explorer assigns the lowest priority to the most recently created traffic 
group.

To Create Traffic Groups, perform the following steps:

1 Choose Administration > Traffic Groups.

2 In the View Traffic Groups window, click New.

The New Group window opens as shown in Figure 35.
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Figure 35 Create New Traffic Group Page

3 Configure information in the following fields to create the traffic group:

• Traffic Group Name— Field where you name the traffic group.

When naming traffic groups, use upper and lower case alpha-numeric, 
ampersand (“&”) and underscore (“_”) to name the values.

• Source Prefix—Enter one or more source IP prefixes.

• Destination Prefix—Enter one or more destination prefixes, separated by commas.

• Source Ports—Enter the source port range (e.g., 1-200, 300)

• Choose either the and or the or radio button
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• Destination Ports—Enter the destination port range.

• Protocol—Select Any or a protocol from the drop-down list.

4 In the CoS Groups section of this page, select the Class of Service you want associated 
with traffic group you are creating and then click the arrow button to move the class to the 
Selected column.

5 In the Classes section, select the traffic classes you want to be part of the traffic group you 
are creating. You can do this by clicking once on the class, and then clicking the arrow 
button to the Selected category.

6 Click Submit to save the information. The screen refreshes and displays the information 
entered for the new traffic group

Editing Traffic Groups

This section applies to Traffic Explorer only.

To Edit Traffic Groups, perform the following steps:

1 Choose Administration > Traffic Groups.

2 Select the traffic group and click Edit.

The Edit Group window opens as shown in Figure 36.
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Figure 36 Edit Group Page

The history for the edited traffic group may not match the new definition.

3 Edit the fields you need to revise.

4 Click Submit to save the information. 
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Creating CoS Definitions

This section applies to Traffic Explorer only.

CoS specifies a priority value in the packet header that can be used to differentiate the service 
received by the packet. With this feature, you can associate a user-defined name with a 
particular CoS, making identifying specific traffic flows easier to locate in the various reports 
found in the appliance. CoS groups provide you the ability to combine multiple CoS values in 
a single group.

You must create CoS definitions on the master or standalone appliance.

For IPv4 networks, CoS is specified by a TOS byte or DSCP settings in the IP header. For 
MPLS-IPv4 and MPLS-VPN networks, CoS is specified by the experimental bits in the MPLS 
header. In both cases, a router examines and then applies a quality of service to the packet. 

To access CoS definitions, locate Traffic on the left navigation pane, and choose CoS 
Definitions.

To create a CoS definition, perform the following steps:

1 Choose Administration > CoS Definitions.

2 Click New to define a CoS. The New CoS Definitions window opens as shown in Figure 37.
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Figure 37 New CoS Definition Window

Changing modes will cause CoS definitions with the mode you want to change 
from will be lost.

3 Enter the name to define the CoS in the Name field.

4 Select a traffic value from the Unselected column and click the > arrow to move the value 
to the Selected column. 

5 Click Save to define the CoS value. A confirmation message is displayed along with the 
new CoS definition and its value as shown in Figure 38. 
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Figure 38 Confirming window for CoS Definitions

To edit a Cos definition, perform the following steps:

1 Choose Administration > CoS Definitions.

2 Select the CoS definition to edit and click Edit.

The screen refreshes, showing the CoS definition in the Name field, and the DSCP or ToS 
values in the Unselected column.

3 Edit the name or change the CoS values, as described in the previous section and click 
Save.
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Configuring the VNC Server

If you plan to use a VNC viewer to access the system, you must configure the VNC server on a 
desktop machine. If users will use the X Window System rather than VNC, we recommend that 
you stop the VNC server. For more information about the VNC viewer, see the “Viewers” 
chapter in the HP Route Analytics Management System User’s Guide.

VNC server configuration applies only to appliances operating with a GUI 
license.

You can log into a persistent VNC session that multiple operators can share, or you can log into 
a session that is created on-demand if both session types are enabled. The persistent, sharable 
session has an implicit account name, “Nobody,” and a simple password that is set as part of 
the NVC server configuration. This account is limited to a privilege level of Operator, so it is 
not possible to perform administrative tasks, such as configuring alerts, in the persistent, 
sharable session. Authentication for on-demand VNC sessions uses the accounts and privilege 
levels created on the Users page, or on a remote authentication server.

The VNC server consumes system resources, even when no sessions are active 
and VNC is not configured for sharing. Start the VNC server only when 
necessary.
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To configure VNC settings, perform the following steps:

1 Choose Administration > VNC Configuration to open the VNS Configuration page 
(Figure 39).

Figure 39 VNC Server Configuration Page

2 Configure the following settings. All users who access the system using VNC share the 
settings configured on this page.

• Choose the window size, which is the size of the virtual screen of the VNC viewer. You 
can configure window sizes individually for display 1 and displays 2-10. For display 1, 
select a window size from the drop-down list, or select Custom and enter the width and 
height (in pixels). For displays 2-10, enter the width and height (in pixels).

• Choose the number of colors to use in the display.
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• Choose whether to enable or disable session sharing.

• Enter and confirm the VNC authentication password.

3 Click Update.

4 To start the VNC server, click Start. When you do so, the button toggles to Stop. If VNC 
server changes are required in the future, stop the VNC server before making changes.

If you change the VNC authentication password after the VNC server is 
started, you must stop and restart the VNC server for the new setting to take 
effect.

Connecting to the VNC Persistent Session

After you start the VNC viewer, enter hostname:1, where hostname is the name or IP address 
of the appliance, and then log in using the password you entered in the VNC Configuration 
page. The VNC session opens using the window size, colors, and sharing properties specified in 
the VNC Configuration page for VNC display 1.

If you enable sharing of the persistent session, anyone with the VNC password can access the 
currently active session and issue commands from their desktop. Multiple users can connect at 
the same time and take turns controlling the user interface to jointly work on a problem. If you 
disable sharing, only one person at a time can connect to VNC display 1 and all other users are 
locked out.

When you disconnect from the persistent VNC session, the user interface continues to run. If 
you connect to the session again later, it resumes as you left it unless someone else has 
connected and made changes in the meantime.

If the network connection drops while someone is connected with sharing 
disabled, the VNC server might refuse to allow new connections. To restore 
VNC access, use the Stop/Start button on the VNC Configuration page to stop 
and restart the VNC Server. 

Using On-Demand VNC Sessions

Multiple operators can log into their own sessions.
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After you start the VNC viewer, specify the VNC display window size by typing the hostname, 
a colon, and the VNC display number. For example, enter hostname:8 to connect to display 8. 
The VNC viewer will display a login window where you should log in using a user name and 
password you configured on the User Administration page.

If you and another user connect to the same display number, such as hostname:8, separate 
VNC sessions are created that both users can operate independently. Multiple users can 
connect to on-demand VNC sessions up to the user count limit displayed on the License page.

When you disconnect from an on-demand VNC session, the session is 
terminated immediately.
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Managing Databases

Use the Database Administration page to delete or rename an existing database.

To open this page, choose Administration > Databases. See Figure 40.

Figure 40 Database Administration Page

Databases may occasionally be renamed automatically when a software update requires a 
change to the database schema. Manual renaming may be required if a database becomes 
damaged due to a power failure. The renamed databases are considered offline since they are 
separate from the online databases that are being actively recorded.
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The length of time that traffic reports are kept in the database depends upon the granularity 
of the data. Reports with coarser granularity (daily, weekly, or monthly reports) are kept for 
much longer than reports with finer granularity (5 minute or hourly reports). The amount of 
time that flow data is kept depends upon load and is generally in the range of 1-2 years. In each 
case, the oldest data is deleted if there is not enough space left for new data to be stored.

We recommend that you run an FTP application to connect to the appliance FTP file storage 
area, and then use the delete command to delete any unneeded files. (See Configuring the FTP 
Server on page 195 for information about the FTP file storage area.) 

The Database Administration page consists of two sections: 

• The Offline Databases section lists administrative domains that are not currently being 
recorded.

• The Online Databases section lists administrative domains that are currently being 
recorded (Figure 41).

Figure 41 Online Databases Page

Before performing any database operations, quit all running instances of the 
client and stop the VNC server.

Using Offline Databases

Offline databases contain data from administrative domains that are not currently being 
recorded. You can delete these databases to save disk space, or rename them if the 
administrative domain name changes.
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Deleting a Database

To permanently delete a database, perform the following steps:

1 Stop all instances of the appliance client.

2 Choose Recorder Configuration to display the Recorder Configuration page.

In a distributed configuration, use the Recorder Configuration page of the 
master appliance, which displays a tree representing all units in the 
configuration.

3 If the database you want to delete is currently recording, stop recording on that database. 
Click the node on the tree that corresponds to the database to be deleted and choose Delete 
from the pop-up menu.

4 If you are not working with a distributed configuration, proceed directly to Step 6. 
Otherwise, click Units on the left navigation bar to access the Units page of the master 
appliance and a list of clients in the configuration.

5 In the Client Status section of the Units page, select the client where the database was 
recorded to access the Home page of that client.

6 Navigate to the Home page of the client and choose Administration > Databases.

7 Select the check boxes to the left of the databases to be deleted.

8 Click Delete Selected Databases.

A confirmation page opens displaying the names of the selected databases.

9 Click Yes if you want to delete the selected databases.

The selected databases are deleted.

To delete an existing database and start recording to a new database, perform the following 
steps:

1 Stop all instances of the appliance client.

2 Navigate to the Home page of the client and choose Recorder Configuration.

3 If the database you want to delete is currently recording, stop recording on that database.

4 Click Databases on the left navigation bar.

5 Select the check boxes to the left of the databases to be deleted.

6 Click Delete Selected Databases.
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A confirmation page opens displaying the names of the selected databases.

7 Click Yes if you want to delete the selected databases.

The selected databases are deleted.

8 Navigate back to the Recorder Configuration page and start recording on the configuration 
whose database you deleted.

A new database is created for that configuration and recording begins.

Renaming Databases

To rename one or more databases, perform the following steps:

1 Stop all instances of the appliance client.

2 Navigate to the Home page of the client and choose Recorder Configuration.

3 If the databases you want to rename are currently recording, stop recording on these 
databases.

4 Click Databases on the left navigation bar.

5 Select the check boxes to the left of the databases to be renamed to a single, new name 
(typically, only databases that have a common first-level administrative domain name 
already).

6 Enter the new name in the New Top-Level Administrative Domain text box. Only the 
first-level administrative domain name can be changed, meaning, no period is allowed in 
the new name. Names must begin with an alphabetic character and can contain only 
alphanumeric characters.

7 Click Rename Selected Databases.

A confirmation page opens displaying the names of the selected databases.

8 Click Yes to confirm that you want to rename the selected databases. The top-level name 
of the selected databases is renamed to the new top-level administrative domain.

Using Online Databases

The Online Databases section of the Database Administration page lists all of the 
Administrative Domains that are currently being recorded. Below the list is a message that 
indicates how many days of recording capacity remain based on the current growth rate of the 
most active of the databases.
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Backing Up and Restoring Data

The system stores recorded route topologies and system configuration files in databases. The 
Backup and Restore page allows you to selectively save any or all data files, including 
databases and system configuration files, to one of two storage systems:

• The appliance hard disk.

• A remote storage system, such as your desktop computer. If you back up to a remote storage 
system, you must configure Server Message Block (SMB) information for that system. See 
Enabling SMB and Adding a Remote Server on page 164.

You can save the backup file through the administration interface or by using FTP. Because 
most web browsers do not allow file transfers larger than 2-4 GB, we recommend that you use 
FTP to manage large backup files. See Transferring Backup Files Using FTP on page 167.

The system saves the data files into a single backup file named backup.dat. The system saves 
the backup file with the date and time in your local time zone.

If you back up only to the appliance, there is only one backup file. After you 
create a new backup file, this new file automatically overwrites the old backup 
file.

Creating a Backup File

During the backup file creation process, a backup file is created containing the selected 
databases and/or system configurations. A metadata header is then attached to the backup file. 
The metadata header contains database and/or system configuration information. It also 
contains general information about the backup file, including the following items:

• The OS version number.

• The Unit ID of the appliance.

• The schema version number.

• The backup creation date and time.

The system configuration information contains the following items:

• The recorder configuration information.

• System licenses.
Administration 157



• All system logs.

• User account information.

To open the Backup and Restore page, choose Administration > Backup and Restore 
(shown in Figure 42).

Figure 42 Backup and Restore Page

This page contains the following sections:

• Filter By—Allows you to filter the list of items by administrative domain, protocol, or area 
ID. If you make a selection and click Filter, the list is redisplayed with the filtering option 
applied.

• Create Backup on this Unit’s Disk—Contains a list of all system configurations and 
databases in the system and includes the following check boxes: 

— Layout and other properties—This check box is always selected, because every 
backup includes layout and related properties. If you do not select any other check 
boxes, you back up only the layout and related properties.
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— System Configuration—Select this check box to back up the system configuration.

• Data table—Lists all the data files available for backup and includes the following 
information:

— Administrative Domain—The system configuration and/or database administrative 
domain name.

— Protocol—The protocol the file uses.

— Area ID—The file area ID.

— Size—The size of the file.

• Restore from Backup on this Unit’s Disk—This section contains the backup file 
information and the databases and system configuration contained in that file.

Figure 43 Restore from Backup Section
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To create a backup file, perform the following steps:

1 Choose Administration > Backup and Restore.

2 Select check boxes to the left of the database and/or system configuration domains that you 
want to back up.

You cannot back up or restore an actively recording database. An actively 
recording database opens in the list in green text and an asterisk in place of 
the check box. Stop database recording in the Recorder Configuration page. 
See Updating Software on page 181.

3 Click Create Backup.

The backup process begins. Depending on the size of the database or configuration, the 
backup process can take several minutes. The Backup and Restore page opens and 
periodically updates with the file size as it progresses.

4 When the backup file is created, the Finished button is displayed on the Backup and 
Restore page. Click Finished to continue.

The Backup and Restore page displays the new backup files in the Restore from Backup on 
This appliance’s Disk table at the bottom of the page, as shown in Figure 43.

Depending on the size of the database and on the Login Idle-Timeout settings, 
the Administration login may time out before the backup completes. If the 
Finished button does not appear after approximately 15 minutes, log in 
again.

The Backup Info table appears above the backup file table. This table contains the 
following backup file information:

• Backup Date—The backup date and time.

• Software Version—The software version used to create the backup file.

• OS Version—The OS version used to create the backup file.

• Unit ID—The ID of the appliance.

• Size (in bytes)—The size of the backup file in bytes.

5 If you stopped recording before you backed up, start recording data again in the Recorder 
Configuration page. 
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Saving a Backup File

After creating a backup file, you can save the file to another location.

Some browsers to do not allow file transfers larger than 2-4 GB. It is 
recommended that you use FTP to manage large backup files. See Transferring 
Backup Files Using FTP on page 167.

To save a backup file, perform the following steps:

1 Create a backup file as describe on page 160. 

2 On the Backup and Restore page, click the Download Backup File button.

A File Download dialog box opens.

3 Click Save.

4 Enter a filename for the backup or accept the default filename (backup.dat), and then 
select a destination for the backup file.

5 Click OK. The system saves the backup file to the destination you specified in Step 3.

Uploading a Backup File

If you downloaded a backup file that you want to restore, you must upload the file before you 
restore it.

Some browsers to do not allow file transfers larger than 2-4 GB. It is 
recommended that you use FTP to manage large backup files. See Transferring 
Backup Files Using FTP on page 167.

To upload a backup file, perform the following steps:

1 Choose Administration > Backup and Restore.

2 Click Upload Backup File at the bottom of the page.

The Restore Backup from File window appears.
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3 Enter the location of the backup file in the Backup Filename text box, or browse for the file 
by clicking Browse.

4 Click Upload File.

The upload process begins. Depending on the size of the database or configuration, the 
upload process can take several minutes.

The databases and/or system configuration in the uploaded backup file appear in the 
Restore from Backup on This appliance’s Disk table.

Restoring a Backup File

You can restore a backup file that has been uploaded.

To restore a backup file, perform the following steps:

1 Upload the backup file, if necessary, as described in Uploading a Backup File on page 161.

2 Choose Administration > Backup and Restore. 

3 Select checkboxes to the left of the database and/or system configuration domains that you 
want to restore.

You cannot back up or restore an actively recording database. Stop database 
recording in the Recorder Configuration page. See Updating Software on 
page 181.

4 The Layouts and other properties check box is selected by default. Unselect this check 
box if you do not want to restore the layouts and related properties.

5 If the Layouts and other properties check box is selected, you can optionally select 
Overwrite layouts and other properties to override the layouts and other properties 
on the system. If the Layouts and other properties check box is not selected, this check 
box is grayed out.

6 Click Restore Selection.

The restore process begins. Depending on the size of the database or configuration, the 
restore process can take several minutes. The Backup and Restore page appears and 
periodically updates with the file size as it progresses.
162 Chapter 4



If you are restoring the system configuration, a warning appears saying the 
system will reboot after the restore is complete. The configuration is restored 
and a message appears indicating that the system is rebooting. If the system 
does not respond to the browser, wait approximately three minutes for the 
boot process to complete, and log in again. 

The Backup and Restore page displays the restored backup file in the Restore from Backup 
on This appliance’s Disk table at the bottom of the page. If you have more than one backup 
table in this section, the restored backup file appears in the top table.

7 On the master appliance, the system configuration must not be restored from backup 
because the information will be inconsistent between the old appliance and its 
replacement. Instead, you must manually configure the following administration items as 
needed:

• Login Message

• Queries

• VNC Configuration

• Archival Configuration

• FTP Server

• Mail

• Network and Interface (host name and DNS server)

• Time and Date ( configuring an NTP server is required)

Restoring the sytem configuration on the master appliance works only when 
the configuration is alreadypresent on a system that has been operating, but 
you want to restore it to before the last change made.

8 If you want to append new data to the restored database, start recording again in the 
Recorder Configuration page.
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Deleting a Backup File

You can delete the backup file from the hard disk to free up space.

To delete the backup file, perform the following steps:

1 Choose Administration > Backup and Restore. 

2 Click Delete Backup File, which appears below the Create Backup on This appliance’s 
Disk table. 

3 In the dialog box that appears, click YES.

The backup file information no longer appears in the Restore from Backup on This 
appliance’s Disk section.

Enabling SMB and Adding a Remote Server

The system uses the Common Internet File System (CIFS) implementation of the SMB to 
create and restore backup files using a remote storage server. You can enable SMB to create 
more than one backup database and/or system configuration file on a remote storage server.

Remote server reachability is checked every time you open the Backup and 
Restore page. If the system cannot open the remote server, then the Backup 
and Restore page displays the backup and restore information.

To enable SMB and add a remote server, perform the following steps:

1 Choose Administration > Archival Configuration to open the Remote Storage page 
(Figure 50). 
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Figure 44 Archival and Remote Storage Configuration Page

2 Select Enable SMB to create or restore backup files from a remote storage server.

3 Enter the remote server login user name in the Remote user name text box.

If the login is for a guest only, then leave the user name blank.

4 Enter the remote server password.

5 Enter the remote server IP address.

6 Enter the remote server share name.

7 Click Update.

The remote storage server information appears in the Restore from Backup on This appliance’s 
Disk section of the Backup and Restore page.

Restoring a Backup File from a Remote Server

Data files are saved in a single backup file named backupYYMMDDHHSS_UnitID.dat 
where YYMMDDHHSS is the date and time the file was saved and UnitID is the server Unit ID. 
For example, 0506251345_00304870B6B0.dat specifies the file was saved on June 25, 2005 at 
1:45 p.m. with the Unit ID of 00304870B6B0.
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If you back up to a remote storage server, you only have access to the backup 
files on the remote 
server, not on the appliance.

If you enabled SMB to save multiple backup files, all backup files appear in the Backup to SMB 
Storage section of the file backup table. The Restore from SMB Storage section appears 
underneath the file backup table.

This section displays the information of each backup file in a separate table. The file 
information of the table that was backed up most recently appears at the bottom of the section. 
The table contains the following information about the file:

• Backup Date—The date and time the file was backed up.

• Software Version—The software version used to create the backup file.

• OS Version—The OS version used to create the backup file.

• Unit ID—The ID of the appliance.

• Size (in bytes)—The size of the backup file in bytes.

• Contents—Displays the database names and/or indicates that the backup file includes the 
system configuration.

To restore a backup file from a remote server, perform the following steps:

1 Choose Administration > Backup and Restore.

2 Select the option button in the left column of the backup file. 

3 Click Select Backup File.

The backup file databases and/or system configuration appears in the file backup table at 
the bottom of the Restore from SMB Storage section.

4 Select one or more check boxes to the left of the database and/or system configuration 
domain name that you want to back up.

You cannot back up or restore an actively recording database. Stop database 
recording in the Recorder Configuration page. See Updating Software on 
page 181.

5 Select Overwrite layouts and other properties if you want to restore a backup set of 
layouts and properties.
166 Chapter 4



6 Click Restore Selection.

The restore process begins. Depending on the size of the database or configuration, the 
restore process can take several minutes. The Backup and Restore page appears and 
periodically updates with the file size as it progresses.

If you are restoring the system configuration, a warning appears saying the 
system will reboot after the restore is complete. The configuration is restored 
and a message appears indicating that the system is rebooting. If there is no 
response, wait approximately three minutes for the boot process to complete, 
and log in again. 

The Backup and Restore page displays the restored backup file in the Restore from Backup 
on This appliance’s Disk table at the bottom of the page. If you have more than one backup 
table in this section, the restored backup file appears in the top table.

7 If you want to append new data to the restored database, start recording again in the 
Recorder Configuration page.

Transferring Backup Files Using FTP

Most web browsers cannot manage transfers of files that are 4 GB and larger. Therefore, you 
have the option of saving the backup.dat file to the hard disk using FTP. You must enable the 
FTP server to transfer backup files using FTP. See Configuring the FTP Server on page 195.

Replacing Client and Master Appliances

Follow the procedures in this section to replace client and master appliances in a multi-unit 
deployment.

Replacing a Client Appliance

Follow the steps in this section to replace a client appliance within a master-client 
configuration. It is assumed that you have an available backup file (backup.dat). 
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Make sure that you take regular backups of at least the system configuration 
according to the instructions in Creating a Backup File on page 157 and Saving 
a Backup File on page 161. Be aware that backing up databases requires that 
you first stop recording. As an alternative, you can enable archiving according 
to the instructions in Configuring Automatic Archival Settings on page 176.

To replace a client appliance, perform the following steps:

1 Choose Recorder Configuration.

2 Click Stop All Recording.

Recording is stopped and the Recorder Configuration page refreshes.

Figure 45 Stopping Recording

3 On the Recorder Configuration page, click the highest node in the recorder configuration 
hierarchy that is bound to the unit in question, and choose Delete. You may need to do 
multiple deletes if the protocols bound to the unit are configured in a disjoint manner. 
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Figure 46 Deleting Units

4 Configure the new unit. For the initial configuration, enter the IP address of the unit that 
you are replacing.

5 Perform this step if the backup was performed using remote storage on an SMB server. On 
the new client unit, open the web interface and choose Administration > Archival 
Configuration. Choose Enable SMB Client and configure the remote server 
parameters.

6 On the new client unit, open the web interface and choose Administration > Backup and 
Restore.

7 Click Upload Backup File and browse to choose and upload the backup.dat file that you 
created earlier. If the backup was made to an SMB server, follow the instructions in 
“Restoring a Backup File from a Remote Server” on page 4-165.

The items available for backup are now listed on the Backup and Restore page. 

8 Choose System Configuration plus any databases that you want to restore. You do not 
need to select Overwrite layouts and other properties if the layout, alert, or group 
information stored on the master appliance is already current. Click Restore Selection. 

9 If the backup file was created after midnight on the most recent Sunday, rename the active 
databases before recording is started. This ensures that new databases are created, which 
is required for database replication to work correctly.

10 On the master unit, choose Administration > License and update the license for the new 
unit. 
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11 On the master unit, choose Administration > Units. Click Add, enter the IP address of 
the new unit, and click Add.

The client unit is added and the client status information is updated on the Units page.

12 On the master unit, choose Recorder Configuration and click Start All Recording.

Replacing a Master Appliance

Follow the steps in this section to replace a master appliance within a master-client 
configuration. It is assumed that you have an available backup file (backup.dat) from the 
master appliance containing at least one database. No system configuration backup is used.

To replace a master appliance, perform the following steps:

1 Use one of the following methods to stop recording:

• If you are replacing a working master, then open the web interface, choose Recorder 
Configuration, and click Stop All Recording. Recording is stopped and the 
Recorder Configuration page refreshes to show the affected units.

• If you were unable to stop all recording from the master because the unit was not 
reachable, then open the web interface for each client unit. Choose Recorder 
Configuration and click Stop All Recording.

2 Disconnect the master appliance from the network.

3 Install the new unit, as described in Chapter 2,  “Initial Configuration” For the initial 
configuration, enter the IP address of the unit that you are replacing.

4 On the master unit, open the web interface and choose Administration > License. Install 
the license for the new unit if is not already installed.

5 Choose Administration > Units and click Make Master.

Figure 47 Making a Master Unit
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6 On the master appliance, the system configuration must not be restored from backup 
because the information will be inconsistent between the old appliance and its 
replacement. Instead, you must manually configure the following administration items as 
needed:

• Login Message

• Queries

• VNC Configuration

• Archival Configuration

• FTP Server

• Mail

• Network and Interface (host name and DNS server)

• Time and Date (configuring an NTP server is required)

Restoring the sytem configuration on the master appliance works only when 
the configuration is alreadypresent on a system that has been operating, but 
you want to restore it to before the last change made. 

7 To add the client units, choose Administration > Units. For each client unit, enter the IP 
address, and click Add. The recorder configuration will be pulled up from the client 
appliance to the master.

8 On the master unit, choose Recorder Configuration and click Start All Recording. 
Verify that all of the recorders start and begin writing to their databases.

9 Choose Administration > Data Source Configuration, and configure the same options 
that were configured on the old master. Click Update. 

10 Choose Administration > Backup and Restore. Click Upload Backup File and 
browse to choose and upload the backup.dat file that you created earlier. If the backup was 
made to an SMB server, follow the instructions in “To restore a backup file from a remote 
server, perform the following steps:” on page 4-166.

The items available for backup are now listed on the Backup and Restore page. 

11 The Layouts and other properties check box is selected by default. Unselect this check 
box if you do not want to restore the layouts and related properties.
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12 If the Layouts and other properties check box is selected, you can optionally select 
Overwrite layouts and other properties to override the layouts and other properties 
on the system. If the Layouts and other properties check box is not selected, this check 
box is grayed out.

Figure 48 Restoring a Master Unit

Choosing a Data Source

You can have multiple recorders geographically and topologically distributed in remote parts 
of the network. This provides you with a global view of the entire network topology from a local 
copy of the database, which will minimize delay. Data replication is enabled by default on the 
Modeling Engine.

Using the Data Source Configuration page, you can have the appliance that is licensed to act 
as a Modeling Engine replicate data from the Route Recorders in your distributed 
configuration. This centralized Modeling Engine consolidates the data that has been collected 
across the network to a centralized location. You can retrieve network-wide information from 
a local source.
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The Data Source Configuration page allows you to specify where routing data is obtained. You 
can obtain reports from individual Route Recorders; however, using a centralized Modeling 
Engine to generate reports provides a global view of the network and reduces the amount of 
time required to obtain that view. In addition, querying the Modeling Engine reduces the 
amount of work required by the Route Recorders, whose primary function is to record data.

If you do obtain routing data by querying each Route Recorder individually, you can configure 
GRE tunnels to connect Route Recorders deployed to remote areas of the network. Each Route 
Recorder provides reports specific to the local areas and protocols where it is listening. 

You need at least 1 Mbps bandwidth between the Route Recorders and the 
replicating Modeling Engine.

Choose a data source using the Data Source Configuration page.

To set up the data source configuration on the Modeling Engine, perform the following steps:

1 Choose Administration > Data Source Configuration to open the page (Figure 49).
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Figure 49 Data Source Configuration Page

2 Click Get data from Route Recorders to disable replication of data on the Modeling 
Engine. To obtain network information, you must query individual Route Recorders.

3 Click Connect to a Replicating Modeling Engine in deployments where multiple 
Modeling Engines are co-located. You can choose one appliance to act as the centralized 
Modeling Engine, then point additional Modeling Engines to this central appliance to 
obtain network-wide data. When you select this option, you must provide the IP address of 
a Modeling Engine who has replication enabled as described in the following paragraph.

4 Click Enable Replication to allow replication from the Route Recorders in the 
deployment.

5 Choose a time interval from the drop-down list to obtain data for the specified interval. 
When you enable replication, you choose the amount of data to be copied from the network’s 
Route Recorders to the centralized Modeling Engine. 

6 Click Update to update the list of replication databases.

7 Click Start Replication to begin the replication process.
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While data is being replicated, the Replication Status table lists the IP addresses of each Route 
Recorder in the deployment, which databases are being copied, and the status of the 
replication. Only databases that are currently recording are replicated.

When a Route Recorder is added to the network, the centralized Modeling 
Engine automatically begins replicating data from that appliance. If you opt to 
bring back 2 weeks of data, for example, the Modeling Engine copies data 
recorded up to 14 days before the Route Recorder was added to the 
configuration.

If replication is enabled on the Modeling Engine, you can select the Central Reports/Alerts 
daemon check box to produce network-wide reports from the local Modeling Engine. This 
option is required to enabled event driven exploration for RSVP-TE reports if IGP databases 
are on a different Route Recorder than the TE Collector. See the “RSVP-TE Reports” chapter 
in the HP Route Analytics Management System User’s Guide for more information.

After a database is replicated on the Modeling Engine, the Route Recorder retains ownership 
of that data. Any operation, such as delete or rename, that is performed on the Route Recorder 
will be replicated on the Modeling Engine.

Archiving Data

The automatic archival of data differs from creating backup files, which is described in Backing 
Up and Restoring Data on page 157:

• You can archive data without stopping the recording process or requiring users to log off.

• Segments of data are archived on an incremental basis, rather than stored at once. 
Segments of data are created each week, on Sunday, when the database is divided into 
manageable files, labelled by date and time. These files are archived at regular intervals 
(every 7 days, on Monday at 0:00). Only previously unarchived data is stored during this 
process. Archived data remains accessible for analysis through the History Navigator. For 
more information, see “The History Navigator” chapter in the HP Route Analytics 
Management System User’s Guide. 
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The procedures for archiving data on the Modeling Engine are the same for a 
distributed configuration as they are for stand-alone configurations. The only 
difference is the archived data for the distributed configuration will be 
replicated.

Unlike Backup and Restore, automatic archiving data does not allow up-to-the-minute data 
storage and retrieval. For example, if data is automatically segmented on Sunday, June 25 at 
10:55 PM, those segments are archived Monday, June 26, at 0:00. Any data written to the 
database beginning on Sunday, June 25 at 10:56 PM is not archived until the following Monday, 
July 3 at 0:00. To capture data between intervals use the Archive Now feature. This manual 
option requires you to stop recording on the database before archiving, and is described in 
Manually Archiving Data on page 178.

If more than one recorder is recording and archiving the same network area, or 
if archiving is configured on both the recorder and Modeling Engine that is 
replicating the data, and if both are pointing to the same storage appliance, 
then the recorder or Modeling Engine that was invoked first will actually store 
the data.

Configuring Automatic Archival Settings

Manage the archival tool using the Archival Configuration and Remote Storage page (Figure 
50). 
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Figure 50 Archival and Remote Storage Configuration Page

Data is archived every seven days. Archiving of data occurs per-appliance; you must configure 
archival settings on each appliance in a distributed system.

To configure the archiving tool, perform the following steps:

1 Enable remote storage as described in Enabling SMB and Adding a Remote Server on 
page 164.

2 Choose Administration > Archival Configuration to open the Archival Configuration 
and Remote Storage page

3 Select Enable Archival.

4 Click Update.

Any unarchived databases that exist before you enable archival functionality will be archived 
at the next scheduled archiving interval.
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Manually Archiving Data

To archive data between regularly scheduled intervals, which occur weekly on Monday at 0:00 
in the time zone set on the appliance, use the Archive Selected Databases button on the 
Database Administration page. Only offline databases can be archived. Before manually 
archiving data, you must stop recording on the selected database if necessary. The system then 
archives the most recent unarchived data. When recording is restarted, the system creates and 
begins writing to a fresh segment of the database.

Databases created with software 3.7x and earlier cannot be archived.

To manually archive data, perform the following steps:

1 Choose Administration > Databases.

The Database Administration page is displayed as shown in Figure 40. 

2 In the Offline Databases section, select one or more check boxes corresponding to the 
databases to archive.

If the database to archive is currently online (recording), it appears in green. You must stop 
recording to the database before you can archive data. See Chapter 3,  “Configuration and 
Management” for more information about starting and stopping the recorders.

3 Click Archive Selected Databases.

Segments of the selected databases are archived. Filenames of the archived segments use the 
following format:

DatabaseName_<segment time in epoch>

For example:

CorpNet_Common_West_bgp_AS65520_1149663600

When you restart recording, the system creates and begins writing to a fresh segment of the 
database.

The web-based configuration page includes a Re-archive button as well. Using Re-archive 
forces the system to archive all available data, whether or not the data was previously 
archived.
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Restoring Archived Data

Retrieve archived data using the Restore from Archive page (Figure 51). 

Figure 51 Archival and Remote Storage Configuration Page

This page contains the following settings:

• Start Time: The start time of the data to restore, in the following format:

YYYY-MM-DD HH:MM:SS

followed by the time zone (for example, PDT).

• End Time: The end time of the data to restore, using the format shown above.

• Databases to Restore: Contains the names of all databases that have segments available 
for restoration. The Databases to Restore box lists database names in the following format:

CorpNet.Common/ospf/Backbone

This format corresponds to the literal database name:

corpnet_common_ospf_backbone

Labels are created based on the name of the database. For example, note that if you have 
renamed a database as described in Renaming Databases on page 156, the original 
database name is used in the Databases to Restore list box.
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For example, three labels are listed in the Labels to Restore box. The first label, SegmentA, 
contains data that began recording on June 4 at 10:31:55 PDT. The third label, SegmentC, 
contains data that stopped recording on June 24 at 10:31:55 PDT. The data contained in all 
three listed segments was recorded between the start and end times indicated.

Restoration of data occurs on a per-appliance basis; you must access each appliance in a 
multi-appliance deployment individually to enable and configure archival settings.

To restore archived data, perform the following steps:

1 Choose Administration > Restore Archives.

2 Specify a start and end time corresponding to the data to restore.

For example, to restore data that was recorded between Wednesday, June 7, 2006 and 
Wednesday, June 14, 2006, enter the following:

2006-06-07 0:00:00 in the Start Time text box

2006-06-14 0:00:00 in the End Time text box.

Since each segment of data begins on Sunday and ends on Sunday, the restored archives 
will include more than the requested Wednesday-to-Wednesday time range. In other words, 
restored data will include Sunday, June 4 through Sunday, June 18.

3 Click to select one or more databases in the Databases to Restore list box that corresponds 
to the database to restore. 

4 Click Restore Now.

When restoring the archived data, the system retrieves archived database segments for the 
time range you specified. A new database is then created to store the retrieved segments. 
The new database is named: DatabaseName<Time1>to<Time2>, where 
DatabaseName is the name of the database whose segments have been restored, 
<Time1> is the start time of the first restored segment, and <Time2> is the end time of 
the last restored segment.

Following the example used in Step 2, the restored database name would be:

CorpNet_Common_West20060607to20060614_bgp_AS65520
[or in epoch: 1149663600to1150268400]
180 Chapter 4



Updating Software

HP provides software updates for <major number>.<minor number> versions of the software 
(for example, version 9.0) using the Software Update feature.

To download a new software update, choose Administration > Software Update to open the 
Software Update page (Figure 4-23).

In a distributed configuration where more than one appliance is installed, you 
must update the software of the master appliance before updating the software 
on each client appliance.

Figure 52 Software Update Page
Administration 181



The appliance has its own operating system software and application software. How you 
update the software depends on how it is connected to the Internet:

• The download process is easiest when the appliance is connected to the Internet, either 
directly or through a proxy server. See Updating with Internet Access on page 4-40.

• If the appliance cannot get access to the Internet, you can download an update, move it to 
a locally accessible FTP server and then perform the update. See Updating without 
Internet Access on page 4-42.

Updating with Internet Access

If the system can access the Internet directly or through a proxy server, follow the steps in this 
section. Otherwise, proceed to Updating without Internet Access on page 4-42.

Before updating software, stop recording on Route Recorders and the Flow 
Collectors. Restart recording after the update is complete. This ensures that 
databases are renamed correctly if the update requires it.

To download updates when connected to the Internet through a proxy server, first you must set 
up the proxy configuration. You can then proceed to the second set of steps to download the 
update.

To set up the proxy configuration, perform the following steps:

1 Choose Administration > Software Update on the appliance where you are updating 
software.

2 Click Check for Update.

3 Select the Use Proxy check box.

4 Enter the host and port details for the proxy server.

5 If the proxy server is password protected, enter the user name and password.

6 Click Save Proxy Settings to preserve these settings for future downloads.

In a distributed configuration, where more than one appliance is installed, you can update 
software on multiple machines at once after the software on the master appliance has been 
updated. You must leave each the Software Update page open in a browser window until the 
software download for the machine is complete.
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To download updates when connected directly to the Internet, perform the following steps:

1 Choose Administration > Software Update on the appliance where you are updating 
software.

An Update Available message tells you if an update is available. If so, the URL of the 
update appears automatically in the URL text box. Otherwise, a message tells you no 
update is available.

The Check for Updates button checks only for updates within the same 
major.minor version number. To update to the next major or minor release, 
you must enter the URL manually.

2 In the Key text box, enter the update key provided by HP customer support. Click Update 
to begin download and installation of the update. 

Alternatively, on a Modeling Engine that serves as a master appliance for a system of 
multiple appliances, you can click Update All Units to automatically update the Modeling 
Engine and then all of the client appliances in sequence. The Update All Units procedure 
will not be performed if any of the client appliances is not reachable. When you click 
Update All Units, the software update image is fetched to the Modeling Engine and then 
distributed from there to all of the client appliances. At that point, recording is 
automatically stopped and the Modeling Engine is rebooted. After the Modeling Engine 
comes back up, all of the client appliances are rebooted. The client appliances resume 
recording when they come back up. 

You can monitor the progress of the update in the log window that is displayed on the 
Software Update page. If you exit your browser, the updating and rebooting process will 
still continue. If you later return to the Software Update page, a Finish button and log are 
displayed. Click Finish to complete the process.

3 After the downloading and unpacking of the update image has completed, a message 
appears stating that you must reboot to complete the update. Click Reboot Now and wait 
for the system to reboot. This should take approximately two or three minutes.

In a multi-appliance deployment, when updating software update on a client machine, you 
will be automatically directed to the master appliance’s Home page 5 seconds after you 
click Reboot Now.

4 Log in again.

If at any time during the update process a 404 page error appears, click Back 
on the browser and then click Refresh. 
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Updating without Internet Access

If the system cannot access the Internet directly or through a proxy server, you can download 
an update to a local FTP or HTTP server, and then install the update from the local server.

Use the full URL to download the update because the file may be hidden in an unreadable 
directory.

In a distributed configuration, where more than one appliance is installed, you can update 
software on multiple machines at once after the software on the master appliance has been 
updated. You must leave the Software Update page for each appliance open in a browser 
window until the software download is complete on that machine.

To download updates when the appliance is behind a firewall, perform the following steps:

1 Go to the HP Route Analytics Management Software product web site 
(http://www.hp.com/go/hpsoftwaresupport) and click the Use self-solve knowledge 
search link. Do not use the Software Patches link at the bottom of the page.

2 Search for the keywords RAMS update. Determine if the non-empty results of your search 
provides an appropriate update version of RAMS. 

If an update is available, download it and save it to a convenient location. Make a note of 
the associated update key, which you will need to complete the update.

Instructions that accompany an upgrade may differ in some details from the 
steps given in this section. If so, use the instructions from the web site, as they 
are more recent.

3 Move the update package to a local server configured for anonymous FTP. The RAMS 
appliance itself is an acceptable server, providing you set it up as described in Configuring 
the FTP Server on page 195. 

4 In the URL field, enter the URL for the local server you are using. For example, 
ftp://anonftp.company.com/<dir>/<patch>

If you use the RAMS appliance as your FTP server, the URL could easily be: 

file:///<dir>/<patch>

5 Enter the update key that you saved in Step 2. 

6 Click Update. 

Downloading begins. If the download includes an operating system update, a message 
appears stating that you must reboot to complete the download. 
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7 Click Reboot Now and wait for the system to reboot. This should take approximately two 
or three minutes. 

8 Click the Home link and log in again. 

Returning to a Previous Version

The previously installed version of the software is saved on the appliance. If you experience 
difficulty running a new version of software, you can return to the previous software version. 
The Software Update page displays the previously installed version number.

Reverting to the previous version may require a reset to factory defaults, as 
described in Shutting Down on page 203, because updates may not be 
completely reversible. Resetting to factory defaults will erase all data and 
configuration settings except the installed license. After reverting to the 
previous version and resetting to factory defaults, you can restore the data and 
configuration settings if you have a backup file created with the previous 
version.

To reinstall a previous version of the operating system, perform the following steps:

1 Choose Administration > Software Update .

2 Click Install Alternate Software and OS.

To install only alternate software, click Install Alternate Software.

3 A confirmation page will be displayed.  If reverting to the previous version does require a 
reset to factory defaults, the page will include a warning about the information that will be 
erased by reverting.  Click Yes to install the previously installed version.

An informational window opens stating that an alternate version is installing and the 
system is rebooting.
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Using the Reports Scheduler

You can schedule a time for the appliance to send daily reports that summarize the health of a 
unit and its recording processes along with BGP and IGP activity using the Reports Scheduler 
page. The reports arrive via email. To access the Reports Scheduler, choose Administration > 
Reports Scheduler. The page appears as shown in Figure 53.

Routing Reports are configured and generated only on appliances that record 
routing data, or on the master unit of a distributed configuration. You can 
configure and generate health reports on all Route Explorer/Traffic Explorer 
appliances.
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Figure 53 Report Scheduler Page 
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Configuring the Mail System

Before you can schedule daily reports on a Route Recorder, you must specify the mail system 
information used to deliver the reports.

You can also enable health reports and routing reports. Health reports provide status of 
processes of each machine running on a network (for example, this report will show recording 
processes and status of databases that are active). Routing reports will show IGP and BGP 
reports for databases that are recording. The BGP routing report also displays the date and 
time the report was generated.

To configure the mail system, perform the following steps:

1 Choose Administration > Reports Scheduler.

2 Enter the outbound mail server or relay in the Mail Server box using a DNS name or an IP 
address. If you do not specify a mail server, the system attempts to send directly to the mail 
servers of the recipients.

3 In the Sender text box, enter the full e-mail address to be shown as the sender of mail. 
Bounced e-mail messages may be sent to this address, so this address should be valid. If 
the hostname and domain name are omitted, or just the domain name is omitted, the 
corresponding names configured on the Network & Interface Configuration page will be 
appended.

4 Click Update Main Configuration to save the pre-entered settings.

5 Enter the recipient e-mail address or addresses in the Recipients box. If you have more 
than one recipient, separate each recipient address with a comma.

6 Click Update Mail Configuration.

To send a test message, enter an email address in the Test Message 
Recipient(s) field and click Send Test Message to send a test message to the 
recipient.

Setting Up and Scheduling Daily Reports

To schedule daily reports, perform the following steps:

1 Choose Administration > Reports Scheduler.
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2 Select the time to generate and send reports from the Report generation begins at 
drop-down list.

3 Enter a list of recipients to receive the daily reports. If you have more than one recipient, 
separate each recipient address with a comma.

4 To generate health reports, select Generate Daily Health Report, and to include the 
reports in the daily email, click Email Daily Health Report.

5 To generate routing reports, select Generate Daily Routing Report, and to include the 
reports in the daily email, click Email Daily Routing Report.

6 By default, the system generates a single report that covers all protocol domains. To 
generate a separate routing report for each domain, select Domain Level Reports.

7 Click Update Daily Reports Configuration.

Understanding Daily Report Contents

The Health Report summarizes appliance health status and includes the following 
information:

• Unit Status—Lists all configured recording processes (BGP Recorder, EIGRP Recorder, 
ISIS Recorder, OSPF Recorder, Flow Collector, Traffic Report Server, and Flow Analyzers) 
with the status of the processes and the databases they are recording. Also lists the status 
of database replication, SQL, RAID, and NTP, where applicable.

• Networks Monitored—Lists all databases on the appliance and their current status: 
online, offline, or offline in the last 24 hours.

• License Information—Lists the status of all licenses on the appliance.

The Routing Report summarizes network activity, and includes the following information:

• IGP Summary—If IGP is recorded, this section lists the following results in all online 
networks:

— Counts of the number of routers, adjacencies, and prefixes

— Top 5 flapping links

— Top 5 flapping prefixes

— Top 5 active routers

• BGP Summary—If BGP data is recorded, this section lists the following results in all 
online databases:

— Top 5 BGP route flaps
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— Top 5 prefix redundancy divergence

— Top 5 AS reachability divergence

In master units, the Health Reports and Routing Report are a combination of the reports 
generated by the client units.

For Health Reports, the master unit report replicates the individual reports for itself and all of 
its clients as generated on the client appliances. Significant problems are summarized at the 
top of the report.

For Routing Reports, if the centralized report server is not enabled, the master unit report will 
replicate the individual reports for all client units that record routing data. If the centralized 
report server is enabled, the master unit report will contain one report that consolidates all of 
the online routing data from all of the client appliances. 

Scheduling Top N Reports

Use Reports Scheduler page to run Top N reports automatically and deliver the reports at 
pre-configured time periods. You can select from a set of pre-defined reports, specify time 
ranges and frequency, and arrange for email delivery.

The following guidelines apply when configuring Top N Reports: 

• We recommend that you configure Top N Reports on the Modeling Engine; however, you 
can configure Top N Reports on the Flow Analyzer.

• You must configure the sender address (and optionally the mail server) on the Mail page in 
addition to configuring the Top N Reports page. See “Using the Reports Scheduler” on 
page 4-186.

• If no recipient list is configured on the Top N Reports page, the recipient list from the Mail 
page is used.

• Top N Reports emails are sent from the Flow Analyzer, so communication from that 
appliance to the mail server or directly to the recipients must not be blocked. If it is 
necessary for that appliance to use a different mail server than the Modeling Engine, you 
can configure the mail server on the Mail page of the Flow Analyzer appliance.

To configure Top N Reports, perform the following steps:

1 Choose Administration > Reports Scheduler.

Scroll down to the Top N Reports area, as shown in Figure 53.

2 Enter the email addresses of those needing these reports in the Top N Recipient(s) text box. 
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If you have more than one email to enter, separate the email addresses with 
a comma.

Report names will display beneath the Report Name column in the Report Configuration 
Parameters section of the window.

3 In the Report Type column, select the frequency of reports. The options you can choose from 
are none, daily, weekly, and monthly.

4 In the Number of Elements field, select a maximum of rows you want returned in the 
report. In the figure shown above, BGP Destination AS report will display 100 AS’s that 
are established.

5 To email the selected reports, select the Email Top N Report checkbox.

6 After entering the report name, type, and number of elements, click Update Top N 
Reports Configuration to activate Top N Report generation.

Viewing Saved Daily Reports

The last 30 days of reports are saved on each appliance that records routing data, so that you 
can compare changes to an earlier report.

To view saved daily reports, perform the following steps:

1 Choose Reports Portal.

2 Click on a report file name to download or view that report.

3 If you click Daily Reports on a system that does not have the Route Analyzer Reports 
license, a message is displayed advising you to access a system that records routing data.

Viewing Previously-Generated Top N Reports 

Top N reports are automatically saved for 30 days. 

To view previously-saved Top N Reports, perform the following steps:

1 Choose Reports Portal.

2 Click Saved Top N Reports on the left navigation menu to list all of the saved reports.

3 Click a report link to view the report, or right-click the report link to save the report.
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Managing Exported Reports

You can view a list of reports that were previously exported from tables in the client 
application, select multiple reports to send in a single email, and delete previously exported 
reports. This functionality is also available in the client application.

Files that were emailed but not saved are not listed in the Manage Exported 
Reports window.

To manage previously exported reports, perform the following steps

1 Choose Reports Portal > Exported Reports.

Figure 54 Managing Exported Reports
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2 To email selected files:

a Select the check boxes for the files, and click Email to open the email dialog box.

b Specify From, To, Subject, and Message. The Message area is pre-populated with the 
file names of all selected files.

c Click Send to send the files. Each is sent as a zip file.

3 To delete previously saved files, select the files and click Delete.

4 To view the contents of a file, double-click the file name.

5 To rename a file, click the file entry once to select it. Then click the entry one more time, to 
make it editable.  Do not double click.

Configuring the FTP Server

A portion of the hard disk on the appliance is available for the storage of users’ files in the FTP 
server directory. Upload time series files and Multi Router Traffic Grapher (MRTG) files onto 
the appliance using FTP for correlation with routing events (see “The History Navigator” 
chapter in the HP Route Analytics Management System User’s Guide for information about 
correlating time series data). Backed-up database files are also stored on the appliance.

SFTP may be used as an alternative to FTP. Use of SFTP does not require 
enabling the FTP server because it is carried inside the SSH protocol that is 
always enabled for GUI access.

The account name used in this procedure must be configured to enable FTP access. This can be 
done in one of the following ways:

• If the appliance is configured for local authentication, be sure to enable the FTP check box 
while setting up user accounts (see Creating New User Accounts on page 139). 

• If the appliance is configured for remote authentication, use the rex-ftp parameter for 
remote TACACS+ or RADIUS authentication (see TACACS+ and RADIUS Parameters on 
page 135).

To access the FTP Server Configuration page, choose Administration > FTP Server. 

The FTP Server Configuration window opens, as shown in Figure 55.
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Figure 55 FTP Server Configuration Page

To enable FTP file uploads, perform the following steps:

1 On the FTP Server Configuration page, check the Enable FTP Server check box.

2 Click Update to complete configuration.

After the FTP is enabled, you can log in for FTP file transfer.

Configuring Flow Fanout

Flow fanout redistributes NetFlow packets that are received on a selected physical interface 
and port to specified destinations identified by IP address and port.

To enable flow fanout, perform the following steps:

1 Choose Administration > Flow Fanout.

The Flow Fanout Configuration window opens, as shown in Figure 56.
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Figure 56 Flow Fanout Configuration Page

2 Select the physical interface from the Physical Interface drop-down list.

3 Enter the port to receive the NetFlow data.

4 Enter the IP addresses and port numbers of all the destinations to receive the NetFlow 
packets that are received on the specified interface.

5 Click Save Configuration to store the changes.

6 To begin redistributing the NetFlow packets, click Start Flow Fanout.
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Viewing and Exporting Log Pages

You can view and export log files to help diagnose problems on a particular appliance. Choose 
Administration > View Log to open the View Log page (Figure 57).

To view a log page, perform the following steps:

1 In the Remote Syslog Collector field, enter the name or IP address of the system you want 
to view messages for.

2 Press the Set Collector button to display messages stored on the system.

3 Specify which component logs to view or choose All from the Component drop-down list.

The number of pages in the log displays automatically.

4 From the Lines drop-down list, select the number of lines to display per page.

5 (Optional) Enter the page number to view in the Page text box. If you leave the text box 
empty, page 1 displays by default.

Figure 57 View Log Page
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6 Select the Show Most Recent First check box to see the last recorded log entries.

7 Click Apply Filter.

You can print a copy of this page using the print command on the web browser.

If no relevant records are found, the message “No Recent Applicable Messages” 
will display.

To export the log as plain text, perform the following steps:

1 Choose which section of the log to export by following the previous set of steps in 
this section.

2 Click Export Log as Plain Text.

The log page is redisplayed in plain text form in the browser window.

3 Use the File menu on your browser or right-click in the window to open the pop-up menu. 

4 Choose Save As.

5 Enter the directory where the log file will be stored, and then click Save.

6 Click the Back button on your browser to return to the View Log page.

Uploading Layout Backgrounds

Layout backgrounds are images that you can apply to the routing topology map to provide 
additional visual cues to the layout. For example, you can upload a map depicting the 
geographic location of network routers, which would enable you to arrange nodes based on 
physical or logical groupings, such as per building or per lab.

Create or convert a desired background image using JPEG, PNG, BMP, SVG, or XPM (X 
PixMap, an ASCII image format used by the X Window System). Adobe Illustrator, Corel Draw, 
OpenOffice Draw, and a number of other graphics tools support SVG images. Import the image 
using the Layout Backgrounds page. The image files are stored in a database and are accessible 
from any appliance on the network.

To import an image, perform the following steps:

1 Choose Application > Layout Backgrounds.
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2 Click Browse to locate the image file to upload. Be sure the appropriate file extension is 
included in the file name.
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3 Click Upload.

Binary images should not exceed 12 MB in size, and other images should not 
exceed 16 MB.

The uploaded file, as well as any other layout background files that have been uploaded, 
appears in the Image Name column, along with the type of image file. You can preview 
the image by clicking View.

4 To delete any of the uploaded background image files, check the corresponding check box, 
and then click Delete.

If a background image is in use, a green star appears in the Delete column; the image 
cannot be deleted until it is removed from all routing topology map layouts.

5 To apply or remove a background image to or from the routing topology map layout, see 
“The Routing Topology Map” chapter in the HP Route Analytics Management System User’s 
Guide.

Using Diagnostic Functions

The system supports the diagnostic functions ping and traceroute. Use these functions to 
investigate network failures or outages. 

Pinging a Network Device

Use ping to determine if a destination host is reachable on the network.

To ping another network device, perform the following steps:

1 Choose Administration > System Diagnostics. 

2 Enter the IP address or DNS name of the destination device.

3 Click Ping.

The System Diagnostics page displays the results of the ping function.
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Running a Traceroute

Use traceroute to trace the path a packet takes through the network from the appliance to the 
destination you specify.

To run the traceroute function, perform the following steps:

1 Choose Administration > System Diagnostics. 

2 Enter the IP address or DNS name of the destination device.

3 Click Traceroute.

The System Diagnostics page displays the results of the traceroute function.
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Shutting Down

The system can be shut down at any time. The system shutdown options are displayed on the 
Shutdown page (Figure 58).

To access the Shutdown page, choose Administration > Shutdown.

The following options are available on the Shutdown page:

• Reboot this system—Click this button, and then click Yes to reboot the system. The VNC 
server and data recording are stopped, and the operating system and recording software 
are reloaded from the disk. The VNC server and recorders are automatically restarted 
using the previous system settings. The message “Please wait for the system to reboot then 
click on Home” should appear. If this message does not appear, wait three minutes, and 
then click Home. Log in to the Administration pages and verify that the VNC server and 
recorders are operating correctly.

Figure 58 Shutdown Page

• Shutdown and power off—Click this button to shutdown the system and power off. A 
confirmation page appears. Click Yes to shutdown the system. The VNC server and data 
recording are stopped. To restart, press the power switch on the appliance.
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• Reset to factory defaults and reboot—Click this button to restore the factory default 
settings and reboot the appliance. A confirmation page appears. Click Yes to reset the 
factory default settings and reboot the system. When the system reboots, use the serial 
console interface to reconfigure the network address and then connect to the Home page, 
and log-in as administrator. Restore the system configuration from a back-up file, or 
re-configure manually following the sequence of steps in Applying License Keys on page 50. 
If recording is enabled, verify on the Recorder Configuration page that Hellos and Events 
are being received from the monitored areas or levels.

If the factory settings are restored, the following information is lost:

— All configuration information, including Network, Route Recorder, user names and 
passwords.

— Data files, including databases, user time-series data files, and log files.

The current and alternate versions of the software and the installed licenses remain on the 
appliance.

• Reset to factory defaults and power off—Click this button to restore the factory 
default settings and power off the appliance. A confirmation page appears. Click Yes to 
reset the factory default settings and power off the system.
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A Hardware Specifications
The tables in this appendix contain hardware specifications for the Series 2000, 
3000, and the 4000. The following products run on these devices:

• Route Explorer

• Route Recorder

• Flow Recorder (Traffic Explorer only)

• Flow Analyzer (Traffic Explorer only)

• Modeling Engine (Route Explorer or Traffic Explorer)
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Table 1 Hardware and Network Specifications

Specification 2000 Series 3000 Series 4000 Series 

System 2600: Intel 2.4 GHz, 
Dual-Core, Core 2 Duo, 
8GB RAM

2700: Intel Xeon X3430, 
2.4 GHz, 4 cores, 8GB 
RAM

3510: 2 x Intel 5450 3 
GHz Quad-Core Xeon, 16 
GB RAM

3600: Intel Xeon Quad 
X5560, 2.8 GHz, 2 
processors, 8 total cores, 
16 GB RAM

 2 x Intel 5450 3 G
Quad-Core Xeon, 
2 processors, 8 tot
16 GB RAM

Storage 2600: RAID 0, total 500 
GB storage

2700: RAID 1, total 1 TB 
storage

3510: RAID 10, total 1 TB 
storage

3600: RAID 10, total 2 TB 
storage

RAID 10, total 2 T
storage

Power 2600: Single 260 W (887 
BTU/hour) power supply, 
100-240V, 50-60Hz, 
4.2-1.8A

2700: Single 350 W (1194 
BTU/hour) power supply, 
100-240V, 50-60Hz, 
4.2-1.8A

3510: Dual 700 W (2388 
BTU/hour) redundant, 
hot swappable power 
supply,
100-240V, 60-50Hz, 8-4A

3600: Dual 650 W (2218 
BTU/hour) redundant, 
hot swappable power 
supply, 100-240V, 
60-50Hz, 8-4A

Dual 700 W (2388
hour) redundant, 
swappable power 
100-240V, 60-50H

Standard Network 
Ports

10/100/1000 Base-T

2600: 2 ports

2700: 4 ports

2 10/100/1000 Base-T 4 10/100/1000 Bas
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Optional Network 
Cards

•1 or 2 port 1000 Base-SX 
short-haul fiber

•1 or 2 port 1000 Base-LX 
long-haul fiber

•1 or 2 port 1000 Base-SX 
short-haul fiber

•1 or 2 port 1000 Base-LX 
long-haul fiber

•1 or 2 port 1000 B
short-haul fib

•1 or 2 port 1000 B
long-haul fibe

Optional Memory 
Upgrade

2600: Expandable to 8 GB 

2700: Expandable to 32 
GB 

3510: Expandable to 16 
GB 

3600: Expandable to 96 
GB 

Expandable to 64

Administration DB-9 pin-male (DTE) 
serial port for on-site 
administration

DB-9 pin-male (DTE) 
serial port for on-site 
administration

DB-9 pin-male (D
serial port for on-
administration

Additional 
Accessible Ports

USB 2.0 for flash disk 
updates

USB 2.0 for flash disk 
updates

USB 2.0 for flash 
updates

Table 1 Hardware and Network Specifications (cont’d)

Specification 2000 Series 3000 Series 4000 Series  (con

Table 2 Mechanical Specifications

Specification 2000 Series 3000 Series 4000 Series

Size 2600: 1.7 inches high 
16.7 inches wide
14 inches deep

2700: 1.7 inches high 
16.8 inches wide
14 inches deep

3510: 1.7 inches high
17.2 inches wide
27 inches deep

3600: 1.7 inches high
17.2 inches wide
25.6 inches deep

3.5 inches high
17.2 inches wide
25.5 inches deep

Weight 13.2 lbs 3510: 45 lbs

3600: 42 lbs

55 lbs

Rack Dimension 1U, 19 inch, EIA 
compliant rack space

1U, 19 inch, EIA 
compliant rack space

2U, 19 inch, EIA 
complaint rack space
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, 
Environmental Specifications

Table 3 Environmental Specifications

Specification 2000 Series 3000 Series 4000 Series

Operating 
Temperature

2600: 5° to 30° C

2700: 10° to 35° C

3510: 5° to 30° C

3600: 10° to 35° C

10° to 35° C

Operating Humidity 2600: 10% to 95% at 30° 
C, non-condensing

2700: 8% to 90% at 30° 
C, non-condensing

3510: 10% to 95% at 30° 
C, non-condensing

3600: 8% to 90% at 30° 
C, non-condensing

8% to 90% at 30° C
non-condensing

Storage 
Temperature

2600: -25° to 70° C

2700: -40° to 70° C

3510: -25° to 70° C

3600: -40° to 70° C

-40° to 70° C

Storage Humidity 2600: 10% to 95%, 
non-condensing

2700: 5% to 95%, 
non-condensing

3510: 10% to 95%, 
non-condensing

3600: 5% to 95%, 
non-condensing

8% to 90%, 
non-condensing
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Table 4 Regulatory Compliance

Compliance 
Area 2600 Series 3510 Series 4000 Series

Safety •USA—UL 60950 
Compliant

•Canada—CSA 60950 
Compliant

•Europe—CE Mark EN 
60950 Compliant

•USA—UL 60950 
Compliant

•Canada—CSA 60950 
Compliant

•Europe—CE Mark EN 
60950 Compliant

•USA—UL 60950 
Compliant

•Canada—CSA 6095
Compliant

•Europe—CE Mark 
60950 Complian

Emissions •USA—FCC Class A, Part 
15

•Canada—ICES-003, 
Class A

•Europe—EN55022, 
EN55024, 
EN6100-3-2, 
EN6100-3-3

•Japan—VCCI, Class A

•Australia/NZ—
CISPR22, Class A

•USA—FCC Class A, Part 
15

•Canada—ICES-003, 
Class A

•Europe—EN55022, 
EN55024, 
EN6100-3-2, 
EN6100-3-3

•Japan—VCCI, Class A

•Australia/NZ—
CISPR22, Class A

•USA—FCC Class A
15

•Canada—ICES-003
Class A

•Europe—EN55022,
EN55024, 
EN6100-3-2, 
EN6100-3-3

•Japan—VCCI, Clas

•Australia/NZ—
CISPR22, Class 
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B Information Collected from Routers
The Collector process gathers additional information, such as interface 
parameters, that is obtained from the routers through recording of BGP, IS-IS, 
and OSPF protocols. This information is gathered using SNMP to query the 
necessary MIBs or by connecting to each router with Telnet or SSH to issue CLI 
commands and parse the output. The choice of method is determined by the 
Collector configuration and by the information that is available for routers 
from each supported vendor (see Table 5 ). When both SNMP and CLI methods 
are available, CLI is preferred because it provides more complete information 
while imposing a lighter load on the router.
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In addition to interface parameters, the Collector can gather static routes.  If 
the access method is SNMP, gathering of static routes is enabled by a separate 
configuration parameter because the Collector must query the entire routing 
table to extract the static routes. This may impose too heavy a load on a router 
that holds the full Internet BGP routing table.  If the access method is CLI, 
then static routes are always collected. This process imposes little load because 
only the static routes are queried and not the whole routing table.

For instructions on configuring the Collector, refer to Configuring the Route 
Recorder for the Collector on page 95. For EIGRP networks, a separate 
recorder process collects the same interface parameters and static route 

Table 5 Methods of Gathering Information from Routers

Router 
Type

Method of Access 
for Base 
Information 

Method of Access for  
Collecting VRF 
Information from PE 
Routers

Method of 
Access for 
RSVP-TE

Juniper 
JUNOS

netconf
or
junoscript
or
SNMP (if netconf and 
junoscript are not 
available)

netconf
or
junoscript 

netconf
or
junoscript 

Juniper 
JunosE

Telnet
and
SNMP 

Telnet
and
SNMP

Not supported

Cisco IOS SSH/Telnet
or 
SNMP

SSH/Telnet SSH/Telnet

Cisco IOS-XR SSH/Telnet
or 
SNMP

Not supported SSH/Telnet

Alcatel SNMP SNMP SNMP
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information using Telnet or SSH as part of discovering the EIGRP topology. 
SNMP is not used. As for the Collector, the EIGRP recorder does not query the 
whole routing table nor the whole IP EIGRP topology table.

 This appendix lists the SNMP MIB tables that are queried by the Collector, the 
router CLI commands that are issued by the Collector and the EIGRP recorder, 
and syslog messages:

• SNMP MIBs Common to All Vendors on page 211

• Juniper SNMP MIBs on page 214

• Alcatel SNMP MIBs on page 214

• SNMP Traps on page 235

• Cisco IOS CLI Commands on page 236

• Cisco IOS-XR CLI Commands on page 238

• JunosE CLI Commands on page 238

• Junos CLI Commands on page 239

• JunosE Commands for RSVP-TE on page 245

• Junos Commands for RSVP-TE on page 246

• EIGRP Recorder Cisco IOS CLI Commands on page 248

• Syslog Messages on page 249

The show snmp mib ifmib ifindex CLI command used by both the Collector 
and the EIGRP recorder normally requires enabled privilege level even though 
it is not potentially harmful.  You can allow that command to be used by a 
non-enabled account by including the following line in the router configuration:
    privilege exec level 1 show snmp mib ifmib ifindex

SNMP MIBs Common to All Vendors

IpAddressTable_OidList

"Snmpv2-SMI::mib-2.ip.ipAddrTable.ipAdEntAddr"= { 
1.3.6.1.2.1.4.20.1.1}
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"Snmpv2-SMI::mib-2.ip.ipAddrTable.ipAdEntIfIndex"= { 
1.3.6.1.2.1.4.20.1.2}
"Snmpv2-SMI::mib-2.ip.ipAddrTable.ipAOBdEntNetMask"= { 
1.3.6.1.2.1.4.20.1.3}

InterfaceTable_OidList

"IF-MIB::ifDescr"= { 1.3.6.1.2.1.2.2.1.2}
"IF-MIB::ifType"= { 1.3.6.1.2.1.2.2.1.3}
"IF-MIB::ifMtu"= { 1.3.6.1.2.1.2.2.1.4}
"IF-MIB::ifSpeed"= { 1.3.6.1.2.1.2.2.1.5}
"IF-MIB::ifPhysAddress"= { 1.3.6.1.2.1.2.2.1.6}
"IF-MIB::ifAdminStatus"= { 1.3.6.1.2.1.2.2.1.7}
"IF-MIB::ifOperStatus"= { 1.3.6.1.2.1.2.2.1.8}

InterfaceIndex_OidList

"IF-MIB::ifDescr"= { 1.3.6.1.2.1.2.2.1.2}

IfXTable_OidList

"IF-MIB::ifName"= { 1.3.6.1.2.1.31.1.1.1.1}
"IF-MIB::ifHighSpeed"= { 1.3.6.1.2.1.31.1.1.1.15},

SysInfo_OidList

"Snmpv2-MIB::sysname"= {1.3.6.1.2.1.1.5.0}
"Snmpv2-MIB::sysDescr"= {1.3.6.1.2.1.1.1.0}
"Snmpv2-MIB::sysObjectID"= {1.3.6.1.2.1.1.2.0}

IpRouteTable_OidList (only if collecting static routes)

"RFC1213-MIB::ipRouteDest"= { 1.3.6.1.2.1.4.21.1.1}
"RFC1213-MIB::ipRouteMask"= { 1.3.6.1.2.1.4.21.1.11}
"RFC1213-MIB::ipRouteNextHop"= { 1.3.6.1.2.1.4.21.1.7}
"RFC1213-MIB::ipRouteType"= { 1.3.6.1.2.1.4.21.1.8}
"RFC1213-MIB::ipRouteProto"= { 1.3.6.1.2.1.4.21.1.9}
"RFC1213-MIB::ipRouteIfIndex"= { 1.3.6.1.2.1.4.21.1.2}
"RFC1213-MIB::ipRouteMetric1"= { 1.3.6.1.2.1.4.21.1.3}
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IpForwardTable_OidList (only if collecting static routes)

"ipForwardDest"= { 1.3.6.1.2.1.4.24.2.1.1}
"ipForwardMask"= { 1.3.6.1.2.1.4.24.2.1.2}
"ipForwardNextHop"= { 1.3.6.1.2.1.4.24.2.1.4}
"ipForwardType"= { 1.3.6.1.2.1.4.24.2.1.6}
"ipForwardProto"= { 1.3.6.1.2.1.4.24.2.1.7}
"ipForwardIfIndex"= { 1.3.6.1.2.1.4.24.2.1.5}
"ipForwardMetric1"= { 1.3.6.1.2.1.4.24.2.1.11}

IpCidrRouteTable_OidList (only if collecting static routes)

"ipCidrRouteDest"= { 1.3.6.1.2.1.4.24.4.1.1}
"ipCidrRouteMask"= { 1.3.6.1.2.1.4.24.4.1.2}
"ipCidrRouteNextHop"= { 1.3.6.1.2.1.4.24.4.1.4}
"ipCidrRouteType"= { 1.3.6.1.2.1.4.24.4.1.6}
"ipCidrRouteProto"= { 1.3.6.1.2.1.4.24.4.1.7}
"ipCidrRouteIfIndex"= { 1.3.6.1.2.1.4.24.4.1.5}
"ipCidrRouteMetric1"= { 1.3.6.1.2.1.4.24.4.1.11}

InetCidrRouteTable_OidList (only if collecting static routes)

"inetCidrRouteType"= { 1.3.6.1.2.1.4.24.7.1.8 }
"inetCidrRouteProto"= { 1.3.6.1.2.1.4.24.7.1.9 }
"inetCidrRouteIfIndex"= { 1.3.6.1.2.1.4.24.7.1.7 }
"inetCidrRouteMetric1"= { 1.3.6.1.2.1.4.24.7.1.12 }

EntityMIBInfo_OidList

"physicalClass_"= {1.3.6.1.2.1.47.1.1.1.1.5}
"physicalSoftwareRev_"= {1.3.6.1.2.1.47.1.1.1.1.10}
"physicalSerialNum_"= {1.3.6.1.2.1.47.1.1.1.1.11}
"physicalMfgName_"= {1.3.6.1.2.1.47.1.1.1.1.12}
"physicalModelName_"= {1.3.6.1.2.1.47.1.1.1.1.13}
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Juniper SNMP MIBs

JuniIpIfTable_OidList

"juniIpIfRowStatus_"= {1.3.6.1.4.1.4874.2.2.12.1.1.2.1.2}
"juniIpIfLowerIfIndex_"= {1.3.6.1.4.1.4874.2.2.12.1.1.2.1.3}
"juniIpIfType_"= {1.3.6.1.4.1.4874.2.2.12.1.1.2.1.4}

Alcatel SNMP MIBs

AlcatelLwVrtrConfTableInfoUnit_OidList

"vRtrRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.2 }
"vRtrName"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.4 }
"vRtrType"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.28 }

AlcatelVrtrConfTableInfoUnit_OidList

"vRtrRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.2 }
"vRtrAdminState"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.3 }
"vRtrName"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.4 }
"vRtrType"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.28 }
"vRtrDescription"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.25 }
"vRtrRouteDistinguisher"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.19 }
"vRtrVpnId"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.23 }
"vRtrVrfTarget"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.33 }
"vRtrVrfExportTarget"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.34 }
"vRtrVrfImportTarget"= { 1.3.6.1.4.1.6527.3.1.2.3.1.1.35 }
"vRtrImportPolicy1"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.1 }
"vRtrImportPolicy2"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.2 }
"vRtrImportPolicy3"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.3 }
"vRtrImportPolicy4"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.4 }
"vRtrImportPolicy5"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.5 }
"vRtrExportPolicy1"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.6 }
"vRtrExportPolicy2"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.7 }
"vRtrExportPolicy3"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.8 }
"vRtrExportPolicy4"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.9 }
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"vRtrExportPolicy5"= { 1.3.6.1.4.1.6527.3.1.2.3.16.1.10 }

AlcatelGlobalIfIndex_OidList

"vRtrIfRowStatus"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.2}
"vRtrIfGlobalIndex"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.63}

AlcatelLwVrtrIntf_OidList

"vRtrIfRowStatus"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.2}
"vRtrIfName"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.4}
"vRtrIfPortId"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.5}
"vRtrIfEncapValue"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.7}
"vRtrIfAdminState"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.8}
"vRtrIfQosPolicyId"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.26}
"vRtrIfServiceId"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.37}
"vRtrIfGlobalIndex"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.63}

AlcatelVrtrIfTableInfoUnit_OidList

"vRtrIfRowStatus"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.2}
"vRtrIfType"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.3}
"vRtrIfName"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.4}
"vRtrIfPortId"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.5}
"vRtrIfEncapValue"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.7}
"vRtrIfAdminState"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.8}
"vRtrIfOperState"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.9}
"vRtrIfPhysicalAddress"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.11}
"vRtrIfMtu"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.25}
"vRtrIfQosPolicyId"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.26}
"vRtrIfDescription"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.34}
"vRtrIfServiceId"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.37}
"vRtrIfGlobalIndex"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.63}
"vRtrIfDelaySeconds"= {1.3.6.1.4.1.6527.3.1.2.3.4.1.64}

AlcatelVrtrIpAddrTableInfoUnit_OidList

"vRiaRowStatus"= {1.3.6.1.4.1.6527.3.1.2.3.6.1.2}
"vRiaIpAddress"= {1.3.6.1.4.1.6527.3.1.2.3.6.1.3}
"vRiaNetMask"= {1.3.6.1.4.1.6527.3.1.2.3.6.1.4}
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AlcatelVrtrStaticRouteTableInfoUnit_OidList

"vRtrStaticRouteDest"= {1.3.6.1.4.1.6527.3.1.2.3.9.1.1}
"vRtrStaticRouteMask"= {1.3.6.1.4.1.6527.3.1.2.3.9.1.2}
"vRtrStaticRouteRowStatus"= {1.3.6.1.4.1.6527.3.1.2.3.9.1.4}
"vRtrStaticRouteStaticType"= {1.3.6.1.4.1.6527.3.1.2.3.9.1.7}
"vRtrStaticRouteMetric"= {1.3.6.1.4.1.6527.3.1.2.3.9.1.9}
"vRtrStaticRouteNextHop"= {1.3.6.1.4.1.6527.3.1.2.3.9.1.12}

ConsolidationInfo_OidList

"Snmpv2-SMI::mib-2.ip.ipAddrTable.ipAdEntAddr"= { 
1.3.6.1.2.1.4.20.1.1}

AlcatelDscpNameTableInfoUnit_OidList

"tDSCPNameRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.16.1.1.1.2 }
"tDSCPNameStorageType"= { 1.3.6.1.4.1.6527.3.1.2.16.1.1.1.3 }
"tDSCPNameDscpValue"= { 1.3.6.1.4.1.6527.3.1.2.16.1.1.1.4 }
"tDSCPNameLastChanged"= { 1.3.6.1.4.1.6527.3.1.2.16.1.1.1.5 }

AlcatelFCNameTableInfoUnit_OidList

"tFCRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.16.2.1.1.2 }
"tFCStorageType"= { 1.3.6.1.4.1.6527.3.1.2.16.2.1.1.3 }
"tFCValue"= { 1.3.6.1.4.1.6527.3.1.2.16.2.1.1.4 }
"tFCNameLastChanged"= { 1.3.6.1.4.1.6527.3.1.2.16.2.1.1.5 }

AlcatelSapBaseInfoUnit_OidList

"sapRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.3 }
"sapType"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.4 }
"sapDescription"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.5 }
"sapAdminStatus"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.6 }
"sapOperStatus"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.7 }
"sapIngressQosPolicyId"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.8 }
"sapEgressQosPolicyId"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.11 }
"sapIesIfIndex"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.15 }
"sapLastMgmtChange"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.16 }
"sapVpnId"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.19 }
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"sapCustId"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.20 }
"sapOperFlags"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.27 }
"sapLastStatusChange"= { 1.3.6.1.4.1.6527.3.1.2.4.3.2.1.28 }

AlcatelSapIngressInfoUnit_OidList

"tSapIngressRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.16.3.1.1.2 }
"tSapIngressScope"= { 1.3.6.1.4.1.6527.3.1.2.16.3.1.1.3 }
"tSapIngressDescription"= { 1.3.6.1.4.1.6527.3.1.2.16.3.1.1.4 
}
"tSapIngressDefaultFC"= { 1.3.6.1.4.1.6527.3.1.2.16.3.1.1.5 }
"tSapIngressDefaultFCPriority"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.1.1.6 }
"tSapIngressMatchCriteria"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.1.1.7 }
"tSapIngressLastChanged"= { 1.3.6.1.4.1.6527.3.1.2.16.3.1.1.8 
}

AlcatelSapIngressDscpInfoUnit_OidList

"tSapIngressDscpRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.3.1.2 }
"tSapIngressDscpFC"= { 1.3.6.1.4.1.6527.3.1.2.16.3.3.1.3 }
"tSapIngressDscpPriority"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.3.1.4 }
"tSapIngressDscpLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.3.1.5 }

AlcatelSapIngressIPCriteriaInfoUnit_OidList

"tSapIngressIPCriteriaRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.2 }
"tSapIngressIPCriteriaDescription"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.3 }
"tSapIngressIPCriteriaActionFC"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.4 }
"tSapIngressIPCriteriaActionPriority"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.5 }
"tSapIngressIPCriteriaSourceIpAddr"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.6 }
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"tSapIngressIPCriteriaSourceIpMask"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.7 }
"tSapIngressIPCriteriaDestIpAddr"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.8 }
"tSapIngressIPCriteriaDestIpMask"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.9 }
"tSapIngressIPCriteriaProtocol"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.10 }
"tSapIngressIPCriteriaSourcePortValue1"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.11 }
"tSapIngressIPCriteriaSourcePortValue2"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.12 }
"tSapIngressIPCriteriaSourcePortOperator"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.13 }
"tSapIngressIPCriteriaDestPortValue1"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.14 }
"tSapIngressIPCriteriaDestPortValue2"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.15 }
"tSapIngressIPCriteriaDestPortOperator"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.16 }
"tSapIngressIPCriteriaDSCP"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.17 }
"tSapIngressIPCriteriaLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.5.1.19 }

AlcatelSapIngressFCInfoUnit_OidList

"tSapIngressFCRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.16.3.7.1.2 
}
"tSapIngressFCLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.7.1.7 }
"tSapIngressFCInProfRemark"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.7.1.8 }
"tSapIngressFCInProfDscp"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.7.1.9 }
"tSapIngressFCInProfPrec"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.7.1.10 }
"tSapIngressFCOutProfRemark"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.7.1.11 }
"tSapIngressFCOutProfDscp"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.7.1.12 }
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"tSapIngressFCOutProfPrec"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.7.1.13 }
"tSapIngressFCProfile"= { 1.3.6.1.4.1.6527.3.1.2.16.3.7.1.14 
}

AlcatelSapIngressPrecInfoUnit_OidList

"tSapIngressPrecRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.8.1.2 }
"tSapIngressPrecFC"= { 1.3.6.1.4.1.6527.3.1.2.16.3.8.1.3 }
"tSapIngressPrecFCPriority"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.8.1.4 }
"tSapIngressPrecLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.3.8.1.5 }

AlcatelSapEgressInfoUnit_OidList

"tSapEgressRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.16.4.1.1.2 }
"tSapEgressScope"= { 1.3.6.1.4.1.6527.3.1.2.16.4.1.1.3 }
"tSapEgressDescription"= { 1.3.6.1.4.1.6527.3.1.2.16.4.1.1.4 
}
"tSapEgressLastChanged"= { 1.3.6.1.4.1.6527.3.1.2.16.4.1.1.5 
}
"tSapEgressMatchCriteria"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.1.1.7 }

AlcatelSapEgressFCInfoUnit_OidList

"tSapEgressFCRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.16.4.3.1.2 
}
"tSapEgressFCLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.3.1.5 }
"tSapEgressFCInProfDscp"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.3.1.12 }
"tSapEgressFCOutProfDscp"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.3.1.13 }
"tSapEgressFCInProfPrec"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.3.1.14 }
"tSapEgressFCOutProfPrec"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.3.1.15 }
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AlcatelSapEgressDscpInfoUnit_OidList

"tSapEgressDscpRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.5.1.2 }
"tSapEgressDscpLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.5.1.3 }

AlcatelSapEgressPrecInfoUnit_OidList

"tSapEgressPrecRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.6.1.2 }
"tSapEgressPrecLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.6.1.3 }

AlcatelSapEgrIPCritInfoUnit_OidList

"tSapEgrIPCritRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.16.4.7.1.3 
}
"tSapEgrIPCritLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.4 }
"tSapEgrIPCritDescription"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.5 }
"tSapEgrIPCritProtocol"= { 1.3.6.1.4.1.6527.3.1.2.16.4.7.1.13 
}
"tSapEgrIPCritSourcePortValue1"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.14 }
"tSapEgrIPCritSourcePortValue2"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.15 }
"tSapEgrIPCritSourcePortOperator"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.16 }
"tSapEgrIPCritDestPortValue1"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.17 }
"tSapEgrIPCritDestPortValue2"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.18 }
"tSapEgrIPCritDestPortOperator"= { 
1.3.6.1.4.1.6527.3.1.2.16.4.7.1.19 }
"tSapEgrIPCritDSCP"= { 1.3.6.1.4.1.6527.3.1.2.16.4.7.1.20 }
"tSapEgrIPCritFragment"= { 1.3.6.1.4.1.6527.3.1.2.16.4.7.1.21 
}
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AlcatelNetworkPolicyInfoUnit_OidList

"tNetworkPolicyRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.1.1.2 }
"tNetworkPolicyScope"= { 1.3.6.1.4.1.6527.3.1.2.16.5.1.1.5 }
"tNetworkPolicyDescription"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.1.1.6 }
"tNetworkPolicyIngressDefaultActionFC"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.1.1.7 }
"tNetworkPolicyIngressDefaultActionProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.1.1.8 }
"tNetworkPolicyEgressRemark"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.1.1.9 }
"tNetworkPolicyLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.1.1.10 }
"tNetworkPolicyIngressLerUseDscp"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.1.1.11 }

AlcatelNetworkIngressDscpInfoUnit_OidList

"tNetworkIngressDscpRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.2.1.2 }
"tNetworkIngressDscpFC"= { 1.3.6.1.4.1.6527.3.1.2.16.5.2.1.3 
}
"tNetworkIngressDscpProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.2.1.4 }
"tNetworkIngressDscpLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.2.1.5 }

AlcatelNetworkIngressLspExpInfoUnit_OidList

"tNetworkIngressLspExpRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.4.1.2 }
"tNetworkIngressLspExpFC"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.4.1.3 }
"tNetworkIngressLspExpProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.4.1.4 }
"tNetworkIngressLspExpLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.4.1.5 }
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AlcatelNetworkEgressFCInfoUnit_OidList

"tNetworkEgressFCDscpInProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.2 }
"tNetworkEgressFCDscpOutProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.3 }
"tNetworkEgressFCLspExpInProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.4 }
"tNetworkEgressFCLspExpOutProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.5 }
"tNetworkEgressFCDot1pInProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.6 }
"tNetworkEgressFCDot1pOutProfile"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.7 }
"tNetworkEgressFCLastChanged"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.8 }
"tNetworkEgressFCForceDEValue"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.9 }
"tNetworkEgressFCDEMark"= { 
1.3.6.1.4.1.6527.3.1.2.16.5.7.1.10 }

AlcatelRPOperASPathInfoUnit_OidList

"tRPOperASPathRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.2.1.2}
"tRPOperASPathRegEx"= { 1.3.6.1.4.1.6527.3.1.2.17.1.1.2.1.3}

AlcatelRPOperCommunityInfoUnit_OidList

"tRPOperCommunityRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.4.1.3}

AlcatelRPOperPrefixListInfoUnit_OidList

"tRPOperPrefixListRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.8.1.4}
"tRPOperPrefixListThroughLength"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.8.1.6}
"tRPOperPrefixListBeginLength"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.8.1.8}
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AlcatelRPOperPolicyStmt_OidList

"tRPOperPolicyStatementRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.10.1.2}
"tRPOperPolicyStatementDescription"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.10.1.3}
"tRPOperPolicyStatementDefaultAction"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.10.1.4}

AlcatelRPOperPSParams_OidList

"tRPOperPSParamsRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.14.1.2}
"tRPOperPSParamsDescription"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.14.1.3}
"tRPOperPSParamsAction"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.14.1.4}

AlcatelRPOperPSFromCriteria_OidList

"tRPOperPSFromCriteriaRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.2}
"tRPOperPSFromCriteriaProtocol"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.3}
"tRPOperPSFromCriteriaNeighborIpAddr"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.4}
"tRPOperPSFromCriteriaNeighborPrefixList"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.5}
"tRPOperPSFromCriteriaPrefixList1"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.6}
"tRPOperPSFromCriteriaPrefixList2"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.7}
"tRPOperPSFromCriteriaPrefixList3"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.8}
"tRPOperPSFromCriteriaPrefixList4"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.9}
"tRPOperPSFromCriteriaPrefixList5"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.10}
"tRPOperPSFromCriteriaASPath"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.11}
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"tRPOperPSFromCriteriaCommunity"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.12}
"tRPOperPSFromCriteriaOrigin"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.13}
"tRPOperPSFromCriteriaTag"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.24}
"tRPOperPSFromCritNbrInetAddrType"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.25}
"tRPOperPSFromCritNbrInetAddr"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.26}
"tRPOperPSFromCriteriaFamily"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.29}
"tRPOperPSFromCriteriaInstanceId"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.20.1.30}

AlcateltRPOperPSToCriteriaTableInfoUnit_OidList

"tRPOperPSToCriteriaRowStatus"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.2 }
"tRPOperPSToCriteriaProtocol"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.3 }
"tRPOperPSToCriteriaNeighborIpAddr"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.4 }
"tRPOperPSToCriteriaNeighborPrefixList"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.5 }
"tRPOperPSToCriteriaPrefixList1"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.8 }
"tRPOperPSToCriteriaPrefixList2"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.9 }
"tRPOperPSToCriteriaPrefixList3"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.10 }
"tRPOperPSToCriteriaPrefixList4"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.11 }
"tRPOperPSToCriteriaPrefixList5"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.12 }
"tRPOperPSToCritNbrInetAddrType"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.13 }
"tRPOperPSToCritNbrInetAddr"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.14 }
"tRPOperPSToCriteriaInstanceId"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.18.1.15 }
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AlcatelRPOperPSDefaultActionParamsTableInfoUnit_OidList

"tRPOperPSDefaultActionASPath"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.1 }
"tRPOperPSDefaultActionASPathName"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.2 }
"tRPOperPSDefaultActionASPathPrependAS"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.3 }
"tRPOperPSDefaultActionASPathPrependCount"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.4 }
"tRPOperPSDefaultActionCommunity1"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.5 }
"tRPOperPSDefaultActionCommunityName1"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.6 }
"tRPOperPSDefaultActionCommunity2"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.7 }
"tRPOperPSDefaultActionCommunityName2"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.8 }
"tRPOperPSDefaultActionOrigin"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.9 }
"tRPOperPSDefaultActionLocalPreferenceSet"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.10 }
"tRPOperPSDefaultActionLocalPreference"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.11 }
"tRPOperPSDefaultActionMetric"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.12 }
"tRPOperPSDefaultActionMetricValue"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.13 }
"tRPOperPSDefaultActionPreference"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.15 }
"tRPOperPSDefaultActionNextHopSelf"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.17 }
"tRPOperPSDefaultActionNextHop"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.18 }
"tRPOperPSDefaultActionTag"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.19 }
"tRPOperPSDefaultActionOspfType"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.20 }
"tRPOperPSDefActInetNextHopType"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.22 }
"tRPOperPSDefActInetNextHop"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.12.1.23 }
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AlcatelRPOperPSAcceptActionParamsTableInfoUnit_OidList

"tRPOperPSAcceptActionASPath"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.1 }
"tRPOperPSAcceptActionASPathName"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.2 }
"tRPOperPSAcceptActionASPathPrependAS"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.3 }
"tRPOperPSAcceptActionASPathPrependCount"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.4 }
"tRPOperPSAcceptActionCommunity1"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.5 }
"tRPOperPSAcceptActionCommunityName1"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.6 }
"tRPOperPSAcceptActionCommunity2"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.7 }
"tRPOperPSAcceptActionCommunityName2"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.8 }
"tRPOperPSAcceptActionOrigin"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.9 }
"tRPOperPSAcceptActionLocalPreferenceSet"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.10 }
"tRPOperPSAcceptActionLocalPreference"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.11 }
"tRPOperPSAcceptActionMetric"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.12 }
"tRPOperPSAcceptActionMetricValue"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.13 }
"tRPOperPSAcceptActionPreference"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.15 }
"tRPOperPSAcceptActionNextHopSelf"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.17 }
"tRPOperPSAcceptActionNextHop"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.18 }
"tRPOperPSAcceptActionTag"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.19 }
"tRPOperPSAcceptActionOspfType"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.20 }
"tRPOperPSAcptActInetNextHopType"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.22 }
"tRPOperPSAcptActInetNextHop"= { 
1.3.6.1.4.1.6527.3.1.2.17.1.1.16.1.23 }
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AlcatelLspInfoUnit_OidList

"vRtrMplsLspRowStatus_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.2 }
"vRtrMplsLspName_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.4 }
"vRtrMplsLspAdminState_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.5 }
"vRtrMplsLspOperState_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.6 }
"vRtrMplsLspFromAddr_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.7 }
"vRtrMplsLspToAddr_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.8 }
"vRtrMplsLspType"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.9 }
"vRtrMplsLspOutSegIndx_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.10 }
"vRtrMplsLspRetryTimer_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.11 }
"vRtrMplsLspMetric_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.13 }
"vRtrMplsLspCspf_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.15 }
"vRtrMplsLspFastReroute_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.16 
}
"vRtrMplsLspClassOfService_"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.19 }
"vRtrMplsLspSetupPriority_"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.20 }
"vRtrMplsLspHoldPriority_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.21 
}
"vRtrMplsLspRecord_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.22 }
"vRtrMplsLspBandwidth_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.24 }
"vRtrMplsLspBwProtect_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.25 }
"vRtrMplsLspHopLimit_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.26 }
"vRtrMplsLspRsvpResvStyle_"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.28 }
"vRtrMplsLspFRMethod_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.30 }
"vRtrMplsLspFRNodeProtect_"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.31 }
"vRtrMplsLspAdminGroupInclude_"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.32 }
"vRtrMplsLspAdminGroupExclude_"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.33 }
"vRtrMplsLspAdaptive_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.34 }
"vRtrMplsLspCspfTeMetricEnabled_"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.40 }
"vRtrMplsLspp2mpid"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.41 }
"vRtrMplsLspClassType"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.42 }
"vRtrMplsLspOperMetric"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.43 }
"vRtrMplsLspLdpOverRsvpInclude"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.44 }
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"vRtrMplsLspLeastFill"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.45 }
"vRtrMplsLspVprnAutoBindInclude"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.46 }
"vRtrMplsLspIgpShortcut"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.48 }

AlcatelLWLspInfoUnit_OidList

"vRtrMplsLspRowStatus_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.2 }
"vRtrMplsLspName_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.4 }
"vRtrMplsLspAdminState_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.5 }
"vRtrMplsLspOperState_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.6 }
"vRtrMplsLspFromAddr_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.7 }
"vRtrMplsLspToAddr_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.8 }
"vRtrMplsLspMetric_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.13 }
"vRtrMplsLspBandwidth_"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.24 }
"vRtrMplsLspOperMetric"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.43 }
"vRtrMplsLspLdpOverRsvpInclude"= { 
1.3.6.1.4.1.6527.3.1.2.6.1.1.44 }
"vRtrMplsLspIgpShortcut"= { 1.3.6.1.4.1.6527.3.1.2.6.1.1.48 }

AlcatelLspPathInfoUnit_OidList

"vRtrMplsLspPathRowStatus_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.1 
}
"vRtrMplsLspPathType_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.3 }
"vRtrMplsLspPathCos_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.4 }
"vRtrMplsLspPathProperties_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.5 }
"vRtrMplsLspPathBandwidth_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.6 
}
"vRtrMplsLspPathState_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.8 }
"vRtrMplsLspPathPreference_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.9 }
"vRtrMplsLspPathSetupPriority_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.12 }
"vRtrMplsLspPathHoldPriority_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.13 }
"vRtrMplsLspPathRecord_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.14 }
"vRtrMplsLspPathHopLimit_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.15 
}
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"vRtrMplsLspPathAdminState_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.17 }
"vRtrMplsLspPathOperState_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.18 }
"vRtrMplsLspPathLspId_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.20 }
"vRtrMplsLspPathTunnelARHopListIndex_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.22 }
"vRtrMplsLspPathFailCode_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.24 
}
"vRtrMplsLspPathFailNodeAddr_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.25 }
"vRtrMplsLspPathAdminGroupInclude_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.26 }
"vRtrMplsLspPathAdminGroupExclude_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.27 }
"vRtrMplsLspPathAdaptive_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.28 
}
"vRtrMplsLspPathOptimizeTimer_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.29 }
"vRtrMplsLspPathTunnelCRHopListIndex_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.34 }
"vRtrMplsLspPathRecordLabel_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.36 }
"vRtrMplsLspPathSrlg_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.37 }
"vRtrMplsLspPathSrlgDisjoint_"= { 
1.3.6.1.4.1.6527.3.1.2.6.4.1.38 }
"vRtrMplsLspPathMetric_"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.40 }
"vRtrMplsLspPathClassType"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.52 
}
"vRtrMplsLspPathOperCT"= { 1.3.6.1.4.1.6527.3.1.2.6.4.1.58 }

AlcatelLspStatInfoUnit_OidList

"vRtrMplsLspAge_"= { 1.3.6.1.4.1.6527.3.1.2.6.2.1.3 }
"vRtrMplsLspTimeUp_"= { 1.3.6.1.4.1.6527.3.1.2.6.2.1.4 }
"vRtrMplsLspTimeDown"= { 1.3.6.1.4.1.6527.3.1.2.6.2.1.5 }
"vRtrMplsLspTransitions"= { 1.3.6.1.4.1.6527.3.1.2.6.2.1.7 }
"vRtrMplsLspLastTransition"= { 1.3.6.1.4.1.6527.3.1.2.6.2.1.8 
}
"vRtrMplsLspPathChanges"= { 1.3.6.1.4.1.6527.3.1.2.6.2.1.9 }
"vRtrMplsLspLastPathChange_"= { 
1.3.6.1.4.1.6527.3.1.2.6.2.1.10 }
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AlcatelLspPathStatInfoUnit_OidList

"vRtrMplsLspPathTimeUp_"= { 1.3.6.1.4.1.6527.3.1.2.6.5.1.1 }
"vRtrMplsLspPathTimeDown_"= { 1.3.6.1.4.1.6527.3.1.2.6.5.1.2 
}
"vRtrMplsLspPathTransitionCount_"= { 
1.3.6.1.4.1.6527.3.1.2.6.5.1.4 }

AlcatelMplsXCInfoUnit_OidList

"vRtrMplsXCIndex_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.1 }
"vRtrMplsInSegmentIfIndex_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.2 
}
"vRtrMplsInSegmentLabel_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.3 }
"vRtrMplsOutSegmentIndex_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.4 
}
"vRtrMplsERHopTunnelIndex_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.5 
}
"vRtrMplsARHopTunnelIndex_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.6 
}
"vRtrMplsRsvpSessionIndex_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.7 
}
"vRtrMplsXCCHopTableIndex_"= { 1.3.6.1.4.1.6527.3.1.2.6.6.1.9 
}

AlcatelCHopInfoUnit_OidList

"vRtrMplsTunnelCHopAddrType_"= { 
1.3.6.1.4.1.6527.3.1.2.6.12.1.3 }
"vRtrMplsTunnelCHopIpv4Addr_"= { 
1.3.6.1.4.1.6527.3.1.2.6.12.1.4 }
"vRtrMplsTunnelCHopIpv4PrefixLen_"= { 
1.3.6.1.4.1.6527.3.1.2.6.12.1.5 }
"vRtrMplsTunnelCHopAsNumber_"= { 
1.3.6.1.4.1.6527.3.1.2.6.12.1.8 }
"vRtrMplsTunnelCHopLspId_"= { 1.3.6.1.4.1.6527.3.1.2.6.12.1.9 
}
"vRtrMplsTunnelCHopStrictOrLoose_"= { 
1.3.6.1.4.1.6527.3.1.2.6.12.1.10 }
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AlcatelRsvpSessInfoUnit_OidList

"vRtrRsvpSessionState"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.2 }
"vRtrRsvpSessionName_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.3 }
"vRtrRsvpSessionSetupPriority_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.4 }
"vRtrRsvpSessionHoldPriority_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.5 }
"vRtrRsvpSessionFlags_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.6 }
"vRtrRsvpSessionEndpointAddress_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.7 }
"vRtrRsvpSessionLspId_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.8 }
"vRtrRsvpSessionSenderAddress_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.9 }
"vRtrRsvpSessionType"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.10 }
"vRtrRsvpSessionStyle_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.13 }
"vRtrRsvpSessionTunnelId_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.14 
}
"vRtrRsvpSessionExtTunnelId_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.15 }
"vRtrRsvpSessionFailCode_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.21 
}
"vRtrRsvpSessionFailNodeAddr_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.22 }
"vRtrRsvpSessionXCIndex_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.23 
}
"vRtrRsvpSessionBypassIndex_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.24 }
"vRtrRsvpSessionBypassAvoid_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.25 }
"vRtrRsvpSessionBypassActive_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.26 }
"vRtrRsvpSessionBypassDnstrmLabel_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.27 }
"vRtrRsvpSessionP2mpId"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.33 }
"vRtrRsvpSessionClassType"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.34 
}
"vRtrRsvpSessionDetourTimeUp"= { 
1.3.6.1.4.1.6527.3.1.2.7.6.1.5 }
"vRtrRsvpSessionDetourAge"= { 1.3.6.1.4.1.6527.3.1.2.7.6.1.6 
}
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"vRtrRsvpSessionBypassTimeUp"= { 
1.3.6.1.4.1.6527.3.1.2.7.6.1.7 }
"vRtrRsvpSessionBypassAge"= { 1.3.6.1.4.1.6527.3.1.2.7.6.1.8 
}

AlcatelLWRsvpSessInfoUnit_OidList

"vRtrRsvpSessionState"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.2 }
"vRtrRsvpSessionName_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.3 }
"vRtrRsvpSessionEndpointAddress_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.7 }
"vRtrRsvpSessionLspId_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.8 }
"vRtrRsvpSessionSenderAddress_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.9 }
"vRtrRsvpSessionTunnelId_"= { 1.3.6.1.4.1.6527.3.1.2.7.5.1.14 
}
"vRtrRsvpSessionExtTunnelId_"= { 
1.3.6.1.4.1.6527.3.1.2.7.5.1.15 }

AlcatelProtectedRsvpSessInfoUnit_OidList

"vRtrRsvpProtectedSessionName"= { 
1.3.6.1.4.1.6527.3.1.2.7.9.1.3 }

LsrMibXCInfoUnit_OidList

"mplsXCLspId_"= { 1.3.6.1.3.96.1.9.1.2 }
"mplsXCLabelStackIndex_"= { 1.3.6.1.3.96.1.9.1.3 }
"mplsXCRowStatus_"= { 1.3.6.1.3.96.1.9.1.6 }
"mplsXCAdminStatus_"= { 1.3.6.1.3.96.1.9.1.8 }
"mplsXCOperStatus_"= { 1.3.6.1.3.96.1.9.1.9 }

LsrMibOutsegInfoUnit_OidList

"mplsOutSegmentIfIndex_"= { 1.3.6.1.3.96.1.6.1.2 }
"mplsOutSegmentPushTopLabel_"= { 1.3.6.1.3.96.1.6.1.3 }
"mplsOutSegmentTopLabel_"= { 1.3.6.1.3.96.1.6.1.4 }
"mplsOutSegmentNextHopIpAddrType_"= { 1.3.6.1.3.96.1.6.1.5 }
"mplsOutSegmentNextHopIpv4Addr_"= { 1.3.6.1.3.96.1.6.1.6 }
"mplsOutSegmentXCIndex_"= { 1.3.6.1.3.96.1.6.1.8 }
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"mplsOutSegmentRowStatus_"= { 1.3.6.1.3.96.1.6.1.11 }

MplsTunnelInfoUnit_OidList

"mplsTunnelName_"= { 1.3.6.1.3.95.1.2.1.4 }
"mplsTunnelDescr_"= { 1.3.6.1.3.95.1.2.1.5 }
"mplsTunnelHopTableIndex_"= { 1.3.6.1.3.95.1.2.1.17 }
"mplsTunnelRowStatus_"= { 1.3.6.1.3.95.1.2.1.21 }

TunnelHopInfoUnit_OidList

"mplsTunnelHopAddrType_"= { 1.3.6.1.3.95.1.5.1.3 }
"mplsTunnelHopIpv4Addr_"= { 1.3.6.1.3.95.1.5.1.4 }
"mplsTunnelHopIpv4PrefixLen_"= { 1.3.6.1.3.95.1.5.1.5 }
"mplsTunnelHopStrictOrLoose_"= { 1.3.6.1.3.95.1.5.1.10 }
"mplsTunnelHopRowStatus_"= { 1.3.6.1.3.95.1.5.1.11 }

AlcatelARHopInfoUnit_OidList

"mplsAlcatelARHopAddrType_"= { 1.3.6.1.3.95.1.8.1.3 }
"mplsAlcatelARHopIpv4Addr_"= { 1.3.6.1.3.95.1.8.1.4 }
"mplsAlcatelARHopIpv4PrefixLen_"= { 1.3.6.1.3.95.1.8.1.5 }
"mplsAlcatelARHopStrictOrLoose_"= { 1.3.6.1.3.95.1.8.1.9 }
"vRtrMplsAlcatelARHopProtection"= { 
1.3.6.1.4.1.6527.3.1.2.6.11.1.1 }
"vRtrMplsAlcatelARHopRecordLabel"= { 
1.3.6.1.4.1.6527.3.1.2.6.11.1.2 }
"vRtrMplsAlcatelARHopRouterID"= { 
1.3.6.1.4.1.6527.3.1.2.6.11.1.3 }

AlcatelMplsAdminGroupInfoUnit_OidList
"vRtrMplsAdminGroupRowStatus_"= { 
1.3.6.1.4.1.6527.3.1.2.6.13.1.2 }
"vRtrMplsAdminGroupValue_"= { 1.3.6.1.4.1.6527.3.1.2.6.13.1.3 
}
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AlcatelMplsSrlgGroupInfoUnit_OidList

"vRtrMplsSrlgGrpRowStatus"= { 1.3.6.1.4.1.6527.3.1.2.6.21.1.2 
}
"vRtrMplsSrlgGrpValue"= { 1.3.6.1.4.1.6527.3.1.2.6.21.1.4 }

AlcatelMplsGeneralInfoUnit_OidList

"vRtrMplsGeneralAdminState"= { 1.3.6.1.4.1.6527.3.1.2.6.7.1.2 
}
"vRtrMplsGeneralOperState"= { 1.3.6.1.4.1.6527.3.1.2.6.7.1.3 
}
"vRtrMplsGeneralTE"= { 1.3.6.1.4.1.6527.3.1.2.6.7.1.5 }
"vRtrMplsGeneralOptimizeTimer"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.7 }
"vRtrMplsGeneralResignalTimer"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.9 }
"vRtrMplsGeneralDynamicBypass"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.11 }
"vRtrMplsGeneralSrlgFrr"= { 1.3.6.1.4.1.6527.3.1.2.6.7.1.14 }
"vRtrMplsGeneralSrlgFrrStrict"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.15 }
"vRtrMplsGeneralLeastFillMinThd"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.17 }
"vRtrMplsGenLeastFillReoptiThd"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.18 }
"vRtrMplsGeneralUseSrlgDB"= { 1.3.6.1.4.1.6527.3.1.2.6.7.1.19 
}
"vRtrMplsGeneralP2mpResigTimer"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.20 }
"vRtrMplsGeneralAutoBWDefSampMul"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.26 }
"vRtrMplsGeneralAutoBWDefAdjMul"= { 
1.3.6.1.4.1.6527.3.1.2.6.7.1.27 }
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SNMP Traps

Juniper Traps

Standard MIB traps

1.mplsTunnelUp (.1.3.6.1.2.1.10.166.3.0.1)
2.mplsTunnelDown (.1.3.6.1.2.1.10.166.3.0.2)
3.mplsTunnelRerouted (.1.3.6.1.2.1.10.166.3.0.3)
4.mplsTunnelReoptimized (.1.3.6.1.2.1.10.166.3.0.4)

Enterprise MIB traps

1.mplsLspInfoUp (.1.3.6.1.4.1.2636.3.2.0.1)
2.mplsLspInfoDown (.1.3.6.1.4.1.2636.3.2.0.2)
3.mplsLspInfoChange (.1.3.6.1.4.1.2636.3.2.0.3)
4.mplsLspInfoPathDown (.1.3.6.1.4.1.2636.3.2.0.4)
5.mplsLspInfoPathUp (.1.3.6.1.4.1.2636.3.2.0.5)

Cisco IOS Traps

Standard MIB traps

1.mplsTunnelUp (.1.3.6.1.3.95.3.0.1)
2.mplsTunnelDown (.1.3.6.1.3.95.3.0.2)
3.mplsTunnelRerouted (.1.3.6.1.3.95.3.0.3)

Cisco IOS XR

Standard MIB traps

1.mplsTunnelUp (.1.3.6.1.2.1.10.166.3.0.1)
2.mplsTunnelDown (.1.3.6.1.2.1.10.166.3.0.2)
Information Collected from Routers 235



3.mplsTunnelRerouted (.1.3.6.1.2.1.10.166.3.0.3)
4.mplsTunnelReoptimized (.1.3.6.1.2.1.10.166.3.0.4)

Alcatel

Standard MIB traps

1.mplsTunnelUp (.1.3.6.1.3.95.2.0.1)
2.mplsTunnelDown (.1.3.6.1.3.95.2.0.2)
3.mplsTunnelRerouted (.1.3.6.1.3.95.2.0.3)
4.mplsTunnelReoptimized (.1.3.6.1.3.95.2.0.4)

Enterprise MIB traps

1.vRtrMplsLspUp (.1.3.6.1.4.1.6527.3.1.3.6.0.3)
2.vRtrMplsLspDown (.1.3.6.1.4.1.6527.3.1.3.6.0.4)
3.vRtrMplsLspPathUp (.1.3.6.1.4.1.6527.3.1.3.6.0.5)
4.vRtrMplsLspPathDown (.1.3.6.1.4.1.6527.3.1.3.6.0.6)
5.vRtrMplsLspPathRerouted (.1.3.6.1.4.1.6527.3.1.3.6.0.7)
6.vRtrMplsLspPathResignaled (.1.3.6.1.4.1.6527.3.1.3.6.0.8)

Cisco IOS CLI Commands

IOS Base Commands

The following commands are used for the Cisco router configuration for the 
Collector.

terminal length 0
terminal width 512
show inventory raw
show version
show ip route static
show ip route 0.0.0.0 255.255.255.255 longer-prefixes 
show ip route connected 
show snmp mib ifmib ifindex
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show interface 
show ip interface 
show ip vrf detail 
show route-map 
show ip access-list 
show ip prefix-list 
show ip extcommunity-list 
show ip community-list 
show ip route vrf <vrf_name> static
show class-map
show policy-map 
show policy-map interface
show table-map 

IOS RSVP-TE commands

     show ip explicit-paths
     show ip rsvp reservation detail
     show ip rsvp reservation
     show ip rsvp sender detail [filter source <rtr-id> 
[destination <rtr-id>] ]
     show isis mpls traffic-eng tunnel
     show mpls forwarding-table
     show mpls traffic-eng autoroute
     show mpls traffic-eng fast-reroute database
     show mpls traffic-eng link-management statistics
     show mpls traffic-eng link-management summary
     show mpls traffic-eng path-option list
     show mpls traffic-eng tunnels backup
     show mpls traffic-eng tunnels protection
     show mpls traffic-eng tunnels role head
     show mpls traffic-eng tunnels summary
     show mpls traffic-eng tunnels
Information Collected from Routers 237



Cisco IOS-XR CLI Commands

IOS-XR Base commands

     terminal length 0
     terminal width 512

     show interface
     show inventory raw
     show ip interface
     show ip route connected
     show ip route static
     show snmp interface
     show version

IOS-XR RSVP-TE commands

     show explicit-paths
     show mpls traffic-eng affinity-map
     show mpls traffic-eng autoroute
     show mpls traffic-eng fast-reroute database
     show mpls traffic-eng forwarding p2p detail
     show mpls traffic-eng link-management statistics summary
     show mpls traffic-eng tunnels backup
     show mpls traffic-eng tunnels p2p role head detail
     show mpls traffic-eng tunnels p2p;
     show mpls traffic-eng tunnels summary
     show rsvp session session-type lsp-p2p detail

JunosE CLI Commands

The following commands are used for the Juniper E-Series router configuration 
for the Collector.
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terminal length 0
show version
show ip route static | include Static
show ip route local | include Connect
show ip vrf detail
show ip interface vrf <vrf_name>
show ip route vrf <vrf_name> static | include Static 
show ip route vrf <vrf_name> local | include Connect 
show route-map 
show access-list detail 
show ip prefix-list 
show ip prefix-tree 
show ip community-list 
show ip extcommunity-list 
show ip route vrf <vrf_name> static | include Static 
show ip route vrf <vrf_name> local | include Connect 
show policy-list 
show classifier-list detail 
show mpls 

Junos CLI Commands

Commands for Collecting Base Information

Router Information

"<get-software-information>
"<get-chassis-inventory/>
"<get-config><time-zone/></get-config>

Interface Information

"<get-interface-information/>
"<walk-snmp-object>ifType</walk-snmp-object>
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Static Routes Information

"<get-route-information><protocol>static</protocol></
get-route-information>
 (protocol can be static or direct or local)

VRF Information

"<get-config><routing-instances/></get-config>

Policy options information
"<get-config><policy-options/></get-config>

Classifier information
"<get-config><firewall/></get-config>

Service policy information
"<get-config><interfaces/></get-config>

CoS information
"<get-cos-information/> 

XML Sent to the Router

Hello 

<?xml version="1.0" encoding="UTF-8"?> 
<hello> 
<capabilities> 
<capability>urn:ietf:params:xml:ns:netconf:base:1.0 
</capability> 
</capabilities> 
</hello> 
]]>]]> 

Close 

<?xml version="1.0" encoding="UTF-8"?> 
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<rpc message-id="106" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<close-session/> 
</rpc> 
]]>]]> 

get-software-information 

<?xml version="1.0" encoding="UTF-8"?> 
<rpc message-id="113" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-software-information> 
<brief/> 
</get-software-information> 
</rpc> 
]]>]]> 

get-chassis-inventory 

<?xml version="1.0" encoding="UTF-8"?> 
<rpc message-id="113" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-chassis-inventory/> 
</rpc> 
]]>]]> 

get-interface-information 
<?xml version="1.0" encoding="UTF-8"?> 
<rpc message-id="113" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-interface-information/> 
</rpc> 
]]>]]> 

get-iftype-query 

<?xml version="1.0" encoding="UTF-8"?> 
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<rpc message-id="113" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<walk-snmp-object>ifType</walk-snmp-object> 
</rpc> 
]]>]]> 

get-static-route-query 

<?xml version="1.0" encoding="UTF-8"?> 
<rpc message-id="113" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-route-information> 
<terse/> // use "brief" for local 
<table>inet.0</table> 
<protocol>static</protocol> // static or direct or local 
</get-route-information> 
</rpc> 
]]>]]> 

get-vrf-info-query 

<get-configuration database="committed"> //junoscript 
<configuration> 
<routing-instances/> 
</configuration> 
</get-configuration> 
or 
<?xml version="1.0" encoding="UTF-8"?> //netconf 
<rpc message-id="111" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-config> 
<source><running/></source> 
<filter type="subtree"> 
<configuration> 
<routing-instances/> 
</configuration> 
</filter> 
</get-config> 
</rpc> 
]]>]]> 
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get-policy-options-query 

<get-configuration database="committed"> //junoscript 
<configuration> 
<policy-options/> 
</configuration> 
</get-configuration> 
or 
<?xml version="1.0" encoding="UTF-8"?> //netconf 
<rpc message-id="111" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-config> 
<source><running/></source> 
<filter type="subtree"> 
<configuration> 
<policy-options/> 
</configuration> 
</filter> 
</get-config> 
</rpc> 
]]>]]> 

get-classifier-query 

<get-configuration database="committed"> //junoscript 
<configuration> 
<firewall/> 
</configuration> 
</get-configuration> 
or 
<?xml version="1.0" encoding="UTF-8"?> //netconf 
<rpc message-id="111" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-config> 
<source><running/></source> 
<filter type="subtree"> 
<configuration> 
<firewall/> 
</configuration> 
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</filter> 
</get-config> 
</rpc> 
]]>]]> 

get-service-policy-query 

<get-configuration database="committed"> 
<configuration> 
<interfaces/> 
</configuration> 
</get-configuration> 
or 
<?xml version="1.0" encoding="UTF-8"?> 
<rpc message-id="111" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-config> 
<source><running/></source> 
<filter type="subtree"> 
<configuration> 
<interfaces/> 
</configuration> 
</filter> 
</get-config> 
</rpc> 
]]>]]> 

get-cos-info-query 

<?xml version="1.0" encoding="UTF-8"?> 
<rpc message-id="113" 
xmlns="urn:ietf:params:xml:ns:netconf:base:1.0"> 
<get-cos-information/> 
</rpc> 
]]>]]> 
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JunosE Commands for RSVP-TE

The following commands are used for the Juniper E-Series router configuration 
for RSVP-TE.

All Ingress Tunnel Query

show mpls lap ingress extensive - lsp (tunnel) and lsp path 
parameters (config params, ERO, RRO)
show rsvp session ingress detail - rsvp session parameters 
(tunnel id, lsp id outgoing intf and so on)
show ospf interface detail
OSPF FA lsp metrics per area
show isis interface
ISIS FA lsp metrics per level
show rsvp interface extensive
bypass lsp information (type, protected interface)

Directed Tunnel Query

show mpls lap ingress extensive  - lsp (tunnel) and lsp path 
parameters (config params, ERO, RRO)
show rsvp session ingress detail   - rsvp session parameters 
(tunnel id, lsp id outgoing intf and so on)

Router Configuration Query

show configuration protocols isis   - ISIS IGP shortcuts
show configuration protocols ospf - OSPF IGP shortcuts
show configuration protocols mpls traffic-engineering - router 
configuration parameters
show configuration protocols mpls admin-groups - router 
configuration admin groups
show configuration routing-options fate-sharing - router 
configuration fate sharing
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Constraint path query

<get-mpls-path-information> (this is netconf command. there is 
no exact CLI equivalent. loose CLI translation - show 
configuration mpls paths) - mpls constraint paths configured 
by the user.

Lightweight Query

netconf commands:

<walk-snmp-object><name>jnxRsvpSessionFrom</name></
walk-snmp-object>       -  lsp src
<walk-snmp-object><name>jnxRsvpSessionTo<walk-snmp-object><na
me>            -  lsp dst
<walk-snmp-object><name>jnxRsvpSessionLspId<walk-snmp-object>
<name>          - lsp id
<walk-snmp-object><name>jnxRsvpSessionTunnelId<walk-snmp-obje
ct><name>  - lsp tunnel id
<walk-snmp-object><name>jnxRsvpSessionRole<walk-snmp-object><
name>         - lsp role

Tunnel Labels query

show rsvp session transit detail  - mpls labels for transit 
tunnels
show rsvp session egress detail  - mpls labels for egress 
tunnels

Junos Commands for RSVP-TE

All Ingress Tunnel Query

show mpls lap ingress extensive      - lsp (tunnel) and lsp 
path parameters (config params, ERO, RRO)
show rsvp session ingress detail      - rsvp session parameters 
(tunnel id, lsp id outgoing intf and so on)
show ospf interface detail               - OSPF FA lsp metrics 
per area
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show isis interface                        -  ISIS FA lsp metrics 
per level
show rsvp interface extensive         - bypass lsp information 
(type, protected interface)

Directed Tunnel Query

show mpls lap ingress extensive      - lsp (tunnel) and lsp 
path parameters (config params, ERO, RRO)
show rsvp session ingress detail      - rsvp session parameters 
(tunnel id, lsp id outgoing intf and so on)

Router Configuration Query

show configuration protocols isis   - ISIS IGP shortcuts
show configuration protocols ospf - OSPF IGP shortcuts
show configuration protocols mpls traffic-engineering - router 
configuration parameters
show configuration protocols mpls admin-groups - router 
configuration admin groups
show configuration routing-options fate-sharing - router 
configuration fate sharing

Constraint Path Query

<get-mpls-path-information> (this is netconf command. there is 
no exact CLI equivalent. loose CLI translation - show 
configuration mpls paths) - mpls constraint paths configured 
by the user.

Lightweight Query

netconf commands:

<walk-snmp-object><name>jnxRsvpSessionFrom</name></
walk-snmp-object>       -  lsp src
<walk-snmp-object><name>jnxRsvpSessionTo<walk-snmp-object><na
me>            -  lsp dst
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<walk-snmp-object><name>jnxRsvpSessionLspId<walk-snmp-object>
<name>          - lsp id
<walk-snmp-object><name>jnxRsvpSessionTunnelId<walk-snmp-obje
ct><name>  - lsp tunnel id
<walk-snmp-object><name>jnxRsvpSessionRole<walk-snmp-object><
name>         - lsp role

Tunnel Labels Query

show rsvp session transit detail  - mpls labels for transit 
tunnels
show rsvp session egress detail  - mpls labels for egress 
tunnels

EIGRP Recorder Cisco IOS CLI Commands

The recorder uses an open-source package called libcisco to log in to each 
router, issue the specified commands, and collect the output.  In order to avoid 
pagination and other effects in the output, libcisco issues the following 
commands:

terminal length 0
terminal no editing
exit

In addition, if the command line prompt ends in '#' to indicate that the privilege 
level is "enabled", then libcisco issues one more command to make sure no 
debug output is interleaved with the desired command output:

terminal no monitor

The commands issued to collect the topology information are as follows (the '$' 
terms are variable parameters that are replaced by numerical values when the 
commands are sent):

show version
show interface
show ip interface
show ip eigrp interfaces
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show ip eigrp neighbors
show ip eigrp topology $AS summary
show ip protocols
show ip route static
show ip route 0.0.0.0 255.255.255.255 longer-prefixes

The following two commands are also used if they are available at the assigned 
privilege level:

show inventory raw
show snmp mib ifmib ifindex

For networks that use offset-list or redistribute-list in their EIGRP 
configuration, an additional command is required to obtain the associated 
access-lists (ACLs):

show ip access-list $acl

To attach external prefixes heard in EIGRP routing updates to the associated 
nodes, additional queries are issued to request routing information for a 
specific list of prefixes using multiple commands of the following form:

show ip eigrp topology $AS $addr $mask

When evidence of a stuck-in-active prefix is detected, the following command is 
issued while probing to find the source:

show ip eigrp topology $AS active

Syslog Messages

Cisco IOS

Route Explorer/Traffic Explorer parses system messages generated when a 
tunnel comes up or goes down. Examples include the following.

Tunnel down:
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 %LINK-5-CHANGED: Interface Tunnel422, changed state to 
administratively down
 %LINEPROTO-5-UPDOWN: Line protocol on Interface Tunnel422, 
changed state to down

Tunnel up:

Sep 12 20:14:21: %LINEPROTO-5-UPDOWN: Line protocol on 
Interface Tunnel422, changed state to up

Tunnel route change:

Cisco does not have a standard system syslog message that is generated when 
a tunnel changes its route (gets signalled again). A syslog message for this 
situation can be generated using the following command. The command is 
verbose, because it generates syslog messages even when a transiting tunnel 
changes.

debug mpls traffic-eng tunnels signaling

For Cisco IOS we recommend using traps to communicate changes in tunnel 
states and paths, because there no non-debugging syslog message is generated 
when a tunnel reoptimizes.

Cisco IOS-XR:

Route Explorer/Traffic Explorer parses system messages that are generated 
when a tunnel comes up or goes down. These messages are generated by using 
the following command: 

logging events link-status software-interfaces.

Examples include the following.

Tunnel down:

%PKT_INFRA-LINK-3-UPDOWN : Interface tunnel-te4, changed state 
to Down
%PKT_INFRA-LINEPROTO-5-UPDOWN : Line protocol on Interface 
tunnel-te4, changed state to Down
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Tunnel up:

%PKT_INFRA-LINK-3-UPDOWN : Interface tunnel-te201, changed 
state to Up
%PKT_INFRA-LINEPROTO-5-UPDOWN : Line protocol on Interface 
tunnel-te201, changed state to Up

For Cisco IOS-XR we recommend using traps to communicate changes in 
tunnel states and paths, because there no non-debugging syslog message is 
generated when a tunnel reoptimizes.

JUNOS

Route Explorer/Traffic Explorer parses system syslog messages that are 
generated when a tunnel changes state or its path. Examples include the 
following.

Tunnel down:

RPD_MPLS_LSP_DOWN: MPLS LSP to_RTR3 down on primary(path1)

Tunnel change:

RPD_MPLS_LSP_CHANGE: MPLS LSP to_RTR3 change on primary() 
Route  10.64.4.2 10.64.16.3(Label=836)

Tunnel up:

RPD_MPLS_LSP_UP: MPLS LSP k_p_15_2 up on primary(15_12_2) 
Route  10.74.7.12 10.64.4.2

Tunnel Switch:

RPD_MPLS_LSP_SWITCH: MPLS LSP to_RTR3 switch from 
secondary(path1) to primary(path2), Route  10.64.4.2
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We recommend that JUNOS routers be configured to send syslog messages to 
the appliance instead of sending SNMP traps, because the syslog messages 
contain the record route object (RRO) information that helps keep the network 
model up-to-date, while avoiding extra queries to the headend routers.

Alcatel (TimOS):

Route Explorer/Traffic Explorer parses syslog messages that are generated 
from the event control mpls.

show log event-control mpls
=============================================================
==========
Log Events
=============================================================
==========
Application
 ID#    Event Name                       P   g/s     Logged     Dropped
-------------------------------------------------------------
----------
   2001 mplsXCUp                         WA  gen          0           0
   2002 mplsXCDown                       WA  gen          0           0
   2003 mplsTunnelUp                     WA  gen         34           0
   2004 mplsTunnelDown                   WA  gen         18           0
   2005 mplsTunnelRerouted               WA  gen          0           0
   2006 mplsTunnelReoptimized            WA  gen          0           
0
   2007 vRtrMplsStateChange              WA  gen          0           0
   2008 vRtrMplsIfStateChange            WA  gen          4           
0
   2009 vRtrMplsLspUp                    WA  sup          0       27404
   2010 vRtrMplsLspDown                  WA  gen      24904           0
   2011 vRtrMplsLspPathUp                WA  gen      27409           
0
   2012 vRtrMplsLspPathDown              WA  gen      24901           
0
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   2013 vRtrMplsLspPathRerouted          WA  gen         40           
0
   2014 vRtrMplsLspPathResignaled        WA  gen       1094           
0
=============================================================
==========

These can be generated using the following command:

config# log event-control mpls generate vRtrMplsStateChange

Examples include the following.

Tunnel change:

MPLS-WARNING-vRtrMplsLspPathResignaled-2014 [VR 1:]:  LSP path 
to_rtr4:ath_to_rtr4 resignaled

Tunnel up:

MPLS-WARNING-vRtrMplsLspPathUp-2011 [VR 1:]:  LSP path 
to_rtr4:ath_to_rtr4 is operationally enabled ('no shutdown')

Tunnel down:

MPLS-WARNING-vRtrMplsLspPathDown-2012 [VR 1:]:  LSP path 
to_rtr4:ath_to_rtr4 is operationally disabled ('shutdown') 
because noError
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C Protocol Compliance
This appendix lists protocol compliance information.

• OSPF:

— RFC 2328, OSPF Version 2

— RFC 3101, The OSPF NSSA Option

— RFC 3623, Graceful OSPF Restart

• IS-IS

— ISO 10589, or RFC 1142 (ISO 10589 draft), OSI IS-IS Intra-Domain 
Routing Protocol

— RFC 1195, Use of OSI IS-IS for Routing in TCP/IP and Dual 
Environments

— RFC 2763, Dynamic Hostname Exchange Mechanism for IS-IS

— RFC 3784, IS-IS Extensions for Traffic Engineering

— RFC 2966, Domain-wide Prefix Distribution with Two-Level IS-IS

— RFC 3567, IS-IS Cryptographic Authentication

• BGP:

— RFC 4271, BGP Version 4

— RFC 2796, BGP Route Reflection

— RFC 1997, BGP Communities Attribute

— RFC 2545, Use of BGP-4 Multiprotocol Extensions for IPv6 
Inter-Domain Routing

— RFC 2547, BGP/MPLS VPNs

— RFC 2858, Multiprotocol Extensions for BGP-4

— RFC 4364, BGP/MPLS IP VPNs
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• EIGRP: Since EIGRP is a Cisco proprietary protocol, there is no RFC to 
specify the protocol. Documentation for EIGRP is available on the Cisco 
website (http://www.cisco.com/warp/public/103/eigrp-toc.html).

The following implementations for multi-protocol route resolution are 
incomplete:

• RFC2328: 16.3 (summary LSAs in transit-area)

• ISO/IEC 10589: QoS metric, virtual link

• ECMP for BGP next hops
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D License Feature Details
This appendix describes the license features associated with Route Explorer/Traffic Explorer. 
For information on how to apply license features to an appliance, see Chapter 3,  “Configuration 
and Management” 

Each license includes an expiration date, or “--” for a permanent license. In a typical 
installation, all licenses will show the same expiration date. However, if you purchase an 
incremental license, that license will have a different expiration date. A license with a 
short-duration expiration date is often provided during product evaluations. When the license 
expires, data recording is disabled, protocol configuration is disabled, and a warning message 
is displayed.

Table 6 Available License Features

Feature 
Name Description

Protocol 
Licenses

Required for an appliance to monitor particular protocols. If the license for 
a given protocol (OSPF, IS-IS, EIGRP, BGP, or MPLS VPN) is not enabled, 
an instance of that protocol cannot be created on the Recorder 
Configuration page. If you attempt to add or edit a protocol instance that 
does not have a license, you will receive an error message indicating the 
lack of license.

Route 
Recorder

Required for an appliance to act as a Route Recorder, which stores 
information obtained from the licensed routing protocols 
(OSPF, IS-IS, EIGRP, BGP, or MPLS VPN).

Flow Collector Required for an appliance to collect traffic flow data, which is then 
analyzed by the Flow Analyzer. (Traffic Explorer only)

Flow Analyzer Required for an appliance to generate reports using data collected from 
Flow Collectors and Route Recorders. (Traffic Explorer only)

GUI Required for an appliance to accept s or X Window System connections to 
display the graphical user interface.
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Advanced 
Analysis

Enables moving time to examine historical data, and enables the BGP 
Root Cause Analysis, RIB Comparison, and Correlate Time Series 
features.

Planning Enables Planning mode for simulated network changes.

MPLS VPN Required for network service providers to collect the VPN-IPv4 prefixes for 
all of their VPN customers. Enables features to make sure that the 
prefixes are correctly distributed among a given customer’s sites and do 
not leak between customers. 

MPLS WAN Required for an appliance to support enterprises that have multiple sites 
that
are connected by one or more VPNs through ISPs that use MPLS within 
their own
networks.

Traffic 
Explorer 

Applied to the Modeling Engine to enable viewing of traffic and routing 
data and traffic reports. 

Route 
Analyzer 
Alerts and 
Reports

Required for an appliance to act as a Route Analyzer. Route Analyzer 
generates reports using data collected from Route Recorders. The licenses 
for Alerts and Reports are typically enabled in an appliance that is 
configured as a Route Recorder.

VPN Customer 
Reports

Enables generation of per-customer traffic report data for your customers 
if you are a VPN service provider. This requires a system system with a 
MPLS-VPN license.

Database 
Server

Required for an appliance that records data to act as a database server. 
Machines that are configured to act as database clients can connect to this 
machine.

Database 
Client

Required for an appliance o act as a database client which can then 
connect to a database server.

Master 
Capability

Required for an appliance to be designated as the master appliance in a 
distributed configuration environment. The master is then used to 
configure a set of clients.

Table 6 Available License Features (cont’d)

Feature 
Name Description
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Router Count Sets the number of routers you are able to monitor. When the number of 
routers you are monitoring exceeds the number of routers allowed by the 
license, a warning message is displayed. Sets the number of routers you 
are able to monitor. When the number of routers you are monitoring 
exceeds the number of routers allowed by the license, the system displays 
a warning message. If you exceed the number by more than 10, then the 
Open Topology operation in the GUI will abort unless you select a subset 
of the databases containing a smaller number of routers.

MPLS VPN 
Prefix Count

Sets the number of VPN prefixes you are able to monitor. If you exceed the 
number supported by the license, a warning message is displayed. If you 
exceed the number by more than 10%, then the Open Topology operation 
in the GUI will abort unless you deselect all VPN databases.

User Count Determines the number of users who can simultaneous connect to the 
client application.

Software 
Update

Indicates whether the appliance can obtain software updates from HP. 
Software Update is enabled with all licenses, including the temporary 
license that can be activated on a new appliance. HP provides software 
updates for <major number>.<minor number> versions of the software (for 
example, version 6.0) using the Software Update feature.

RSVP-TE Required to collect and report on information about RSVP-TE tunnels.

RSVP-TE 
Tunnel Count

Specifies the number of tunnels you are able to monitor. If you exceed the 
number supported by the license, a warning message is displayed. If you 
exceed the number by more than 10%, then the Open Topology operation 
in the GUI will abort unless you deselect all RSVP-TE databases.

Table 6 Available License Features (cont’d)

Feature 
Name Description
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E Abbreviations
The following abbreviations are used in this documentation.

Table 0-1

ABR Area Border Router

ACL Access Control List

AES Advanced Encryption Standard

AS Autonomous System 

ASBR Autonomous System Border Router

ASCII American Standard Code for Information Interchange

BGP Border Gateway Protocol

BR Border Router

BW Bandwidth

CA Certificate Authority

CDE Common Desktop Environment

CE Customers Edge

CIFS Common Internet File System

CLI Command Line Interface

CoS Class of Service

CSR Certificate Signing Request

DES Data Encryption Standard

DHCP Dynamic Host Configuration Protocol
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DNS Domain Name Service

DR Designated Router

DSCP Differentiated Services Code Point

DSL Digital Subscriber Line

DTE Data Terminal Equipment

ECMP Equal-Cost Multi-Path

EIGRP Enhanced Interior Gateway Routing Protocol

FA Forwarding Adjacency

FTP File Transfer Protocol

GRE Generic Route Excapsulation

GUI Graphical User Interface

HTML Hypertext Markup Language

ICMP Internet Control Message Protocol

IGP Interior Gateway Protocol

IP Internet Protocol

IS-IS Intermediate System to Intermediate System

ISP Internet Service Provider

LA Local Address

LAN Local Area Network

LDP Label Distribution Protocol

LSA Link State Advertisement

LSP Link State Packets

LSR Label Switch Router

MD5 Message Digest Algorithm 5

Table 0-1
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MP Multi-protocol

MPLS Multiprotocol Label Switching 

MRTG Multi Router Traffic Grapher

MTU Maximum Transmission Unit

NSAP Network Service Access Point 

NTP Network Time Protocol

NU No Unicast

OSI Open Systems Interconnection

OSPF Open Shortest Path First

PBX Private Branch Exchange

PDF Portable Document Format

PE Provider Edge

PSTN Public Switched Telephone Network

RADIUS Remote Authentication Dial In User Service

RD Route Distinguisher

RegEx Regular Expression

RFC Request for Comments

RIB Routing Information Base

RRC Route Reflector Client

RRD Round Robin Database

RT Route Target

SFTP Secure File Transfer Protocol

SHA Secure Hash Algorithm

SMB Server Message Block

Table 0-1
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SNMP Simple Network Management Protocol

SSH Secure Shell

SSL Secure Socket Layer

SVG Scalable Vector Graphic

TACACS Terminal Access Controller Access-Control System

TCP Transmission Control Protocol

TE Traffic Engineering

TOS Type of Service

UDP User Datagram Protocol

VNC Virtual Network Computing

VoIP Voice over Internet Protocol

VPN Virtual Private Network

VRF Virtual Routing and Forwarding

VTY Virtual Teletype

WAN Wide Area Network

XML Extended Markup Language

Table 0-1
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Index
A
add

client, 58

adding clients, considerations for, 56

administration interface, selecting, 65

Administration pages, 43, 133
logging in, 45

administrative domain
creating, 77
deleting, 107
top-level, 77

administrator default user name and 
password, 46

Administrator password
changing, 48

Administrators, 135

alias
BGP AS, 91
interface, 66

Analysis mode, 21

appliance
reboot, 201
reset, 202
shutdown, 201

application interface, 21

Archival Configuration and Remote Storage 
page, 174

archiving, 174
automatic, 174
configuration, 174
enable, 175
end time, 177
filename format, 176
frequency of, 174
manual, 176
restoring data, 177
start time, 177

areas
contiguous, 84
multiple, 84

AS
BGP, 91
configuring for EIGRP protocol instance, 

88

authentication
local, 137
MD5, 128
OSPF, 108, 128
type, 137
user, 46

autonomous system
see AS

B
backing up

client unit, 167
master appliance, 169

Backup and Restore page, 157
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backup file
creating, 157, 160
deleting, 163
downloading, 161
FTP, 166
restoring, 162
restoring from remote server, 165
saving, 161
transferring, 166
uploading, 161

backup on unit’s disk, 158

BGP
aliases, AS, 91
autonomous system (AS), 91
configuring, 90, 91
protocol

instances, 91

BGP Reports, 23

boot sequence, 25

browsers
Firefox, 44
Safari, 44
supported, 44

button
Make Master, 56
Re-apply All, 54
Relinquish Master Role, 60, 61
Remove all licenses on this unit, 54
Restore Now, 178

C
CA

CSR, 70

callback, enable, 35, 130

Cisco router loopback interface, 129

CLI Access, 135

CLI Access users, 135

client, 44
adding, 56
removing, 61

client list, 56

client unit
backing up, 167

clock
setting, 49

Collector
and MPLS tunnels, 97
and RSVP-TE, 97
configuring, 95
configuring for RSVP-TE, 98
router commands, 96, 209

collector
traffic flow, 15

compliance, regulatory, 207

compliance information
protocol

compliance, 255

components
data flow, 16
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configuration, 25
additional tasks, 122
administration interface, 65
BGP, 90
client, 44
database

deleting, 155
renaming, 156

DHCP, 64
DNS, 31
ethernet, 30
Flow Analyzer, 119
Flow Collector, 109
for recording, 74
FTP server, 193, 194
GRE tunnels, 125
hierarchy, 75, 77
hostname, 63
loopback interface, 129
master, 44
network, 30
option card, 68
Route Recorder, 75, 78, 92
show, 28
static route, 67
support access, 129
technical support access, 35
traffic instance, 110
tree, 75
users, 48
VNC, 149

connecting the terminal, 25

considerations for, 68

cookies, 45

CoS groups, 144

CSR
CA request, 70
obtaining and installing, 70

D
daily reports

creating, 184
scheduling, 188
understanding contents, 189
viewing saved, 191

database
administration page, 153
archiving, 175
backing up, 157
deleting, 155
deleting and start recording to new, 155
online vs. offline, 154
renaming, 156, 177
restored filename, 178
restoring, 157
restoring archived, 177
unarchived, 175
using offline, 154
using online, 156

Database Client, 258

Database Server, 258

Data Configuration page, 171

data source
choosing, 172

default, factory, 201

DHCP, 30, 64

diagnostics, 38, 199
interface statistics, 40
ping, 39, 199
process statistics, 40
routing table, 39
tcpdump, 39
telnet, 39
traceroute, 39, 200

Diagnostics menu, 38
267



distributed configuration
applying license keys, 50
archival settings for, 175
archiving data for, 174
choosing data source for, 171
configuring route recorder in, 20
deleting a database within, 155
designating master and client roles for, 

54
IGP and BGP reports for, 23
updating software for, 179
updating software with internet access 

for, 180
updating software without internet 

access, 182

distributed configuration
description, 43

DNS
configuration, 31
server, 64

downloading
software updates, 179

E
EIGRP

multiple areas, ASs, 84
multiple interfaces, coverage and, 86
protocol instance, configuring ASs, 84

enable archival, 175

ethernet, configuring, 30

export
log, 197
reports, 192

F
factory defaults, 201

features, 13

filename, restored database, 178

Firefox, 44

Flow Analyzer, 15, 54, 120, 257
configuration, 119
starting and stopping, 120

Flow Collector, 15, 54, 257
configuration, 109
starting and stopping, 113

flow fanout, 194

FTP
file transfer, 194
file upload, enabling, 194
file uploads, 194
server configuration, 193, 194

G
GRE tunnels, 16, 125

Guests, 135

H
hardware

specifications, 203

hierarchy
configuration, 75, 77

History Navigator, 21

HTTP POST, 55

I
ICMP redirects, 67

ifconfig, 40

IGP Reports, 23

image, importing
importing

background image, 197
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interface
administration, 65
alias, 66
application, 21
removing from protocol instance, 107
statistics, 40
VLAN, 65
web, 43

interface statistics, 40

Internet Explorer, 44

IP address, 65
before you change on a system, 63

K
keys, license, 257

L
layout

uploading backgrounds
backgrounds, 197

LDP, in IPv4 deployments, 112

LDP peering sessions
establishing, 109

license
applying, 50
install new key, 52
key, 50
remove all, 54
updating licenses, 50

license key, 257
advanced analysis, 258
database client, 258
database server, 258
flow analyzer, 257
flow collector, 257
GUI, 257
master capability, 258
Modeling Engine, 258
MPLS VPN prefix count, 259
MPLS WAN, 258
planning, 258
protocol, 257
route analyzer, 258
router count, 259
Route Recorder and GUI, 257
software update, 259
user count, 259
VPN customer reports, 258

license reapplying, 50

list client, 56

local authentication, 137

log
export as plain text, 197
viewing, 196

logging in, 46

login attributes, 140

login page, 46

loopback
interface, 87, 129
interface, on Cisco router, 129

M
Mail page, 184

mail system
configuring, 188

map
Routing Topology, 21
269



master, 44
assigning, 55
assigning appliance as master, 43
license key, 258
relinquish, 60
removing client, 61

master appliance
backing up, 169
relinquishing master status, 60

Master Capability, 258

master-client shared secret, 55

MD5 authentication, 128

mode
Analysis, 21
Monitoring, 21
Planning, 21

Modeling Engine
adding an additional, 59
as master appliance, 43
description, 16
in distributed configuration, 54
license key, 258

Monitoring mode, 21

MPLS VAN WAN site, 79

MPLS VPN
deployments, 109

MPLS VPN Prefix Count, 259

multiple port options, 68

N
NetFlow, 15

and flow fanout, 194

network
configuration, 30, 62
DHCP, 63

Network & Interface Configuration page, 62

NTP server, 48, 49

O
online/offline databases, 154

Operators, 135

option cards, configuring, 68

OSPF
area ID format, 106
authentication, 108, 128
contiguous areas, 82
loopback interface, 87

overwrite layouts, 162, 166, 170

P
password

master-client shared secret, 55

Path Reports, 23

ping, 39, 199

planning license, 258

Planning mode, 21

Planning Reports window, 22

ports
serial, settings, 27

power supply, 27

previous version, revert to, 183

privileges, 139

process statistics, 40

protocol
BGP, 90, 91
instance, deleting, 107
instance, VPN, 93
license keys, 257
link-state, 14
supported, 15

Protocol Licenses, 257
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Q
queries, configuring server, 99

query server, 99

R
RADIUS Server, 137

RAMS
about, 13
components of, 15
reverting to previous version, 183
web interface, 44

re-apply all, 54

reboot, 201

rebooting the system, 41, 201

recorder
NetFlow, 15
routing, 15

Recorder Configuration page, 75

recording, configuration, 74

regulatory compliance, 207

remote server, adding, 163

remove all licenses, 54

replacing
client unit, 167
master appliance, 169

reports
and mail, 188
BGP, 23
daily, 184
deleting instance, 121
export, 192
IGP, 23
managing previously exported, 192
Path, 23
Planning, 22
scheduling daily, 188
Traffic, 23
using top N, 190

reset to factory defaults, 202

restore
archived data, 177
databases, 177
from backup on unit’s disk, 159

revert to previous version, 183

RFCs, 255

route
static, configuring, 67

Route Analyzer, 258

router
count, 259
login for EIGRP, 89

router commands
Cisco IOS, 236
for Collector, 96, 209
JunOS CLI, 239
JunosE, 238

Router Count, 259

Route Recorder, 15, 54, 78
Collector, 95
configuration overview, 78
configuration page, 75

Route Recorder and GUI license, 257

route reflectors, 92
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Router Recorder
starting and stopping, 105

routing table, 39

Routing Topology Map, 21

RSVP-TE
and Collector, 97
configuring Collector, 98

S
Safari, 44

serial port, 27

server
database, 258
DNS, 64
FTP, 193, 194
NTP, 48, 49
remote, 163
VNC, 149

SFTP, as alternative to FTP, 193

Show Configuration command, 28

shutdown
command, 41
options, 201
page, 201
system, 41

site, MPLS VPN WAN, 79

SMB, enabling, 163

SNMP, 104
Agent configuration, 69
and the Collector, 95

software
reinstalling previous version, 183
updating, 259

Software Update
license, 259
page, 179

SSH, 35, 67, 89, 130, 135

SSL certificate
and CSR, 70

static information collection, 99

static route, 68
adding, 67

static route, configuration, 67

static route information, 95

status table, 114

support access, configuring, 129

supported, 199

system
reboot, 41, 201
shutdown, 41, 201

System Diagnostics page, 199

system settings, viewing, 74

T
TACACS, 89

TACACS+
class of users, 135

TACACS Server, 137

tcpdump, 39

technical support
access configuration, 35

telnet, 39

time
setting, 48, 49

time and date
synchronizing with NTP server, 48

Time and Date page, 48

top N reports, 190

topology
map, 21
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traceroute, 39, 200

traffic
configuration status, 114
deleting instance, 118
instance, 110

Traffic Groups
creating, 141

traffic groups
creating, 141
editing, 144

Traffic Reports, 23

tree, configuration, 75

tunnels
and the Collector, 97
GRE, 16, 125
MPLS, 97

U
Units page, 56

updating software, 179

upload
FTP, 194

User accounts, updating existing, 139

User Administration page, 48

user count license, 259

user interface
application, 21
web, 19

user name and password, default, 46

User privileges, 135

users
adding, 48
CLI access class, 135
creating accounts, 139
login attributes, 140
privileges, 139
updating accounts, 139

uses of by the appliance, 65

V
v3 profiles, configuring, 104

View Configuration page, 74

viewer, 19
VNC

recommended use of, 47
X Window System

recommended use of, 47

visibility of, 68

VLAN
interface, 65

VLAN, configuring interface, 65

VNC, 19, 47
configuration, 149
connecting to persistent session, 151
on-demand sessions, 151
server, 149
start, stop server, 149
viewer, 151

W
web browser

supported
browsers

Internet Explorer, 44

web browser, cookies, 45

web interface, 19, 43, 44
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X
X Window System, 19, 47

evaluation license, 47
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